Guaranty and Declaration

Copyright
© 2013 RIGOL Technologies, Inc. All Rights Reserved.

Trademark Information
RIGOL is a registered trademark of RIGOL Technologies, Inc.

Publication Number
UGA16107-1110

Notices
• RIGOL products are protected by patent law in and outside of P.R.C.
• RIGOL reserves the right to modify or change parts of or all the specifications and pricing policies at company’s sole decision.
• Information in this publication replaces all previously corresponding material.
• RIGOL shall not be liable for losses caused by either incidental or consequential in connection with the furnishing, use or performance of this manual as well as any information contained.
• Any part of this document is forbidden to be copied or photocopied or rearranged without prior written approval of RIGOL.

Product Certification
RIGOL guarantees this product conforms to the national and industrial standards in China as well as the ISO9001:2008 standard and the ISO14001:2004 standard. Other international standard conformance certification is in progress.

Contact Us
If you have any problem or requirement when using our products or this manual, please contact RIGOL.
E-mail: service@rigol.com
Website: www.rigol.com
Safety Requirement

General Safety Summary

Please review the following safety precautions carefully before putting the instrument into operation so as to avoid any personal injury or damage to the instrument and any product connected to it. To prevent potential hazards, please use the instrument only specified by this manual.

**Use Proper Power Cord.**
Only the power cord designed for the instrument and authorized for use within the local country could be used.

**Ground The Instrument.**
The instrument is grounded through the Protective Earth lead of the power cord. To avoid electric shock, it is essential to connect the earth terminal of power cord to the Protective Earth terminal before any inputs or outputs.

**Connect the Probe Correctly.**
If a probe is used, do not connect the ground lead to high voltage since it has the isobaric electric potential as ground.

**Observe All Terminal Ratings.**
To avoid fire or shock hazard, observe all ratings and markers on the instrument and check your manual for more information about ratings before connecting.

**Use Proper Overvoltage Protection.**
Make sure that no overvoltage (such as that caused by a thunderstorm) can reach the product, or else the operator might expose to danger of electrical shock.

**Do Not Operate Without Covers.**
Do not operate the instrument with covers or panels removed.

**Do Not Insert Anything into the Holes of Fan.**
Do not insert anything into the holes of the fan to avoid damaging the instrument.
Use Proper Fuse.
Please use the specified fuses.

Avoid Circuit or Wire Exposure.
Do not touch exposed junctions and components when the unit is powered.

Do Not Operate With Suspected Failures.
If you suspect damage occurs to the instrument, have it inspected by qualified service personnel before further operations. Any maintenance, adjustment or replacement especially to circuits or accessories must be performed by RIGOL authorized personnel.

Keep Well Ventilation.
Inadequate ventilation may cause increasing of temperature or damages to the device. So please keep well ventilated and inspect the intake and fan regularly.

Do Not Operate in Wet Conditions.
In order to avoid short circuiting to the interior of the device or electric shock, please do not operate in a humid environment.

Do Not Operate in an Explosive Atmosphere.
In order to avoid damages to the device or personal injuries, it is important to operate the device away from an explosive atmosphere.

Keep Product Surfaces Clean and Dry.
To avoid the influence of dust and/or moisture in air, please keep the surface of device clean and dry.

Electrostatic Prevention.
Operate in an electrostatic discharge protective area environment to avoid damages induced by static discharges. Always ground both the internal and external conductors of the cable to release static before connecting.

Proper Use of Battery.
If a battery is supplied, it must not be exposed to high temperature or in contact with fire. Keep it out of the reach of children. Improper change of battery (note: lithium battery) may cause explosion. Use RIGOL specified battery only.
Handling Safety.
Please handle with care during transportation to avoid damages to buttons, knob interfaces and other parts on the panels.

Safety Terms and Symbols

Terms Used in this Manual. These terms may appear in this manual:

- **WARNING**
  Warning statements indicate the conditions or practices that could result in injury or loss of life.

- **CAUTION**
  Caution statements indicate the conditions or practices that could result in damage to this product or other property.

Terms Used on the Product. These terms may appear on the Product:

- **DANGER** indicates an injury or hazard may immediately happen.
- **WARNING** indicates an injury or hazard may be accessible potentially.
- **CAUTION** indicates potential damage to the instrument or other property might occur.

Symbols Used on the Product. These symbols may appear on the product:
Allgemeine Sicherheits Informationen

Überprüfen Sie die folgenden Sicherheitshinweise sorgfältig um Personenschäden oder Schäden am Gerät und an damit verbundenen weiteren Geräten zu vermeiden. Zur Vermeidung von Gefahren, nutzen Sie bitte das Gerät nur so, wie in diesem Handbuch angegeben.

**Um Feuer oder Verletzungen zu vermeiden, verwenden Sie ein ordnungsgemäßes Netzkabel.**
Verwenden Sie für dieses Gerät nur das für Ihr Land zugelassene und genehmigte Netzkabel.

**Erden des Gerätes.**
Das Gerät ist durch den Schutzleiter im Netzkabel geerdet. Um Gefahren durch elektrischen Schlag zu vermeiden, ist es unerlässlich, die Erdung durchzuführen. Erst dann dürfen weitere Ein- oder Ausgänge verbunden werden.

**Anschluss eines Tastkopfes.**
Die Erdungsklemmen der Sonden sind auf dem gleichen Spannungspegel des Instruments geerdet. Schließen Sie die Erdungsklemmen an keine hohe Spannung an.

**Beachten Sie alle Anschlüsse.**

**Verwenden Sie einen geeigneten Überspannungsschutz**
Stellen Sie sicher, daß keinerlei Überspannung (wie z.B. durch Gewitter verursacht) das Gerät erreichen kann. Andernfalls besteht für den Anwender die Gefahr eines Stromschlages.

**Nicht ohne Abdeckung einschalten.**
Betreiben Sie das Gerät nicht mit entfernten Gehäuse-Abdeckungen.

**Betreiben Sie das Gerät nicht geöffnet**
Der Betrieb mit offenen oder entfernten Gehäuseteilen ist nicht zulässig. Nichts in entsprechende Öffnungen stecken (Lüfter z.B.)

**Passende Sicherung verwenden**
Setzen Sie nur die spezifikationsgemäßen Sicherungen ein.

**Vermeiden Sie ungeschützte Verbindungen**
Berühren Sie keine unisolierten Verbindungen oder Baugruppen, während das Gerät
in Betrieb ist.

**Betreiben Sie das Gerät nicht im Fehlerfall**
Wenn Sie am Gerät einen Defekt vermuten, sorgen Sie dafür, bevor Sie das Gerät wieder betreiben, dass eine Untersuchung durch qualifiziertes Kundendienstpersonal durchgeführt wird. Jedwede Wartung, Einstellarbeiten oder Austausch von Teilen am Gerät, sowie am Zubehör dürfen nur von RIGOL autorisiertem Personal durchgeführt werden.

**Belüftung sicherstellen**
Unzureichende Belüftung kann zu Temperaturanstiegen und somit zu thermischen Schäden am Gerät führen. Stellen Sie deswegen die Belüftung sicher und kontrollieren regelmäßig Lüfter und Belüftungsoffnungen.

**Nicht in feuchter Umgebung betreiben**
Zur Vermeidung von Kurzschluß im Geräteinneren und Stromschlag betreiben Sie das Gerät bitte niemals in feuchter Umgebung.

**Nicht in explosiver Atmosphäre betreiben**

**Geräteoberflächen sauber und trocken halten**
Um den Einfluß von Staub und Feuchtigkeit aus der Luft auszuschließen, halten Sie bitte die Geräteoberflächen sauber und trocken.

**Schutz gegen elektrostatische Entladung (ESD)**
Sorgen Sie für eine elektrostatisch geschützte Umgebung, um somit Schäden und Funktionsstörungen durch ESD zu vermeiden. Erden Sie vor dem Anschluß immer Innen- und Außenleiter der Verbindungsleitung, um statische Aufladung zu entladen.

**Die richtige Verwendung des Akku.**

**Sicherer Transport**
Transportieren Sie das Gerät sorgfältig (Verpackung!), um Schäden an Bedienelementen, Anschlüssen und anderen Teilen zu vermeiden.
Sicherheits Begriffe und Symbole

Begriffe in diesem Guide. Diese Begriffe können in diesem Handbuch auftauchen:

**WARNING**
Die Kennzeichnung WARNING beschreibt Gefahrenquellen die leibliche Schäden oder den Tod von Personen zur Folge haben können.

**CAUTION**
Die Kennzeichnung Caution (Vorsicht) beschreibt Gefahrenquellen die Schäden am Gerät hervorrufen können.

Begriffe auf dem Produkt. Diese Bedingungen können auf dem Produkt erscheinen:

**DANGER** weist auf eine Verletzung oder Gefährdung hin, die sofort geschehen kann.

**WARNING** weist auf eine Verletzung oder Gefährdung hin, die möglicherweise nicht sofort geschehen.

**CAUTION** bedeutet, dass eine mögliche Beschädigung des Instruments oder anderer Gegenstände auftreten kann.

Symbole auf dem Produkt. Diese Symbole können auf dem Produkt erscheinen:

- Gefährliche Spannung
- Sicherheits Hinweis
- Schutz erde
- Gehäusemasse
- Erde
Measurement Category

Measurement Category

DS2000A series digital oscilloscopes can make measurements in Measurement Category I.

⚠️ WARNING
This oscilloscope can only be used for measurements within its specified measurement categories.

Measurement Category Definitions

Measurement category I is for measurements performed on circuits not directly connected to MAINS. Examples are measurements on circuits not derived from MAINS, and specially protected (internal) MAINS derived circuits. In the latter case, transient stresses are variable; for that reason, the transient withstand capability of the equipment is made known to the user.

Measurement category II is for measurements performed on circuits directly connected to the low voltage installation. Examples are measurements on household appliances, portable tools and similar equipment.

Measurement category III is for measurements performed in the building installation. Examples are measurements on distribution boards, circuit-breakers, wiring, including cables, bus-bars, junction boxes, switches, socket-outlets in the fixed installation, and equipment for industrial use and some other equipment, for example. Stationary motors with permanent connection to the fixed installation.

Measurement category IV is for measurements performed at the source of the low-voltage installation. Examples are electricity meters and measurements on primary overcurrent protection devices and ripple control units.
Ventilation Requirement

This oscilloscope uses fan to force cooling. Please make sure that the air intake and exhaust areas are free from obstructions and have free air. When using the oscilloscope in a bench-top or rack setting, provide at least 10 cm clearance beside, above and behind the instrument for adequate ventilation.

WARNING

Inadequate ventilation may cause temperature increase which would damage the instrument. So please keep the instrument well ventilated during operation and inspect the intake and fan regularly.
Working Environment

Temperature
Operating: 0°C to +50°C
Non-operating: -40°C to +70°C

Humidity
0°C to +30°C: ≤95% relative humidity
+30°C to +40°C: ≤75% relative humidity
+40°C to +50°C: ≤45% relative humidity

⚠️ WARNING
To avoid short circuit inside the instrument or electric shock, please do not operate in humid environment.

Altitude
Operating: less than 3 km
Non-operating: less than 15 km

Installation (overvoltage) Category
This product is powered by mains conforming to installation (overvoltage) category II.

⚠️ WARNING
Make sure that no overvoltage (such as that caused by thunderbolt) can reach the product, or else the operator might expose to danger of electric shock.

Installation (overvoltage) Category Definitions
Installation (overvoltage) category I refers to signal level which is applicable to equipment measurement terminals connected to the source circuit. In these terminals, precautions are done to limit the transient voltage to the corresponding low level.
Installation (overvoltage) category II refers to the local power distribution level which is applicable to equipment connected to the AC line (AC power).
Pollution Degree
Degree 2

Pollution Degree Definitions
Pollution degree 1: No pollution or only dry, non-conductive pollution occurs. The pollution has no influence. For example: a clean room or air-conditioned office environment.
Pollution degree 2: Normally only dry, non-conductive pollution occurs. Occasionally a temporary conductivity caused by condensation may occur. For example: general indoor environment.
Pollution degree 3: Conductive pollution occurs, or dry, non-conductive pollution occurs which becomes conductive due to condensation which is expected. For example: Sheltered outdoor environment.
Pollution degree 4: Pollution that generates persistent conductivity through conductive dust, rain, or snow. For example: outdoor locations.

Safety Class
Class 1 – Grounded Product
General Care and Cleaning

General Care:
Do not store or leave the instrument at places where the instrument will be exposed to direct sunlight for long periods of time.

Cleaning:
Clean the instrument regularly according to its operating conditions. To clean the exterior surface:
1. Disconnect the instrument from all power sources.
2. Clean the loose dust on the outside of the instrument with a lint-free cloth (with mild detergent or water). When cleaning the LCD, take care to avoid scarifying it.

CAUTION
To avoid damages to the instrument, do not expose them to corrosive liquids.

WARNING
To avoid injury resulting from short circuit, make sure the instrument is completely dry before reconnecting it to a power source.
Environmental Considerations

The following symbol indicates that this product complies with the WEEE Directive 2002/96/EC.

![WEEE Symbol]

**Product End-of-Life Handling**

The equipment may contain substances that could be harmful to the environment or human health. In order to avoid release of such substances into the environment and harm to human health, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately. Please contact your local authorities for disposal or recycling information.
DS2000A Series Overview

DS2000A Series is high-performance digital oscilloscopes developed on the basis of the Ultra Vision technique. DS2000A, featuring rather deep memory depth, ultra-wide dynamic range, superb waveform capture rate and all-round trigger functions as well as hardware waveform record function and good display effect, is an invaluable debug instrument in various fields (such as communication, cosmonautics, defense, embedded system, computer, research and education) and is the one with the most complete functions and most outstanding specifications among the digital oscilloscopes with lower than 300 MHz bandwidth.

Main features:
- 300MHz, 200 MHz, 100 MHz and 70 MHz bandwidth.
- Ultra Vision technique.
- 2 GSa/s maximum real-time sample rate.
- 50,000 wfms/s (dots display) waveform capture rate.
- Real-time hardware waveform recording, waveform playback, record open (constant on) and waveform analysis functions. Up to 65,000 frames of waveform can be recorded.
- 56 Mpts maximum memory depth (option) and 14 Mpts standard memory depth.
- 256 degree gray scale display.
- Low noise floor, 500 μV/div to 10 V/div ultra-wide vertical dynamic range.
- 8.0 inches, WVGA (800*480) 160,000 color TFT LCD, with ultra-wide screen, vivid picture, low power consumption and long service life.
- Adjustable brightness of analog channel waveform.
- Auto setting of waveform display (AUTO).
- 16 kinds of trigger functions including multiple protocol triggers.
- Standard parallel decoding and multiple serial decoding options.
- Auto measurements of 24 waveform parameters and measurement functions with statistic.
- Precise delayed sweep function.
- Built-in FFT function.
- Pass/Fail test function.
- Multiple waveform math operation functions.
- Built-in dual-channel and 25 MHz signal generator function (only applicable to DS2000A-S).
- Standard configuration interfaces: USB Device, USB Host, LAN and GPIB
(optional).
• Support USB storage device and PictBrige printer.
• Conform to LXI-C instrument standards. Enable quick, economic and efficient creation and reconfiguration of test system.
• Support remote command control.
• Embedded help enables easier information access.
• Support multiple languages and Chinese/English input.
• Novel and delicate industrial design and easier operation.
# Document Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 Quick Start</strong></td>
<td>Provide information about preparations before using the instrument and a brief introduction of the instrument.</td>
</tr>
<tr>
<td><strong>2 To Set the Vertical System</strong></td>
<td>Introduce the functions of the vertical system of the oscilloscope.</td>
</tr>
<tr>
<td><strong>3 To Set the Horizontal System</strong></td>
<td>Introduce the functions of the horizontal system of the oscilloscope.</td>
</tr>
<tr>
<td><strong>4 To Set the Sample System</strong></td>
<td>Introduce the functions of the sample system of the oscilloscope.</td>
</tr>
<tr>
<td><strong>5 To Trigger the Oscilloscope</strong></td>
<td>Introduce the trigger mode, trigger coupling, trigger holdoff, external trigger and various trigger types of the oscilloscope.</td>
</tr>
<tr>
<td><strong>6 To Make Measurements</strong></td>
<td>Introduce how to make math operation, cursor measurement and auto measurement.</td>
</tr>
<tr>
<td><strong>7 Protocol Decoding</strong></td>
<td>Introduce how to decode the input signal using those common protocols.</td>
</tr>
<tr>
<td><strong>8 Reference Waveform</strong></td>
<td>Introduce how to compare the input waveform with the reference waveform.</td>
</tr>
<tr>
<td><strong>9 Pass/Fail Test</strong></td>
<td>Introduce how to monitor the input signal using the Pass/Fail test.</td>
</tr>
<tr>
<td><strong>10 Waveform Record</strong></td>
<td>Introduce how to analyze the input signal using waveform record.</td>
</tr>
<tr>
<td><strong>11 Display Control</strong></td>
<td>Introduce how to control the display of the oscilloscope.</td>
</tr>
<tr>
<td><strong>12 Signal Source</strong></td>
<td>Introduce how to use the built-in signal generator.</td>
</tr>
<tr>
<td><strong>13 Store and Recall</strong></td>
<td>Introduce how to store and recall the measurement result and the setting of the oscilloscope.</td>
</tr>
<tr>
<td><strong>14 System Function Setting</strong></td>
<td>Introduce how to set the remote interface and system-related functions.</td>
</tr>
<tr>
<td><strong>15 Remote Control</strong></td>
<td>Introduce how to control the oscilloscope remotely.</td>
</tr>
<tr>
<td><strong>16 Troubleshooting</strong></td>
<td>Introduce how to deal with common failures of the oscilloscope.</td>
</tr>
<tr>
<td><strong>17 Specifications</strong></td>
<td>Provide the specifications and general specifications of the oscilloscope.</td>
</tr>
<tr>
<td><strong>18 Appendix</strong></td>
<td>Provide common information such as options and accessories.</td>
</tr>
</tbody>
</table>
Format Conventions in this Manual:
1. Front panel key: denoted by the format of “Text Box + Button Name (Bold)”, for example, **Storage**.
2. Menu softkey: denoted by the format of “Character Shading + Menu Word (Bold)”, for example, **Storage**.
3. Operation steps: denoted by the arrow “→”, for example, **Storage → Storage**.
4. Cross reference: denoted by the format of “underscore + word (Blue and Bold), for example, **Store and Recall**.
5. Knob:

<table>
<thead>
<tr>
<th>Logo</th>
<th>Knob</th>
<th>Logo</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="logo" /></td>
<td>Multi-function Knob</td>
<td><img src="image2.png" alt="logo" /></td>
<td>Vertical Scale Knob</td>
</tr>
<tr>
<td><img src="image3.png" alt="logo" /></td>
<td>Navigation Knob</td>
<td><img src="image4.png" alt="logo" /></td>
<td>Vertical Position Knob</td>
</tr>
<tr>
<td><strong>HORIZONTAL SCALE</strong></td>
<td>Horizontal Scale Knob</td>
<td><strong>TRIGGER LEVEL</strong></td>
<td>Trigger Level Knob</td>
</tr>
<tr>
<td><strong>HORIZONTAL POSITION</strong></td>
<td>Horizontal Position Knob</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

Content Conventions in this Manual:
This manual takes DS2302A-S for example and the descriptions here have contained all the functions and performances of other models. DS2000A series includes the following models:

<table>
<thead>
<tr>
<th>Model</th>
<th>Analog Bandwidth</th>
<th>Channels</th>
<th>Channels of the Signal Generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS2072A</td>
<td>70 MHz</td>
<td>2</td>
<td>--</td>
</tr>
<tr>
<td>DS2072A-S</td>
<td>70 MHz</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>DS2102A</td>
<td>100 MHz</td>
<td>2</td>
<td>--</td>
</tr>
<tr>
<td>DS2102A-S</td>
<td>100 MHz</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>DS2202A</td>
<td>200 MHz</td>
<td>2</td>
<td>--</td>
</tr>
<tr>
<td>DS2202A-S</td>
<td>200 MHz</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>DS2302A</td>
<td>300 MHz</td>
<td>2</td>
<td>--</td>
</tr>
<tr>
<td>DS2302A-S</td>
<td>300 MHz</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>
# Contents

Guaranty and Declaration .................................................................................................................. I

Safety Requirement .......................................................................................................................... II

General Safety Summary ................................................................................................................. II
Safety Terms and Symbols ................................................................................................................ IV
Allgemeine Sicherheits Informationen ............................................................................................ V
Sicherheits Begriffe und Symbole ................................................................................................... VII
Measurement Category .................................................................................................................... VIII
Ventilation Requirement ................................................................................................................. IX
Working Environment .................................................................................................................... X
General Care and Cleaning ............................................................................................................ XI
Environmental Considerations ....................................................................................................... XII

DS2000A Series Overview ............................................................................................................. XIV

Document Overview ....................................................................................................................... XVI

1 Quick Start ................................................................................................................................... 1-1

General Inspection .......................................................................................................................... 1-2
Appearance and Dimensions .......................................................................................................... 1-3
To Prepare the Oscilloscope for Use .............................................................................................. 1-4
  To Adjust the Supporting Legs .................................................................................................... 1-4
  To Connect to Power Supply ...................................................................................................... 1-4
  Power-on Inspection .................................................................................................................. 1-5
  To Connect the Probe ............................................................................................................... 1-5
  Function Inspection .................................................................................................................... 1-6
  Probe Compensation .................................................................................................................. 1-7
Front Panel Overview ...................................................................................................................... 1-8
Rear Panel Overview ....................................................................................................................... 1-10
Front Panel Function Overview ..................................................................................................... 1-12
  VERTICAL ............................................................................................................................... 1-12
  HORIZONTAL ......................................................................................................................... 1-13
  TRIGGER .............................................................................................................................. 1-14
  CLEAR ................................................................................................................................. 1-14
  RUN/STOP ........................................................................................................................... 1-14
  SINGLE .............................................................................................................................. 1-15
2 To Set the Vertical System .................................................................. 2-1
   To Enable the Channel ........................................................................ 2-2
   Channel Coupling ............................................................................. 2-3
   Bandwidth Limit ................................................................................ 2-3
   Probe Ratio ........................................................................................ 2-4
   Input Impedance ................................................................................ 2-4
   Waveform Invert ................................................................................ 2-5
   Vertical Scale .................................................................................... 2-5
   Vertical Expansion ............................................................................ 2-6
   Amplitude Unit .................................................................................. 2-6
   Channel Label ................................................................................... 2-7
   Delay Calibration .............................................................................. 2-8

3 To Set the Horizontal System .............................................................. 3-1
   Delayed Sweep ................................................................................ 3-2
   Time Base Mode .............................................................................. 3-4
      Y-T Mode ..................................................................................... 3-4
      X-Y Mode ................................................................................... 3-4
      Roll Mode ................................................................................... 3-7
   Horizontal Scale .............................................................................. 3-8
   Horizontal Reference ....................................................................... 3-9

4 To Set the Sample System ................................................................. 4-1
   Acquisition Mode ............................................................................ 4-2
      Normal ....................................................................................... 4-2
      Average ..................................................................................... 4-2
      Peak Detect ............................................................................... 4-4
      High Resolution .......................................................................... 4-4
Sample Mode ................................................................. 4-5
Sample Rate ................................................................. 4-6
Memory Depth ............................................................... 4-8
Antialiasing ................................................................. 4-9

5 To Trigger the Oscilloscope ........................................ 5-1
Trigger Source .............................................................. 5-2
Trigger Mode ............................................................... 5-3
Trigger Coupling ........................................................ 5-5
Trigger Holdoff ........................................................... 5-6
Noise Rejection ............................................................ 5-7
Trigger Type ................................................................. 5-8
  Edge Trigger ............................................................. 5-9
  Pulse Trigger ............................................................ 5-10
  Runt Trigger ............................................................. 5-12
  Windows Trigger (Option) ................................. 5-14
  Nth Edge Trigger (Option) ................................... 5-16
  Slope Trigger .......................................................... 5-18
  Video Trigger (HDTV Option) .......................... 5-21
  Pattern Trigger ......................................................... 5-23
  Delay Trigger (Option) ........................................ 5-25
  TimeOut Trigger (Option) ................................. 5-27
  Duration Trigger (Option) ...................................... 5-29
  Setup/Hold Trigger ................................................ 5-31
  RS232 Trigger .......................................................... 5-33
  I2C Trigger .............................................................. 5-35
  SPI Trigger .............................................................. 5-38
  USB Trigger (Option) ............................................. 5-40
  CAN Trigger (Option) ............................................... 5-42
Trigger Output Connector ............................................. 5-45

6 To Make Measurements ........................................... 6-1
Math Operation .......................................................... 6-2
  Addition ................................................................. 6-2
  Substraction .......................................................... 6-2
  Multiplication ......................................................... 6-3
  Division ................................................................. 6-3
  FFT ............................................................... 6-4
Logic Operation .......................................................... 6-7
Advanced Operation ....................................................... 6-9
Auto Measurement .......................................................... 6-12
  Quick Measurement after AUTO .................................. 6-12
  One-key Measurement of 24 Parameters ..................... 6-13
  Frequency Counter Measurement ............................... 6-18
  Measurement Setting .................................................. 6-19
  To Clear the Measurement .......................................... 6-21
  All Measurement ....................................................... 6-22
  Statistic Function ....................................................... 6-23
  Measurement History .................................................. 6-24
Cursor Measurement ....................................................... 6-24
  Manual Mode ............................................................ 6-24
  Track Mode ............................................................... 6-28
  Auto Mode ............................................................... 6-31
  X-Y Mode ............................................................... 6-32

7 Protocol Decoding ........................................................ 7-1
  Parallel Decoding ....................................................... 7-2
  RS232 Decoding (Option) ............................................. 7-5
  I2C Decoding (Option) ................................................ 7-10
  SPI Decoding (Option) ................................................ 7-14
  CAN Decoding (Option) ............................................... 7-17

8 Reference Waveform ..................................................... 8-1
  To Enable REF Function ............................................. 8-2
  To Set the Color ....................................................... 8-3
  To Select REF Source ................................................ 8-3
  To Save to Internal Memory ....................................... 8-3
  To Adjust REF Waveform Display ............................. 8-4
  To Export to Internal or External Memory ..................... 8-4
  To Import from Internal or External Memory ................ 8-4

9 Pass/Fail Test ............................................................. 9-1
  To Enable Pass/Fail Test ............................................. 9-2
  To Select Source ...................................................... 9-2
  Mask Range ............................................................. 9-2
  Test and Output ....................................................... 9-3
  To Save the Test Mask .............................................. 9-4
To Load the Test Mask................................................................. 9-4

10 Waveform Record ........................................................................ 10-1
   Waveform Record................................................................. 10-2
   Record Constant On............................................................ 10-4
   Waveform Playback............................................................. 10-6
   Waveform Analysis............................................................. 10-8
      Analysis Based on Trace.................................................. 10-12
      Analysis Based on Pass/Fail Mask................................. 10-13

11 Display Control ........................................................................... 11-1
   To Select the Display Type................................................... 11-2
   To Set the Persistence Time................................................ 11-3
   To Set the Waveform Intensity............................................ 11-5
   To Set the Screen Grid........................................................ 11-5
   To Set the Grid Brightness............................................... 11-5
   To Set the Menu Display.................................................... 11-5

12 Signal Source ............................................................................. 12-1
   Parameter Setting Method.................................................... 12-2
   To Output Basic Waveform................................................... 12-3
      To Output Sine ................................................................. 12-3
      To Output Square........................................................... 12-4
      To Output Ramp............................................................. 12-5
      To Output Pulse.............................................................. 12-6
      To Output DC................................................................. 12-6
      To Output Noise............................................................. 12-7
   To Output Built-in Waveform............................................... 12-8
   To Output Arbitrary Waveform............................................ 12-13
      To Select Waveform........................................................ 12-15
      To Create Waveform..................................................... 12-15
      To Edit Waveform......................................................... 12-18
   Modulation........................................................................... 12-20

13 Store and Recall .......................................................................... 13-1
   Storage System....................................................................... 13-2
   Storage Type......................................................................... 13-3
   Internal Storage and Recall............................................... 13-5
   External Storage and Recall............................................... 13-7
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Management</td>
<td>13-9</td>
</tr>
<tr>
<td>To Select File Type</td>
<td>13-10</td>
</tr>
<tr>
<td>To Create a New File or Folder</td>
<td>13-11</td>
</tr>
<tr>
<td>To Delete a File or Folder</td>
<td>13-14</td>
</tr>
<tr>
<td>To Rename a File or Folder</td>
<td>13-15</td>
</tr>
<tr>
<td>To Clear the Local Memory</td>
<td>13-15</td>
</tr>
<tr>
<td>Factory</td>
<td>13-16</td>
</tr>
<tr>
<td>14 System Function Setting</td>
<td>14-1</td>
</tr>
<tr>
<td>Remote Interface Configuration</td>
<td>14-2</td>
</tr>
<tr>
<td>LAN Setting</td>
<td>14-2</td>
</tr>
<tr>
<td>USB Device</td>
<td>14-6</td>
</tr>
<tr>
<td>To Set the GPIB Address</td>
<td>14-6</td>
</tr>
<tr>
<td>System-related</td>
<td>14-7</td>
</tr>
<tr>
<td>Sound</td>
<td>14-7</td>
</tr>
<tr>
<td>Language</td>
<td>14-7</td>
</tr>
<tr>
<td>System Information</td>
<td>14-7</td>
</tr>
<tr>
<td>Power-off Recall</td>
<td>14-8</td>
</tr>
<tr>
<td>System Time</td>
<td>14-8</td>
</tr>
<tr>
<td>Screen</td>
<td>14-9</td>
</tr>
<tr>
<td>Self-calibration</td>
<td>14-10</td>
</tr>
<tr>
<td>Aux Output</td>
<td>14-11</td>
</tr>
<tr>
<td>Option Management</td>
<td>14-12</td>
</tr>
<tr>
<td>15 Remote Control</td>
<td>15-1</td>
</tr>
<tr>
<td>Remote Control via USB</td>
<td>15-2</td>
</tr>
<tr>
<td>Remote Control via LAN</td>
<td>15-6</td>
</tr>
<tr>
<td>Remote Control via GPIB</td>
<td>15-9</td>
</tr>
<tr>
<td>16 Troubleshooting</td>
<td>16-1</td>
</tr>
<tr>
<td>17 Specifications</td>
<td>17-1</td>
</tr>
<tr>
<td>18 Appendix</td>
<td>18-1</td>
</tr>
<tr>
<td>Appendix A: Accessories and Options</td>
<td>18-1</td>
</tr>
<tr>
<td>Appendix B: Warranty</td>
<td>18-3</td>
</tr>
<tr>
<td>Index</td>
<td>1</td>
</tr>
</tbody>
</table>
1 Quick Start

This chapter introduces the preparations when using the oscilloscope for the first time, the front panel, rear panel and user interface of the oscilloscope as well as the using method of the built-in help system.

The contents of this chapter:

- **General Inspection**
- **Appearance and Dimensions**
- **To Prepare the Oscilloscope for Use**
- **Front Panel Overview**
- **Rear Panel Overview**
- **Front Panel Function Overview**
- **User Interface**
- **To Use the Security Lock**
- **To Use the Built-in Help System**
General Inspection

1. **Inspect the shipping container for damage.**
   Keep the damaged shipping container or cushioning material until the contents of the shipment have been checked for completeness and the instrument has passed both electrical and mechanical tests.

   The consigner or carrier shall be liable for the damage to instrument resulting from shipment. RIGOL would not be responsible for free maintenance/rework or replacement of the unit.

2. **Inspect the instrument.**
   In case of any damage, or defect, or failure, notify your RIGOL sales representative.

3. **Check the Accessories**
   Please check the accessories according to the packing lists. If the accessories are incomplete or damaged, please contact your RIGOL sales representative.
Appearance and Dimensions

Figure 1-1 Front View
Unit: mm

Figure 1-2 Top View
Unit: mm
To Prepare the Oscilloscope for Use

To Adjust the Supporting Legs

Adjust the supporting legs properly to use them as stands to tilt the oscilloscope upwards for stable placement of the oscilloscope as well as better operation and observation.

To Connect to Power Supply

The power requirements of the oscilloscope are 100-240 V, 45-440 Hz. Please use the power cord supplied with the accessories to connect the oscilloscope to the power source. At this point, the power key at the lower-left corner of the front panel is in breathing state.
**Power-on Inspection**

When the oscilloscope is energized, press the power key at the lower-left corner of the front panel to start the oscilloscope. During the start-up process, the oscilloscope performs a series of self-tests and you can hear the sound of relay switching. After the self-test, the welcome screen is displayed. The instrument is installed with the trial versions of the options before leaving factory and the remaining time is about 2000 minutes. The “Current Options” dialog box will be displayed if your instrument currently installs the trial versions of options. From this dialog box you can view the types, names, versions and the remaining time of the options currently installed.

**To Connect the Probe**

**RIGOL** provides passive probes for the DS2000A series oscilloscopes. For detailed technical information of the probes, please refer to the corresponding Probe User’s Guide. The following are the probes recommended for this oscilloscope.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RP3300A</td>
<td>350 MHz, passive probe, standard</td>
</tr>
<tr>
<td>RP3500A</td>
<td>500 MHz, passive probe, optional</td>
</tr>
</tbody>
</table>

**Connect the Probe:**

1. Connect the BNC terminal of the probe to a channel BNC connector of the oscilloscope at the front panel.
2. Connect the ground alligator clip of the probe to the circuit ground terminal and connect the probe tip to the circuit point to be tested.

![Figure 1-5 To Connect the Probe](image-url)
Function Inspection

1. Press **Storage** → **Default** to restore the instrument to its default configuration.
2. Connect the ground alligator clip of the probe to the “Ground Terminal” under
the probe compensation signal output terminal.
3. Connect the BNC of the probe to the input terminal of CH1, and the probe tip to
the “Compensation Signal Output Terminal” of the oscilloscope.

![Figure 1-6 To Use the Compensation Signal](image)

4. Press **AUTO**.
5. Observe the waveform on the display. In normal condition, the display should be
a square waveform as shown in the figure below:

![Figure 1-7 Square Waveform](image)

6. Use the same method to test the other channels. If the square waveforms
actually shown do not match that in the figure above, please perform **Probe
Compensation** in the next section.

---

**WARNING**

To avoid electric shock during the use of probe, please make sure that
the insulated wire of the probe is in good condition and do not touch
the metallic part of the probe when the probe is connected to high
voltage source.
Tip

The signal output from the probe compensation connector can only be used for probe compensation adjustment and cannot be used for calibration.

Probe Compensation

When the probes are used for the first time, you should compensate the probes to match the input channels of the oscilloscope. Non-compensated or poorly compensated probes may cause measurement inaccuracy or error. The probe compensation procedures are as follows.

1. Perform steps 1, 2, 3 and 4 of Function Inspection in the previous section.
2. Check the waveforms displayed and compare them with the following.

![Waveforms](image)

- Over compensated
- Perfectly compensated
- Under compensated

Figure 1-8 Probe Compensation

3. Use a nonmetallic driver to adjust the low-frequency compensation adjustment hole on the probe until the waveform displayed is as the “Perfectly compensated” in the figure above.
Front Panel Overview

Figure 1-9 Front Panel Overview
## Table 1-1 Front Panel Description

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Measurement Menu Softkeys</td>
<td>12</td>
<td>Power Key</td>
</tr>
<tr>
<td>2</td>
<td>LCD</td>
<td>13</td>
<td>USB HOST</td>
</tr>
<tr>
<td>3</td>
<td>Multi-function Knob</td>
<td>14</td>
<td>HORIZONTAL</td>
</tr>
<tr>
<td>4</td>
<td>Function Menu Keys</td>
<td>15</td>
<td>Function Menu Softkeys</td>
</tr>
<tr>
<td>5</td>
<td>Signal Source[^1]</td>
<td>16</td>
<td>VERTICAL</td>
</tr>
<tr>
<td>6</td>
<td>Navigation Knob</td>
<td>17</td>
<td>Analog Channel Input Area</td>
</tr>
<tr>
<td>7</td>
<td>CLEAR</td>
<td>18</td>
<td>Waveform Record/Playback</td>
</tr>
<tr>
<td>8</td>
<td>AUTO</td>
<td>19</td>
<td>TRIGGER</td>
</tr>
<tr>
<td>9</td>
<td>RUN/STOP</td>
<td>20</td>
<td>EXT TRIG Input Terminal</td>
</tr>
<tr>
<td>10</td>
<td>SINGLE</td>
<td>21</td>
<td>Probe Compensation Signal Output Terminal/Ground Terminal</td>
</tr>
<tr>
<td>11</td>
<td>Help&amp;Print</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

\[^1\]: Only applicable to DS2000A-S.
Rear Panel Overview

1. **Handle**
   Pull up the handle vertically for easy carrying of the instrument. When you do not need the handle, press it down.

2. **LAN**
   Connect the instrument to the network via this interface for remote control. This oscilloscope conforms to the LXI-C class instrument standards and can quickly build test system with other instruments.

3. **USB DEVICE**
   PictBridge printer or PC can be connected via this interface to print waveform data or control the instrument using PC software or user-defined programming.

4. **Fuse**
   If a new fuse is required, please use the specified fuse (250V, T2A).
1. Quick Start

a) Turn off the instrument and remove the power cord.
b) Insert a small straight screw driver into the groove at the power socket and prize out the fuse seat gently.
c) Take out the fuse and replace it with a specified one. Reinstall the fuse seat.

5. AC Power Socket
AC power input terminal. The power requirement of this oscilloscope is 100-240V, 45-440 Hz. Use the power cord provided with the accessories to connect the instrument to AC power. Then, you can press the power key at the front panel to start the instrument.

6. Lock Hole
You can lock the instrument to a fixed location using the security lock (please buy it yourself) via the lock hole.

7. Trigger Out
The oscilloscope outputs a signal that can reflect the current capture rate of the oscilloscope at each trigger via this interface. Connect this signal to a waveform display device to measure the frequency of the signal and the measurement result should be the same with the current capture rate. The instrument can also output a signal when failed waveform is detected during the pass/fail test.

8. Signal Output
When the corresponding signal source 1 or signal source 2 is enabled, the current signal can be output to the analog channel output terminal of the oscilloscope or the external device connected via [Source 1] or [Source 2]. This function is only applicable to DS2000A-S.
Front Panel Function Overview

VERTICAL

**CH1, CH2**: press this key to set the analog input channels. The 2 channels are marked by different colors which are also used to mark both the corresponding waveforms on the screen and the channel input connectors. Press the key to open the corresponding channel menu and press again to turn off the channel.

**MATH**: press this key to open the math operation menu under which add, subtract, multiply, divide, FFT, logic and advanced operations are provided.

**REF**: press this key to enable the reference waveform function to compare the waveform actually tested with the reference waveform.

**Vertical POSITION**: modify the vertical position of the current channel waveform. Turn clockwise to increase the position and turn counterclockwise to decrease. During the modification, the waveform would move up and down and the position message (e.g. **POS: 300 mV**) at the lower-left corner of the screen would change accordingly. Press down this knob to quickly reset the vertical position to zero.

**VERTICAL SCALE**: modify the vertical scale of the current channel. Turn clockwise to decrease the scale and turn counterclockwise to increase. During the modification, the displayed amplitude of the waveform would enlarge or reduce, the actual amplitude remains unchanged and the scale information (e.g. **1 = 500 mV**) at the lower side of the screen would change accordingly. Press down this knob to quickly switch the vertical scale adjustment modes between “Coarse” and “Fine”.

---

User's Guide for DS2000A
Decode1, Decode2: decoding function keys. Press the corresponding key to open the decoding function menu. DS2000A supports parallel decoding and protocol decodings.

HORIZONTAL

Decode1, Decode2: decoding function keys. Press the corresponding key to open the decoding function menu. DS2000A supports parallel decoding and protocol decodings.

HORIZONTAL MENU: press this key to open the horizontal control menu under which to turn on or off the delayed sweep function, switch between different time base modes, switch between “Coarse” and “Fine” adjustment of scale as well as modify the horizontal reference setting.

HORIZONTAL SCALE: modify the horizontal time base. Turn clockwise to reduce the time base and turn counterclockwise to increase the time base. During the modification, waveforms of all the channels will be displayed in expanded or compressed mode and the time base message (e.g. H 5.000ns) at the upper side of the screen would change accordingly. Press down this knob to quickly switch to delayed sweep state.

HORIZONTAL POSITION: modify the horizontal position. The trigger point would move left or right relative to the center of the screen when you turn the knob. During the modification, waveforms of all the channels would move left or right and the horizontal position message (e.g. D 5.8000000000ns) at the upper-right corner of the screen would change accordingly. Pressing down this knob will quickly reset the horizontal position (or the delayed sweep position).
TRIGGER

**MODE**: press this key to switch the trigger mode to **Auto**, **Normal** or **Single** and the corresponding state backlight of the current trigger mode would be illuminated.

**TRIGGER LEVEL**: modify the trigger level. Turn clockwise to increase the level and turn counterclockwise to reduce the level. During the modification, the trigger level line would move up and down and the value in the trigger level message box (e.g. ![Trigger Level 1.5V](image)) at the lower-left corner of the screen would change accordingly. Pressing down the knob will quickly reset the trigger level to zero point.

**MENU**: press this key to open the trigger operation menu. This oscilloscope provides various trigger types.

**FORCE**: in **Normal** and **Single** trigger modes, press this key to generate a trigger signal forcefully.

CLEAR

Press this key to clear all the waveforms on the screen. If the oscilloscope is in “RUN” state, new waveforms will still be displayed.

RUN/STOP

Press this key to set the state of the oscilloscope to “RUN” or “STOP”. In “RUN” state, the key is illuminated in yellow. In “STOP” state, the key is illuminated in red.
SINGLE

Press this key to set the trigger mode to “Single”, the key is illuminated in orange. In single trigger mode, press [FORCE] to generate a trigger signal immediately.

AUTO

Press this key to enable the waveform auto setting function. The oscilloscope will automatically adjust the vertical scale, horizontal time base and trigger mode according to the input signal to realize optimum waveform display. Note that in the actual measurement, auto setting requires that the frequency of the signal under test should be no lower than 25 Hz. If the parameter exceeds these limits, “Can’t detect any signal!” would be displayed after pressing this key and the quick parameter measurement menu might not be displayed.
Knob

Adjust waveform brightness:
In non-menu-operation mode (menu is hidden), turn this knob to adjust the brightness of waveform display. The adjustable range is from 0% to 100%. Turn clockwise to increase the brightness and counterclockwise to reduce. Pressing down this knob will reset the brightness to 50%. You can also press Display → Wave intensity and use the knob to adjust the waveform brightness.

Multifunction (the backlight goes on during operation):
In menu operation, press any menu softkey and turn the knob to switch to the desired submenu under this menu and then press down the knob to select the current submenu. It can also be used to modify parameters and input filename. Besides, for DS2000A-S oscilloscope, when the current operation interface is signal generator, the numeric keyboard will be displayed when you press the corresponding menu key and press down the knob. At this point, you can use the knob to input the desired parameter value and unit directly.

Navigation Knob

This knob provides quick Adjust/Locate function for numerical parameters with relatively larger settable range. Turn clockwise (counterclockwise) to increase (reduce) the value. The inner knob is used for fine adjustment and the outer knob for coarse adjustment.

For example, this knob can be used to quickly locate the waveform frame (“Current Frame” menu) to be played back in the waveform playback function. Similar menus include trigger holdoff, pulse width setting, slope time etc.
Menu

**Measure**: press this key to open the measurement setting menu. You can set the measurement setting, all measure, statistic function etc.

Press **MENU** at the left of the screen to open the measurement menus of 24 waveform parameters. Then, press down the corresponding menu softkey to quickly realize one-key measurement and the measurement result will be displayed at the bottom of the screen.

**Acquire**: press this key to enter the sample setting menu to set the acquisition mode, memory depth and antialiasing function of the oscilloscope.

**Storage**: press this key to enter the file store and recall interface. The storable file types include traces, waveforms, setups, picture and CSV. Pictures can be stored as bmp, png, jpeg and tiff formats. Internal and external storage as well as disk management are also supported.

**Cursor**: press this key to enter the cursor measurement menu. The oscilloscope provides three cursor modes: manual, track and auto.

**Display**: press this key to enter the display setting menu to set the display type, persistence time, wave intensity, grid type, grid brightness and menu display time of the waveform.

**Utility**: press this key to enter the system utility function setting menu to set the system-related functions or parameters, such as I/O setting, sound and language. Besides, some advanced functions (such as pass/fail test, waveform record and print setting) are also supported.
Source

Press this key to enter the source setting interface. You can enable or disable the output of the [Source1] and [Source2] connectors at the rear panel, set the output signal parameters (such as the frequency, amplitude, offset and phase).

Note: This function is only available for DS2000A-S models oscilloscopes.

Record

Record: press this key to start recording the waveform. At this moment, the red backlight of the key will start flashing. Besides, when the record constant on (Open) is enabled, the backlight will also keep flashing.

Play/Pause: in stop or pause state, press this key to play back the waveform and press again to pause the play. The backlight is illuminated in yellow.

Stop: press this key to stop the waveform being recorded or being played back. The backlight is illuminated in orange.
Print

Press this key to execute the print function or save the screen in the USB storage device. If a PictBridge printer is currently connected and the printer is in idle state, pressing this key will execute the print function. If no printer but a USB storage device is currently connected, pressing this key will save the screen to the USB storage device in “.png” format. If the current storage type is picture, the screen will be saved in the USB storage device in the specified picture format (bmp, png, jpeg and tiff). When printer and USB storage device are connected at the same time, the printer enjoys higher priority.
User Interface

DS2000A provides 8.0 inches, WVGA (800*480) 160,000 color TFT LCD. What is worth mentioning is that the 14-grid ultra-wide screen enables you to view “longer” waveform.

1. Auto Measurement Items

Provide 12 horizontal (HORIZONTAL) and 12 vertical (VERTICAL) measurement parameters. Press the softkey at the left of the screen to activate the corresponding measurement item. Press [MENU] continuously to switch between the horizontal and vertical parameters.
2. **Channel Label/ Waveform**
   Different channels are marked by different colors and the color of the waveform complies with the color of the channel.

3. **Status**
   Available states include RUN, STOP, T’D (triggered), WAIT and AUTO.

4. **Horizontal Time Base**
   - Represent the time per grid on the horizontal axis on the screen.
   - Use **HORIZONTAL SCALE** to modify this parameter. The range available is from 1.000 ns to 1.000 ks (for 200 MHz bandwidth oscilloscope, the range is from 2.000 ns to 1.000 ks; for 100 MHz and 70 MHz bandwidth oscilloscopes, the range is from 5.000 ns to 1.000 ks).

5. **Sample Rate/ Memory Depth**
   - Display the current sample rate and memory depth of the oscilloscope.
   - Use **HORIZONTAL SCALE** to modify this parameter.

6. **Waveform Memory**
   Provide the schematic diagram of the memory position of the waveform currently on the screen.

7. **Trigger Position**
   Display the trigger position of the waveform in the waveform memory and on the screen.

8. **Horizontal Position**
   Use **HORIZONTAL POSITION** to modify this parameter. Pressing down the knob will automatically set the parameter to zero.

9. **Trigger Type**
   Display the trigger type currently selected and trigger condition setting. Different labels are displayed when different trigger types are selected. For example: ![represents triggering on the rising edge in “Edge” trigger.](image)
10. Trigger Source
Display the trigger source currently selected (CH1, CH2, EXT, or AC Line).
Different labels are displayed when different trigger sources are selected and the color of the trigger parameter area will change accordingly.
For example: ![icon]

11. Trigger Level
- ![icon]
at the right of the screen is the trigger level label and the trigger level value is displayed at the upper-right corner of the screen.
- When using **TRIGGER LEVEL** to modify the trigger level, the trigger level value will change with the up and down of ![icon].
Note: In slope trigger, runt trigger and windows trigger, there are two trigger level labels ( ![icon] and ![icon]) at the right of the screen.

12. CH1 Vertical Scale
- Display the voltage value per grid of CH1 waveform vertically.
- Use **V R T I C A L SCALE** to modify this parameter.
- The following labels will be displayed according to the current channel setting: channel coupling (e.g. ![icon]), input impedance (e.g. ![icon]) and bandwidth limit (e.g. ![icon]).

13. CH2 Vertical Scale
- Display the voltage value per grid of CH2 waveform vertically.
- Use **V R T I C A L SCALE** to modify this parameter.
- The following labels will be displayed according to the current channel setting: channel coupling (e.g. ![icon]), input impedance (e.g. ![icon]) and bandwidth limit (e.g. ![icon]).

14. Source 1 Waveform
- Display the type of waveform currently set for Source 1.
- When the impedance of the source is set to 50 Ω, ![icon] is displayed at the right of Source 1 Waveform.
- When modulation is turned on, ![icon] is displayed at the right of Source 1 Waveform.
- Only applicable to DS2000A-S.
15. **Source 2 Waveform**
- Display the type of waveform currently set for Source 2.
- When the impedance of the source is set to 50 Ω, is displayed at the right of Source 2 Waveform.
- When modulation is turned on, is displayed at the right of Source 2 Waveform.
- Only applicable to DS2000A-S.

16. **Message Box**
Display prompt messages.

17. **Notification Area**
Display system time, sound icon and USB storage device icon.
- System Time: displayed in “hh:mm (hour:minute)” format. When printing or storing the waveform, the output file will contain this time message. Press Utility → System → System Time → System Time to set through the following format:
yyyy-mm-dd  hh:mm:ss (year-month-date hour:minute:second)
- Sound Icon: when sound is enabled, will be displayed. Press Utility → Sound to enable or disable the sound.
- USB Storage device Icon: when a USB storage device is detected, will be displayed.

18. **Operation MENU**
Press any softkey to activate the corresponding menu. The following symbols might be displayed in the menu:
- Denote that at the front panel can be used to select parameter items. The backlight of turns on when parameter selection is valid.
- Denote that can be used to modify parameter values. The backlight of turns on when parameter input is valid.
- Denote that can be used to modify parameters and the numeric keyboard with which you can input parameter values directly will be displayed when is pressed down. The backlight of turns on when parameter input is valid.
- Denote that you can use the Navigation Knob to quickly adjust/locate parameters.
- Denote that you can use to select parameter items. The backlight of
keeps on during the operation.

Denote that the current menu has several options.

Denote that the current menu has a lower level menu.

Press this key to return to the previous menu.

Note: The following direction keys might appear in the grid at the lower-left corner of the menu bar:

Denote that you can open the next page menu.

Denote that you can open the previous page menu.
To Use the Security Lock

If needed, you can use the security lock (please buy it yourself) to lock the oscilloscope to a fixed location. The method is as follows, align the lock with the lock hole and plug it into the lock hole vertically, turn the key clockwise to lock the oscilloscope and then pull the key out.

![Security Lock Hole](Figure 1-12 To Use the Security Lock)

Note: Do not insert any other articles into the security lock hole to avoid damaging the instrument.
To Use the Built-in Help System

The help system of this oscilloscope provides instructions for all the function keys (including menu keys) at the front panel. Press [Help] to open the help interface and press again to close the interface. The help interface mainly consists of two parts. The left is “Help Options” and you can use “Button” or “Index” mode to select. The right is “Help Display Area”.

**Button:**
Default mode. In this mode, you can press the button (except the power key, the knob, and the function menu page up/down key) or rotate the multifunction knob to select the name of the key directly to get the corresponding help information in the “Help Display Area”. Use \(\Rightarrow\) to select “To Index” and then press the knob to switch to **Index** mode.

**Index:**
In this mode, use \(\Rightarrow\) to select the desired item (for example, “BW”). The item currently selected is displayed in brown. Press the knob to get the corresponding help information in the “Help Display Area”. Use \(\Rightarrow\) to select “To Button” and then press the knob to switch to **Button** mode.
2 To Set the Vertical System

The contents of this chapter:

- To Enable the Channel
- Channel Coupling
- Bandwidth Limit
- Probe Ratio
- Input Impedance
- Waveform Invert
- Vertical Scale
- Vertical Expansion
- Amplitude Unit
- Channel Label
- Delay Calibration
To Enable the Channel

DS2000A provides 2 analog input channels (CH1 and CH2) and provides independent vertical control system for each channel. As the vertical system setting methods of the 2 channels are completely the same, this chapter takes CH1 as an example to introduce the setting method of the vertical system.

Connect a signal to the channel connector of any channel (for example, CH1) and then press CH1 in the vertical control area (VERTICAL) at the front panel to enable CH1.

Screen:
The channel setting menu is displayed at the right side of the screen and the channel label at the bottom of the screen (as shown in the figure below) is highlighted. The information displayed in the channel label is related to the current channel setting.

After the channel is turned on, modify the parameters such as the vertical scale, horizontal time base and trigger mode according to the input signal to make the waveform display easy to observe and measure.
Channel Coupling

The undesired signals can be filtered out by setting the coupling mode. For example, the signal under test is a square waveform with DC offset.

- When the coupling mode is “DC”: the DC and AC components of the signal under test can both pass the channel.
- When the coupling mode is “AC”: the DC components of the signal under test are blocked.
- When the coupling mode is “GND”: the DC and AC components of the signal under test are both blocked.

Press [CH1] → [Coupling] and use ↑↓ to select the desired coupling mode (the default is DC). The current coupling mode is displayed in the channel label at the bottom of the screen. You can also press [Coupling] continuously to switch the coupling mode.

Bandwidth Limit

Setting the bandwidth limit can reduce the display noise. For example, the signal under test is a pulse with high frequency oscillation.

- When bandwidth limit is disabled, the high frequency components of the signal under test can pass the channel.
- Enable bandwidth limit and limit the bandwidth to 20 MHz or 100 MHz (only applicable to 200 MHz and 300 MHz oscilloscopes), the high frequency components that exceed 20 MHz or 100 MHz are attenuated.

Note: for DS2102 and DS2072, the bandwidth limit can only be set to 20 MHz.

Press [CH1] → [BW Limit] and use ↑↓ to enable or disable bandwidth limit (the default is OFF). When bandwidth limit (20 MHz or 100 MHz) is enabled, the character “B” will be displayed in the channel label at the bottom of the screen. You can also press [BW Limit] continuously to switch between on and off of the bandwidth limit.
Probe Ratio

You can set the probe attenuation ratio manually. The probe ratio values available are as shown in the table below.

Table 2-1 Probe Attenuation Coefficient

<table>
<thead>
<tr>
<th>Menu</th>
<th>Attenuation Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01X</td>
<td>1:100</td>
</tr>
<tr>
<td>0.02X</td>
<td>1:50</td>
</tr>
<tr>
<td>0.05X</td>
<td>1:20</td>
</tr>
<tr>
<td>0.1X</td>
<td>1:10</td>
</tr>
<tr>
<td>0.2X</td>
<td>1:5</td>
</tr>
<tr>
<td>0.5X</td>
<td>1:2</td>
</tr>
<tr>
<td>1X</td>
<td>1:1</td>
</tr>
<tr>
<td>2X</td>
<td>2:1</td>
</tr>
<tr>
<td>5X</td>
<td>5:1</td>
</tr>
<tr>
<td>10X</td>
<td>10:1</td>
</tr>
<tr>
<td>20X</td>
<td>20:1</td>
</tr>
<tr>
<td>50X</td>
<td>50:1</td>
</tr>
<tr>
<td>100X</td>
<td>100:1</td>
</tr>
<tr>
<td>200X</td>
<td>200:1</td>
</tr>
<tr>
<td>500X</td>
<td>500:1</td>
</tr>
<tr>
<td>1000X</td>
<td>1000:1</td>
</tr>
</tbody>
</table>

Input Impedance

This oscilloscope provides two input impedance modes (1 MΩ (default) and 50 Ω) to reduce the circuit load caused by the interaction of the oscilloscope and the circuit to be tested.

- 1 MΩ: the input impedance of the oscilloscope is rather high and the current flowing into the oscilloscope from the circuit under test cannot be ignored.
- 50 Ω: match the oscilloscope with a device with 50 Ω output impedance.

Press CH1 → Input to set the input impedance of the oscilloscope. When “50 Ω” is selected, “Ω” is displayed in the channel label at the bottom of the screen.
Waveform Invert

When waveform invert is enabled, the waveform display rotates 180 degree relative to the ground potential. When waveform invert is disabled, the waveform display is normal. Press CH1 → Invert to enable or disable waveform invert.

Vertical Scale

The vertical scale can be adjusted in “Coarse” or “Fine” mode.

Press CH1 → Volts/Div to select the desired mode. Rotate VERTICAL SCALE to adjust the vertical scale (clockwise to reduce the scale and counterclockwise to increase).

The scale information (such as ) in the channel label at the bottom of the screen will change accordingly during the adjustment. The adjustable range of the vertical scale is related to the probe ratio currently set. By default, the probe ratio is 1X and the adjustable range of the vertical scale is from 500 μV/div to 10 V/div.

- Coarse adjustment (take counterclockwise as an example): set the vertical scale in 1-2-5 step namely 500 μV/div, 1 mV/div, 2 mV/div, 5 mV/div, 10 mV/div...10 V/div.
- Fine adjustment: further adjust the vertical scale within a relatively smaller range to improve vertical resolution. If the amplitude of the input waveform is a little bit greater than the full scale under the current scale and the amplitude would be a little bit lower if the next scale is used, fine adjustment can be used to improve the amplitude of waveform display to view signal details.

Note: You can also press VERTICAL SCALE to quickly switch between “Coarse” and “Fine” adjustments.
Vertical Expansion

When using VERTI CAL SCALE to change the vertical scale of the analog channel, you can choose to expand or compress the signal vertically around the center of the screen or the ground point of the signal.

Press Utility → System → VerticalExp to select “Center” or “Ground” and the default is “Ground”.

- Center: when the vertical scale is modified, the waveform will expand or compress around the center of the screen.
- Ground: when the vertical scale is modified, the waveform ground level will remain at the same point on the screen and the waveform will expand or compress around this point.

Amplitude Unit

Select the amplitude display unit for the current channel. The available units are W, A, V and U. When the unit is changed, the unit displayed in the channel label will change accordingly.

Press CH1 → Unit to select the desired unit and the default is V.
Channel Label

You can modify the labels used to mark the analog channels (CH1 and CH2) at the left side of the screen. The label is the number of the channel (such as 1) by default and the length of the label can not exceed 4 characters. Note: Only English input method can be used for this operation.

Press [CH1 → Label] to enter the label modification interface.

For example, change “1” to “Chn1”.

Press Keyboard to select the “Keyboard” area. Select “A” using ⇧ and press down ⇧ to switch it to “A”. Select “C” using ⇧ and press down ⇧ to input the character. Use the same method to input “hn1”.

After finishing the input, press OK to finish the modification and the channel label will change to “Chn1”.

To modify or delete the input character, press Name to select the “Name Input Area” and use ⇧ to select the character to be modified or deleted. Enter the desired character or press Delete to delete the character selected.
Delay Calibration

When using an oscilloscope for actual measurement, the transmission delay of the probe cable may bring relatively greater error (zero offset). DS2000A allows users to set a delay time to calibrate the zero offset of the corresponding channel. Zero offset is defined as the offset of the crossing point of the waveform and trigger level line relative to the trigger position, as shown in the figure below.

![Zero Offset](image)

Figure 2-2 Zero Offset

Press **CH1 → Delay-Cal** and use 🔄 to set the desired delay time. The range available is from -200 ns to 200 ns.

Note: This parameter is related to the instrument model and the current horizontal scale setting. The larger the horizontal scale is, the larger the scale will be. Take DS2302A as an example, when the horizontal scale is set to 200.0 ns, you can set the delay time in 4 ns step namely -200 ns, -196 ns, -192 ns…200 ns; when the horizontal scale is set to 2.000 us, you can set the delay time in 40 ns step namely -200 ns, -160 ns, -120 ns…200 ns; when the horizontal scale is set to larger then 10 us, you cannot set the delay time, it keeps 0.00 s.
3 To Set the Horizontal System

The contents of this chapter:

- Delayed Sweep
- Time Base Mode
- Horizontal Scale
- Horizontal Reference
Delayed Sweep

Delayed sweep can be used to enlarge a length of waveform horizontally to view the waveform details.

Press **MENU** in the horizontal control area (HORIZONTAL) at the front panel and press **Delayed** to enable or disable delayed sweep. Note that to enable delayed sweep, the current time base mode must be “Y-T” and the “Pass/Fail test” must be disabled.

In delayed sweep mode, the screen is divided into two display areas as shown in the figure below.

![Delayed Sweep Diagram](image)

**The waveform before enlargement:**
The waveform in the area that has not been covered by the subtransparent blue in the upper part of the screen is the waveform before enlargement. You can turn **HORIZONTAL** **POSITION** to move the area left and right or turn **HORIZONTAL** **SCALE** to enlarge or reduce this area.
The waveform after enlargement:
The waveform in the lower part of the screen is the horizontally expanded waveform. Note: Compared to the main time base, the delayed time base has increased the waveform resolution (as shown in the figure above). The delayed time base should be less than or equal to the main time base.

Tip
You can also press down HORIZONTAL  SCALE (delayed sweep shortcut key) to directly switch to delayed sweep mode.
Time Base Mode

Press [MENU] in the horizontal control area (HORIZONTAL) at the front panel and then press [Time Base] to select the time base mode of the oscilloscope and the default is Y-T.

Y-T Mode

This mode is the main time base mode and is applicable to both of the input channels.
In this mode, the Y axis represents voltage and the X axis represents time. Note that only when this mode is enabled can [Delayed Sweep] be turned on.

X-Y Mode

In this mode, the oscilloscope changes the two channels from voltage-time display mode to voltage-voltage display mode. Wherein, the X axis and Y axis tracks the voltages of CH1 and CH2 respectively. The phase deviation between two signals with the same frequency can be easily measured via Lissajous method. The figure below shows the measurement schematic diagram of the phase deviation.

![Measurement Schematic Diagram of the Phase Deviation](image)

Figure 3-2 Measurement Schematic Diagram of the Phase Deviation
According to $\sin \theta = \frac{A}{B}$ or $\frac{C}{D}$ (wherein, $\theta$ is the phase deviation angle between the two channels and the definitions of A, B, C and D are as shown in the figure above), the phase deviation angle is obtained, that is:

$$\theta = \pm \arcsin \left( \frac{A}{B} \right) \text{ or } \pm \arcsin \left( \frac{C}{D} \right)$$

If the principal axis of the ellipse is within quadrant I and III, the phase deviation angle obtained should be within quadrant I and IV, namely within $(0 \text{ to } \pi/2)$ or $(3\pi/2 \text{ to } 2\pi)$. If the principal axis of the ellipse is within quadrant II and IV, the phase deviation angle obtained should be within quadrant II and III, namely within $(\pi/2 \text{ to } \pi)$ or $(\pi \text{ to } 3\pi/2)$.

X-Y function can be used to measure the phase deviation occurred when the signal under test passes through a circuit network. Connect the oscilloscope to the circuit to monitor the input and output signals of the circuit.

**Application example:** measure the phase deviation of the input signals of two channels.

**Method 1: Use Lissajous method**

1. Connect a sine signal to CH1 and then connect a sine signal with the same frequency and amplitude but a 90° phase deviation to CH2.
2. Press [AUTO] and enable X-Y mode. Rotate **Horizontal SCALE** to adjust the sample rate properly to get better Lissajous figure for better observation and measurement.
3. Rotate **VERTICAL POSITION** of CH1 and CH2 to display the signals at the center of the screen and rotate **VERTICAL SCALE** of CH1 and CH2 to make the signals easy to observe. At this point, the circle as shown in the figure below should be displayed.
4. As shown in the figure above, the distances from the crossing points of axis and the circle to the origin of the coordinates are approximately equal. Thus, the phase deviation angle $\theta = \pm \arcsin \frac{1}{\sin 90°} = 90°$.

**Note:**

- In Y-T mode, the oscilloscope could use any sample rate (within the guaranteed range) to capture waveform. The maximum sample rate of X-Y mode is 1.0 GSa/s. Generally, reducing the sample rate properly could improve the display effect of Lissajous figure.
- When X-Y mode is enabled, **Delayed Sweep** will be disabled automatically.
- The following functions are not available in X-Y mode:
  - Auto measure, math operation, reference waveform, delayed sweep, vector display, **HORIZONTAL POSITION**, trigger control, decoding control, acquisition mode, Pass/Fail test and waveform record.

**Method 2: Use the shortcut measurement function**

Please refer to “Phase 1→2f” and “Phase 1→2t” measurement functions of “**Delay and Phase**” in page **6-15**.
**Roll Mode**

In this mode, the waveform scrolls from the right to the left to update the display. The range of horizontal scale adjustment is from 200.0 ms to 1.000 ks.

Note: When Roll mode is enabled, the horizontal position, Delayed Sweep, Protocol Decoding, Pass/ Fail Test, Measurement Range, Waveform Record, To Set the Persistence Time and To Trigger the Oscilloscope are not available.

---

**Slow Sweep**

Another mode similar to Roll mode. In Y-T mode, when the horizontal time base is set to 200 ms or slower, the instrument enters “slow sweep” mode in which the instrument first acquires the data at the left of the trigger point and then waits for trigger event. After the trigger occurs, the instrument continues to finish the waveform at the right of the trigger point. When slow sweep mode is used to observe low frequency signal, it is recommended that the Channel Coupling is set to “DC”.
Horizontal Scale

Being similar to Vertical Scale, the horizontal scale can be adjusted in “Coarse” or “Fine” mode.

Press **MENU → ScaleAdjust** in the horizontal control area (HORIZONTAL) at the front panel to select the desired mode. Turn **HORIZONTAL SCALE** to adjust the horizontal scale. Turn clockwise to reduce the horizontal scale and turn counterclockwise to increase.

The scale information (such as **H 1.000s**) at the upper left corner of the screen will change accordingly during the adjustment. The range of horizontal scale adjustment is from 1.000 ns to 1.000 ks (for 200 MHz bandwidth oscilloscope, the range is from 2.000 ns to 1.000 ks; for 100 MHz and 70 MHz bandwidth oscilloscopes, the range is from 5.000 ns to 1.000 ks).

- **Coarse** (take counterclockwise as an example): set the horizontal scale in 1-2-5 step namely 1 ns、2 ns、5 ns、10 ns...1.000 ks.
- **Fine**: further adjust within smaller range.
Horizontal Reference

Horizontal reference is the reference position according to which the screen waveform expands or compresses horizontally when adjusting **HORIZONTAL SCALE**. In Y-T mode (this function is not available in X-Y mode and Roll mode), press **MENU → HorRef** in the horizontal control area (HORIZONTAL) at the front panel to select the desired reference mode and the default is “Center”.

1. **Center**
   - When changing the horizontal time base, the waveform expands or compresses horizontally around the center of the screen.

2. **Trig Pos**
   - When changing the horizontal time base, the waveform expands or compresses horizontally around the trigger point.

3. **User**
   - When changing the horizontal time base, the waveform expands or compresses horizontally around the user-defined reference position. In the horizontal direction, the screen can display a maximum of 700 points with the leftmost as 350 and the rightmost as -350. For example, set the reference position to 150.
4 To Set the Sample System

The contents of this chapter:

- Acquisition Mode
- Sample Mode
- Sample Rate
- Memory Depth
- Antialiasing
Acquisition Mode

The acquisition mode is used to control how to generate waveform points from sample points.

Press Acquire → Acquisition in the function menu at the front panel and use to select the desired acquisition mode (the default is normal), then press down the knob to select this mode. You can also press Acquisition continuously to switch the acquisition mode.

Normal

In this mode, the oscilloscope samples the signal at equal time interval to rebuild the waveform. For most of the waveforms, the best display effect can be obtained using this mode.

Average

In this mode, the oscilloscope averages the waveforms from multiple samples to reduce the random noise of the input signal and improve the vertical resolution. The greater the number of averages is, the lower the noise will be and the higher the vertical resolution will be but the slower the response of the displayed waveform to the waveform changes will be.

The available range of the number of averages is from 2 to 8192 and the default is 2. When “Average” mode is selected, press Averages and use to set the desired number of averages as the power function of 2.
Figure 4-1 The Waveform before Average

Figure 4-2 The Waveform after 256 Averages
Peak Detect

In this mode, the oscilloscope acquires the maximum and minimum values of the signal within the sample interval to get the envelope of the signal or the narrow pulse of the signal that might be lost. In this mode, signal confusion can be prevented but the noise displayed would be larger.

In this mode, the oscilloscope can display all the pulses with pulse widths at least as wide as the sample period.

High Resolution

This mode uses a kind of ultra-sample technique to average the neighboring points of the sample waveform to reduce the random noise on the input signal and generate much smoother waveforms on the screen. This is generally used when the sample rate of the digital converter is higher than the storage rate of the acquisition memory.

Note: “Average” and “High Res” modes use different averaging methods. The former uses “Multi-sample Average” and the latter uses “Single Sample Average”.
Sample Mode

This oscilloscope only supports real-time sample. In this mode, the oscilloscope samples and displays waveform within a trigger event. The maximum real-time sample rate of DS2000A is 2 GSa/s and the current sample rate is displayed under the **Sa Rate** menu.

**Tip**

Press **RUN/STOP** to stop the sample, the oscilloscope will hold the last display. At this point, you can still use the vertical control and horizontal control to pan and zoom the waveform.
Sample Rate

The sample rate of this oscilloscope is up to 2 GSa/s. Note that the sample rate is displayed in the status bar at the upper side of the screen and in the Sample Rate menu and can be changed by adjusting the horizontal time base (s/div) through HORIZONTAL SCALE or modifying the Memory Depth.

The influence on the waveform when the sample rate is too low:

1. **Waveform Distortion**: when the sample rate is too low, some waveform details are lost and the waveform displayed is rather different from the actual signal.

2. **Waveform Confusion**: when the sample rate is lower than twice the actual signal frequency (Nyquist Frequency), the frequency of the waveform rebuilt from the sample data is lower than the actual signal frequency.
3. **Waveform Leakage:** when the sample rate is too low, the waveform rebuilt from the sample data does not reflect all the actual signal information.
Memory Depth

Memory depth refers to the number of waveform points that the oscilloscope can store in a single trigger sample and it reflects the storage ability of the sample memory. DS2000A provides up to 56 Mpts memory depth (option) and 14 Mpts standard memory depth.

![Figure 4-3 Memory Depth](image)

The relation of memory depth, sample rate and horizontal timebase scale fulfills the equation below. Therefore, under the same horizontal timebase scale, higher memory depth can ensure higher sample rate.

\[
MDepth = SRate \times TScale \times HDivs
\]

Wherein,
- \(MDepth\) -- Memory depth and its unit is pts
- \(SRate\) -- Sample Rate and its unit is Sa/s
- \(TScale\) -- Horizontal timebase scale and its unit is s/div
- \(HDivs\) -- The Number of Divisions in the Horizontal Axis and its unit is div. For DS2000A, it is equal to 14.

Press \(\text{Acquire} \rightarrow \text{Mem Depth}\), use \(\downarrow\) to switch to the desired memory depth (the default is auto) and then press down the knob to select the option. You can also press \(\text{Mem Depth}\) continuously to switch the memory depth.

When a single channel is enabled, the memory depths available include Auto, 14kPoints, 140kPoints, 1.4MPoints, 14MPoints and 56MPoints (option). In “Auto” mode, the oscilloscope selects the memory depth automatically according to the
current sample rate.

When CH1 and CH2 are enabled, the memory depths available include Auto, 7kPoints, 70kPoints, 700kPoints, 7MPoints and 28MPoints (option). In “Auto” mode, the oscilloscope selects the memory depth automatically according to the current sample rate.

Antialiasing

At slower sweep speed, the sample rate is reduced and a dedicated display algorithm is used to minimize the possibility of aliasing.

Press **Acquire** ➔ **Anti_Aliasing** to enable or disable the antialiasing function. By default, antialiasing is disabled. The displayed waveforms will be more susceptible to aliasing when this function is disabled.
5 To Trigger the Oscilloscope

For trigger, you set certain trigger condition according to the requirement and when a waveform in the waveform stream meets this condition, the oscilloscope captures this waveform as well as the neighbouring part and displays them on the screen. For digital oscilloscope, it displays waveform continuously no matter whether it is stably triggered, but only stable trigger can ensures stable display. The trigger circuit ensures that every time base sweep or acquisition starts from the input signal and the user-defined trigger condition, namely every sweep is synchronous to the acquisition and the waveforms acquired overlap to display stable waveform.

Trigger setting should be based on the features of the input signal, thus you need to have some knowledge of the signal under test to quickly capture the desired waveform. This oscilloscope provides abundant advanced trigger functions which can help you to focus on the desired waveform details.

The contents of this chapter:

- **Trigger Source**
- **Trigger Mode**
- **Trigger Coupling**
- **Trigger Holdoff**
- **Noise Rejectio**
- **Trigger Type**
- **Trigger Output Connector**
5-2

User’s Guide for DS2000A

5 To Trigger the Oscilloscope

Trigger Source

Press **MENU** → **Source** in the trigger control area (TRIGGER) at the front panel to select the desired trigger source. Signals input from CH1/CH2 and the **[EXT TRIG]** connector as well as the AC Line can all be used as trigger source.

**Analog channel input:**
Signals input from analog channels CH1 and CH2 can all be used as the trigger source. No matter whether the input of the channel selected is enabled, the channel can work normally.

**External trigger input:**
External trigger source can be used to connect external trigger signal to the EXT TRIG channel when both of the two channels are sampling data. The trigger signal (such as external clock and signal of the circuit to be tested) will be connected to EXT trigger source via the **[EXT TRIG]** connector. You can set the trigger condition within the range of trigger level (-4 V to +4 V).

**AC line:**
The trigger signal is obtained from the AC power input of the oscilloscope. This kind of signal source can be used to display the relationship between signal (such as illuminating device) and power (power supply device). For example, to stably trigger the waveform output from the transformer of a transformer substation, which is mainly used in related measurement of the power industry.
Trigger Mode

Trigger mode affects the way in which the oscilloscope searches for the trigger. The following is the schematic diagram of the acquisition memory. As shown in the figure below, the position of the trigger event is determined by the reference time point and the delay setting. Note that the acquisition memory of the oscilloscope is a cyclic buffer and the new data would overwrite the old data until the acquisition finishes.

Pre-trigger/Delayed trigger:
Acquire data before/after the trigger event. The trigger position is usually at the horizontal center of the screen. In full-screen display, seven-grid pre-trigger and delayed trigger information are displayed respectively. You can adjust the horizontal position of the waveform through HORIZONTAL POSITION to view more pre-trigger information and delayed trigger information, through which the signal information before/after the trigger (such as capture the glitch generated by the circuit and analyze the pre-trigger data to find out the reasons for glitch) can be obtained.

Press MODE in the trigger control area (TRIGGER) at the front panel or press MENU → Sweep to select the desired trigger mode. The corresponding status light of the mode currently selected turns on.

Auto:
No matter whether the trigger condition is met, there is always waveform display. A horizontal line is displayed when no signal is input.
In this mode, the oscilloscope operates by first filling the pre-trigger buffer. It starts searching for a trigger after the pre-trigger buffer is filled and continues to flow data
through this buffer while it searches for the trigger. While searching for the trigger, the oscilloscope overflows the pre-trigger buffer and the first data put into the buffer is first pushed out (First Input First Out, FIFO). When a trigger is found, the pre-trigger buffer would contain the data acquired just before the trigger. If no trigger is found, the oscilloscope will trigger forcefully. If forceful trigger is invalid, the oscilloscope still displays waveform but the waveform is not stable; if forceful trigger is valid, the oscilloscope displays stable waveform.

This trigger mode is applicable to low-repetitive-rate signals and unknown signal levels. To display DC signals, you must use auto trigger mode.

Note: When the horizontal time base is set to 50 ms/div or greater, this trigger mode allows the absence of trigger signal.

**Normal:**
Display waveform when the trigger condition is met; otherwise, the oscilloscope holds the original waveform and waits for the next trigger.
In this mode, the oscilloscope fills the pre-trigger buffer first and then search for a trigger while at the same time continues filling data. While searching for the trigger, the oscilloscope overflows the pre-trigger buffer and the first data put into the buffer is first pushed out (FIFO). When a trigger is found, the oscilloscope will fill the post-trigger buffer and display the acquisition memory.
Use normal trigger mode for low-repetitive-rate signals or when auto trigger is not required.
Note: In this mode, pressing **FORCE** can generate a trigger signal forcefully.

**Single:**
When this mode is selected, the backlight of **SINGLE** turns on. The oscilloscope waits for a trigger and displays the waveform when the trigger condition is met and then stops.
Note: In this mode, pressing **FORCE** can generate a trigger signal forcefully.
Trigger Coupling

Trigger coupling decides which kind of components will be transmitted to the trigger circuit. Please distinguish it with Channel Coupling.
- DC: allow DC and AC components into the trigger path.
- AC: block all the DC components and attenuate signals lower than 75 Hz.
- LF Reject: block the DC components and reject the low frequency components (lower than 75 kHz).
- HF Reject: reject the high frequency components (higher than 75 kHz).

Press [MENU] → Setting → Coupling in the trigger control area (TRIGGER) at the front panel to select the desired coupling type (the default is DC). Note that trigger coupling is only valid in edge trigger.
Trigger Holdoff

Trigger holdoff can be used to stably trigger the complex waveforms (such as pulse series). Holdoff time is the amount of time that the oscilloscope waits before re-arming the trigger circuitry. The oscilloscope will not trigger until the holdoff time expires.

Press **MENU → Setting → Holdoff** in the trigger control area (TRIGGER) at the front panel and use ← to modify the holdoff time (the default is 100 ns) until the waveform triggers stably. The adjustable range of holdoff time is from 100 ns to 10 s. Note that trigger holdoff is not available for Nth edge trigger, video trigger, RS232 trigger, I2C trigger, SPI trigger, USB trigger and CAN trigger.
Noise Rejection

Noise rejection reduces the trigger sensitivity and also reduces the possibility of noise trigger; therefore, a larger signal is required to trigger the oscilloscope.

Press **MENU -> Setting -> Noise Reject** in the trigger control area (TRIGGER) at the front panel to enable or disable noise rejection.
Trigger Type

DS2000A provides various trigger functions, including various serial bus triggers.

- **Edge Trigger**
- **Pulse Trigger**
- **Runt Trigger**
- **Windows Trigger (Option)**
- **Nth Edge Trigger**
- **Slope Trigger**
- **Video Trigger (HDTV Option)**
- **Pattern Trigger**
- **Delay Trigger (Option)**
- **TimeOut Trigger (Option)**
- **Duration Trigger (Option)**
- **Setup/Hold Trigger**
- **RS232 Trigger**
- **I2C Trigger**
- **SPI Trigger**
- **USB Trigger (Option)**
- **CAN Trigger (Option)**
Edge Trigger

Trigger on the trigger threshold of the specified edge of the input signal.

**Trigger Type:**
Press **Type** to select “Edge”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Trigger Type Example](image)

**Source Selection:**
Press **Source** to select CH1, CH2, EXT or AC Line as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen. Note: Select channel with signal input as trigger source to obtain stable trigger.

**Edge Type:**
Press **Slope** to select the kind of edge of the input signal on which the oscilloscope triggers. The current edge type is displayed at the upper right corner of the screen.

- ![Edge Type Example](image)

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger coupling, trigger holdoff and noise rejection) under this trigger type.

**Trigger Level:**
Trigger occurs only when the signal reaches the preset trigger level.

Use **TRIGGER LEVEL** to modify the level. An orange trigger level line and the trigger mark “!” appear on the screen and move up and down with the rotation of the knob, while at the same time, the trigger level value (such as ![Trigger Level Example](image)) at the lower left corner of the screen also changes accordingly. When stopping turning the knob, the trigger level line and the trigger mark disappear in about 2 s.
Pulse Trigger

Trigger on the positive or negative pulse with a specified width.

**Trigger Type:**
Press **Type** to select “Pulse”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Trigger Setting](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.
Note: Select channel with signal input as trigger source to obtain stable trigger.

**Pulse Condition:**
Press **When** to select the desired pulse condition.
- : trigger when the positive pulse width of the input signal is greater than the specified pulse width.
- : trigger when the positive pulse width of the input signal is lower than the specified pulse width.
- : trigger when the positive pulse width of the input signal is greater than the specified lower limit of pulse width and lower than the upper limit of pulse width.
- : trigger when the negative pulse width of the input signal is greater than the specified pulse width.
- : trigger when the negative pulse width of the input signal is lower than the specified pulse width.
- : trigger when the negative pulse width of the input signal is greater than the specified lower limit of pulse width and lower than the upper limit of pulse width.

**Pulse Width Setting:**
In this oscilloscope, positive pulse width is defined as the time difference between the two crossing points of the trigger level and positive pulse as shown in the figure below.
5 To Trigger the Oscilloscope

When the Pulse Condition is set to \( \begin{array}{c} > \\ < \\ = \\ \neq \end{array} \), press Setting and use ↓ or the navigation knob to input the desired value. The range available is from 2 ns to 4 s.

- When the Pulse Condition is set to \( \begin{array}{c} > \\ = \\ \neq \end{array} \), press Upper Limit and Lower Limit and use ← or the navigation knob to input the desired values respectively. The range of the upper limit is from 10 ns to 4 s. The range of the lower limit is from 2 ns to 3.99 s. Note that the lower limit of the pulse width must be lower than the upper limit.

Trigger Mode:
Press Sweep to select the Trigger Mode (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

Trigger Setting:
Press Setting to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

Trigger Level:
Use TRIGGER LEVEL to modify the level. For details, please refer to the description of Trigger Level on page 5-9.
Runt Trigger

This trigger mode is used to trigger pulses that pass through one trigger level but fails to pass through the other trigger level as shown in the figure below.

![Figure 5-3 Runt Trigger](image)

**Trigger Type:**
Press **Type** to select “Runt”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Image of trigger settings](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.

**Pulse Polarity:**
Press **Polarity** to select the pulse polarity of runt trigger.
- **|** : positive polarity. The instrument triggers on the positive runt pulse.
- **-** : negative polarity. The instrument triggers on the negative runt pulse.

**Qualifier:**
Press **Qualifier** to set the trigger conditions of runt trigger.
- **None**: do not set the trigger condition of runt trigger.
- **>** : trigger when the runt pulse width is greater than the lower limit of pulse width. Press **Lower Limit** to set the minimum pulse width of runt trigger. The range available is from 2 ns to 4 s.
- **<** : trigger when the runt pulse width is lower than the upper limit of pulse width.
Press **Upper Limit** to set the maximum pulse width of runt trigger. The range available is from 2 ns to 4 s.

- `<>`: trigger when the runt pulse width is greater than the lower limit and lower than the upper limit of pulse width. Press **Upper Limit** to set the maximum pulse width of runt trigger and the range is from 10 ns to 4 s; press **Lower Limit** to set the minimum pulse width of runt trigger and the range is from 2 ns to 3.99 s.
  
  Note: The lower limit of the pulse width must be lower than the upper limit.

**Vertical Window:**
Press **Vertical** to select the desired vertical window type. Note that under the “Runt trigger” menu, you can press the trigger level knob continuously to switch among different vertical window types.

You can select the boundary of the trigger level to be set and then use **Trigger LEVEL** to adjust the trigger level. During the adjustment, two orange trigger level lines and trigger marks (11 and 12) appear on the screen and move up and down with the rotation of the knob. At the same time, the current trigger level values are displayed at the lower left corner of the screen. The trigger level lines and trigger marks disappear after you stop rotating the knob for about 2 s.

![Trigger Level](image)

The adjustment mode of the trigger level differs when different vertical window is selected.

- [ ]: only adjust the upper limit of the trigger level. During the adjustment, the “Up Level” changes accordingly and “Low Level” remains unchanged.

- [ ]: only adjust the lower limit of the trigger level. During the adjustment, the “Low Level” changes accordingly and the “Up Level” remains unchanged.

- [ ]: adjust the upper and lower limits of the trigger level at the same time. During the adjustment, the “Up Level” and “Low Level” change accordingly.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.
Windows Trigger (Option)

Windows trigger provides a high trigger level and a low trigger level. The instrument
triggers when the input signal passes through the high trigger level or the low trigger
level.

Trigger Type:
Press **Type** to select “Windows”. At this point, the trigger setting information as
shown in the figure below is displayed at the upper right corner of the screen.

Source Selection:
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger
source is displayed at the upper right corner of the screen.
Note: Select channel with signal input as trigger source to obtain stable trigger.

Windows Type:
Press **WndType** to select the kind of edge of the input signal on which the
oscilloscope triggers.
- ![Image](image.png)
  - trigger on the rising edge of the input signal when the voltage level is
    greater than the preset high trigger level.
- ![Image](image.png)
  - trigger on the falling edge of the input signal when the voltage level is
    lower than the preset low trigger level.
- ![Image](image.png)
  - trigger on any edge of the input signal when the voltage level meets the
    preset trigger level.

Trigger Position:
After selecting the windows type, press **Position** to further specify the time point of
trigger by selecting the trigger position.
- ![Image](image.png)
  - *Enter*: trigger when the trigger signal enters the specified trigger level range.
- ![Image](image.png)
  - *Exit*: trigger when the input signal exits the specified trigger level range.
- ![Image](image.png)
  - *Time*: used to specify the hold time of the input signal after entering the
    specified trigger level range. The instrument triggers when the accumulated
    hold time equals the windows time.
**Vertical Window:**
Press **Vertical** to select the desired vertical window type. For detailed operation, please refer to **Vertical Window** (page 5-13).

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.
Nth Edge Trigger (Option)

Trigger on the nth edge that appears after the specified idle time, as shown in the figure below.

![Figure 5-4 Nth Edge Trigger](image)

Trigger Type:
Press **Type** to select “Nth Edge”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

Source Selection:
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.

Note: Select channel with signal input as trigger source to obtain stable trigger.

Edge Type:
Press **Slope** to select the kind of edge of the input signal on which the oscilloscope triggers.
- ![Rising Edge](image): trigger on the rising edge of the input signal when the voltage level meets the specified trigger level.
- ![Falling Edge](image): trigger on the falling edge of the input signal when the voltage level meets the specified trigger level.

Idle Time:
Press **Idle** to set the idle time before the edge counting in Nth egde trigger. The range available is from 16 ns to 4 s.
Edge Number:
Press **Edge** to set the value of “N” in Nth edge trigger and the range available is from 1 to 65535.

Trigger Mode:
Press **Sweep** to select the Trigger Mode (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

Trigger Setting:
Press **Setting** to set the trigger parameter (noise rejection) under this trigger type.

Trigger Level:
Use **TRIGGER LEVEL** to modify the level. For details, please refer to the description of Trigger Level on page 5-9.
**Slope Trigger**

Trigger on the positive or negative slope of specified time.

**Trigger Type:**
Press **Type** to select “Slope”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Slope Trigger Setting](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.

Note: Select channel with signal input as trigger source to obtain stable trigger.

**Slope Condition:**
Press **When** to select the desired slope condition.

- ![Condition Symbol]: trigger when the positive slope time of the input signal is greater than the specified time.
- ![Condition Symbol]: trigger when the positive slope time of the input signal is lower than the specified time.
- ![Condition Symbol]: trigger when the positive slope time of the input signal is greater than the specified lower limit of time and lower than the specified upper limit of time.
- ![Condition Symbol]: trigger when the negative slope time of the input signal is greater than the specified time.
- ![Condition Symbol]: trigger when the negative slope time of the input signal is lower than the specified time.
- ![Condition Symbol]: trigger when the negative slope time of the input signal is greater than the specified lower limit of time and lower than the specified upper limit of time.

**Time Setting:**
In this oscilloscope, positive slope time is defined as the time difference between the two crossing points of trigger level line A and B with the positive edge as shown in the figure on the next page.
5 To Trigger the Oscilloscope

When the **Slope Condition** is set to 0, 0, 0, or 0, press **Time** and use or the navigation knob to input the desired value. The range available is from 10 ns to 1 s.

When the **Slope Condition** is set to 0 or 0, press **Upper Limit** and **Lower Limit** and use or the navigation knob to input the desired values respectively. The range of time upper limit is from 20 ns to 1 s. The range of the time lower limit is from 10 ns to 999 ms. Note that the time lower limit must be lower than the upper limit.

**Vertical Window:**

Press **Vertical** to select the desired vertical window. Note that under the “Slope” trigger menu, you can also press down the trigger level knob continuously to switch the vertical window.

You can select the boundaries of the trigger level and then use **TRIGGER LEVEL** to adjust the trigger level. During the adjustment, two orange trigger level lines and two trigger marks ( and ) appear on the screen and move up and down with the rotation of the knob, when stopping turning the knob, the trigger level lines and trigger marks disappear in about 2 s.

When the **Slope Condition** is set to 0, 0, 0, or 0, the current trigger level and slew rate will be displayed at the lower left corner of the screen, as shown in (a). The formula of slew rate is:

\[
\text{SlewRate} = \frac{\text{UpLevel} - \text{LowLevel}}{\text{TimeSettingValue}}
\]

When the **Slope Condition** is set to 0 or 0, the current trigger level and slew rate range will be displayed at the lower left corner of the screen, as shown.
in (b). The formula of slew rate range is:

\[
\text{SlewRate} = \frac{\text{UpLevel} - \text{LowLevel}}{\text{TimeUpperLimit}} = \frac{\text{UpLevel} - \text{LowLevel}}{\text{TimeLowerLimit}}
\]

The adjustment mode of the trigger level is different when different vertical window is selected.

- : only adjust the upper limit of the trigger level. During the adjustment, “UP Level” and “Slew Rate” change accordingly but “Low Level” remains unchanged.
- : only adjust the lower limit of the trigger level. During the adjustment, “Low Level” and “Slew Rate” change accordingly but “UP Level” remains unchanged.
- : adjust the upper and lower limits of the trigger level at the same time. During the adjustment, “UP Level” and “Low Level” change accordingly but “Slew Rate” remains unchanged.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.
**Video Trigger (HDTV Option)**

Trigger on the standard video signal field or line of NTSC (National Television Standards Committee), PAL (Phase Alternating Line), SECAM (sequential color with memory) or HDTV (High Definition Television).

**Trigger Type:**
Press **Type** to select “Video”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![76.0mV](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.
Note: Select channel with signal input as trigger source to obtain stable trigger.

**Video Polarity:**
Press **Polarity** to select the desired video polarity. The polarities available are normal polarity (👍) and inverted polarity (👎).

**Sync:**
Press **Sync** to select the desired sync type.
- **All Lines**: trigger on all the horizontal sync pulses.
- **Line Num**: for NTSC and PAL/SECAM video standards, trigger on the specified line in the odd or even field; for HDTV video standard, trigger on the specified line. Note that when this sync trigger mode is selected, you can modify the line number using 🔄 in the **Line Num** menu with a step of 1. The range of the line number is from 1 to 525 (NTSC), 1 to 625 (PAL/SECAM), 1 to 525 (480P), 1 to 625 (576P), 1 to 750 (720P), 1 to 1125 (1080P) or 1 to 1125 (1080I).
- **Odd field**: trigger on the rising edge of the first ramp waveform pulse in the odd field.
- **Even field**: trigger on the rising edge of the first ramp waveform pulse in the even field.

**Video Standard:**
Press **Standard** to select the desired video standard.
- **NTSC**: the field frequency is 60 fields per second and the frame frequency is 30 frames per second. The TV sweep line is 525 with the even field goes first and the odd field follows behind.
PAL: the frame frequency is 25 frames per second. The TV sweep line is 625 with the odd field goes first and the even field follows behind.

SECAM: the frame frequency is 25 frames per second. The sweep line is 625 with interlacing sweep.

480P: the frame frequency is 60 frames per second; the TV sweep line is 525; line-by-line sweep; the line frequency is 31.5 kHz.

576P: the frame frequency is 60 frames per second; the TV sweep line is 625; line-by-line sweep.

HDTV: The specified video standards are as follows:
- 720P: the frame frequency is 60 frames per second; the TV sweep line is 750; line-by-line sweep; the line frequency is 45 kHz; the field frequencies available are 60 Hz, 50 Hz, 30 Hz, 25 Hz and 24 Hz.
- 1080P: the frame frequency is 60 frames per second; the TV sweep line is 1125; line-by-line sweep; the field frequencies available are 60 Hz, 50 Hz, 30 Hz, 25 Hz and 24 Hz.
- 1080I: the field frequency is 50 to 60 fields per second; the frame frequency is 25 to 30 frames per second; the TV sweep line is 1125; interlacing sweep; the line frequency is 33.75 kHz; the field frequencies available are 30 Hz, 25 Hz and 24 Hz.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameter (noise rejection) under this trigger type.

**Trigger Level:**
Use **TRIGGER LEVEL** to modify the level. For details, please refer to the description of **Trigger Level** on page 5-9.
Pattern Trigger

Identify a trigger condition by looking for a specified pattern. This pattern is a logical “AND” combination of the two channels. Each channel can have a value of high (H), low (L) or don’t care (X). A rising or falling edge can be specified for one channel included in the pattern. When an edge is specified, the oscilloscope will trigger at the edge specified if the pattern set for the other channel is true (H or L). If no edge is specified, the oscilloscope will trigger on the last edge that makes the pattern true. If both the channels in the pattern are set to “Don’t Care”, the oscilloscope will not trigger.

Figure 5-5 Pattern Trigger

Trigger Type:
Press Type to select “Pattern”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

Channel Selection:
Press Source to select CH1 or CH2 as the channel source for H, L, X or edge condition. The current signal source is displayed at the upper right corner of the screen.

Pattern Setting:
Press Code to set the pattern of the current channel. At this point, the pattern setting area (as shown in the figure below) is displayed at the bottom of the screen.

- H: set the pattern of the channel selected to “H”, namely the voltage level is higher than the threshold level of the channel.
- L: set the pattern of the channel selected to “L”, namely the voltage level is lower than the threshold level of the channel.
- X: set the pattern of the channel selected to “Don’t Care”, namely this channel is not used as a part of the pattern. When both the channels in the pattern are set
to “Don’t Care”, the oscilloscope will not trigger.

- or : set the pattern to the rising or falling edge of the channel selected.

Note: Only one rising or falling edge can be specified in the pattern. If one edge item is currently defined and then another edge item is defined in another channel in the pattern, the former edge item defined will be replaced by H.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

**Trigger Level:**
Use **TRIGGER LEVEL** to modify the level. For details, please refer to the description of **Trigger Level** on page 5-9. Note that the trigger level of each channel needs to be set respectively.
Delay Trigger (Option)

Trigger when the time difference (ΔT) between the specified edges of source A and source B meets the preset time limit, as shown in the figure below. Note that edge A and edge B must be neighbouring edges.

Trigger Type:
Press **Type** to select “Delay”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

Source A:
Press **SourceA** to select CH1 or CH2 as the trigger source of signal source A.

Edge A:
Press **EdgeA** to select the trigger edge type of signal source A in delay trigger. It can be set to the rising edge or falling edge.

Source B:
Press **SourceB** to select CH1 or CH2 as the trigger source of signal source B.

Edge B:
Press **EdgeB** to select the trigger edge type of signal source B in delay trigger. It can be set to the rising edge or falling edge.
Delay Type:
Press DelayType to set the time limit condition of delay trigger.
- >: trigger when the time difference (ΔT) between the specified edges of source A and source B is greater than the preset time limit. Press Time to set the delay time in delay trigger and the range is from 2 ns to 4 s.
- <: trigger when the time difference (ΔT) between the specified edges of source A and source B is lower than the preset time limit. Press Time to set the delay time in delay trigger and the range is from 2 ns to 4 s.
- <>: trigger when the time difference (ΔT) between the specified edges of source A and source B is greater than the lower limit of the preset time and lower than the upper limit of the preset time. Press Upper Limit to set the upper limit of the delay time in delay trigger and the range is from 12 ns to 4 s. Press Lower Limit to set the lower limit of the delay time in delay trigger and the range is from 2 ns to 3.99 s. Note that the time lower limit must be lower than the time upper limit.
- >=: trigger when the time difference (ΔT) between the specified edges of source A and source B is lower than the lower limit of the preset time or greater than the upper limit of the preset time. Press Upper Limit to set the upper limit of the delay time in delay trigger and the range is from 12 ns to 4 s. Press Lower Limit to set the lower limit of the delay time in delay trigger and the range is from 2 ns to 3.99 s. Note that the time lower limit must be lower than the time upper limit.

Trigger Mode:
Press Sweep to select the Trigger Mode (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

Trigger Setting:
Press Setting to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

Trigger Level:
Use TRIGGER LEVEL to modify the level. For details, please refer to the description of Trigger Level on page 5-9. Note that the trigger level of each channel needs to be set respectively.
**Timeout Trigger (Option)**

Trigger when the time interval ($\triangle T$) from when the rising edge (or falling edge) of the input signal passes through the trigger level to when the neighbouring falling edge (or rising edge) passes through the trigger level is greater than the timeout time set, as shown in the figure below.

![Figure 5-7 TimeOut Trigger](image)

**Trigger Type:**
Press **Type** to select “TimeOut”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.

Note: Select channel with signal input as trigger source to obtain stable trigger.

**Edge Type:**
Press **Slope** to select the type of the first edge of the input signal that passes through the trigger level.

- $\uparrow$: start timing when the rising edge of the input signal passes through the trigger level.
- $\downarrow$: start timing when the falling edge of the input signal passes through the trigger level.
- $\uparrow\downarrow$: start timing when any edge of the input signal passes through the trigger level.
**Timeout Time:**
Press **TimeOut** to set the timeout time of timeout trigger and the range is from 16 ns to 4 s.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

**Trigger Level:**
Use TRIGGER \( \text{LEVEL} \) to modify the level. For details, please refer to the description of **Trigger Level** on page 5-9.
Duration Trigger (Option)

Identify a trigger condition by looking for the duration of a specified pattern. This pattern is a logical “AND” combination of the two channels. Each channel can have a value of high (H), low (L) or don’t care (X). The instrument triggers when the duration (\(\Delta T\)) of this pattern meets the preset time, as shown in the figure below.

![Figure 5-8 Duration Trigger](image)

**Trigger Type:**
Press **Type** to select “Duration”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Trigger Setting](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the channel source of H, L or X. The current signal source is displayed at the upper right corner of the screen.

**Pattern Setting:**
Press **Code** to set the pattern of the current channel. At this point, the pattern setting area (as shown in the figure below) is displayed at the bottom of the screen.

![Pattern Setting](image)

- **H**: set the pattern of the channel selected to “H”, namely the voltage level is higher than the threshold level of the channel.
- **L**: set the pattern of the channel selected to “L”, namely the voltage level is lower than the threshold level of the channel.
- **X**: set the pattern of the channel selected to “Don’t Care”, namely this channel is not used as a part of the pattern. When both the channels in the pattern are set
to “Don’t Care”, the oscilloscope will not trigger.

**Trigger Condition:**
Press **When** to select the desired trigger condition.

- **>**: trigger when the duration of the pattern is greater than the preset time. Press **Time** to set the duration of duration trigger and the range is from 2 ns to 4 s.

- **<**: trigger when the duration of the pattern is lower than the preset time. Press **Time** to set the duration of duration trigger and the range is from 2 ns to 4 s.

- **<>**: trigger when the duration of the pattern is lower than the upper limit of the preset time and greater than the lower limit of the preset time. Press **Upper Limit** to set the upper limit of the duration of duration trigger and the range is from 12 ns to 4 s. Press **Lower Limit** to set the lower limit of the duration of duration trigger and the range is from 2 ns to 3.99 s. Note that the time lower limit must be lower than the time upper limit.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

**Trigger Level:**
Use **TRIGGER LEVEL** to modify the level. For details, please refer to the description of **Trigger Level** on page 5-9.
5 To Trigger the Oscilloscope

Setup/ Hold Trigger

Trigger when the internal state of the setup or hold time relative to the clock edge is changed by the logic data input, namely trigger when the setup time (\( \Delta T_1 \)) is less than the preset setup time or when the hold time (\( \Delta T_2 \)) is less than the preset hold time, as shown in the figure below.

\[ \begin{align*}
\Delta T_1 \text{ is the setup time} \\
\Delta T_2 \text{ is the hold time}
\end{align*} \]

The edge type is \( \neg \) The data type is H

Figure 5-9 Setup/Hold Trigger

**Trigger Type:**
Press **Type** to select “Setup/Hold”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

**Source Selection:**
Press **DataSrc** and **ClkSrc** to set the data sources of the data line and clock line respectively. They can be set to CH1 or CH2 and the current data sources are displayed at the upper right corner of the screen.

**Edge Type:**
Press **Slope** to select the desired clock edge type and it can be set to the rising edge or falling edge.

**Data Type:**
Press **Pattern** to set the effective pattern of the data signal to H (high level) or L (low level).
Setup Type:
Press **SetupType** to select the desired setup type.
- **Setup**: set the time that the data stays stable and constant before the clock edge appears. Press **Setup** to set the setup time and the range is from 2 ns to 1 s.
- **Hold**: set the time that the data stays stable and constant after the clock edge appears. Press **Hold** to set the hold time and the range is from 2 ns to 1 s.
- **SetupHold**: set the time that the data stays stable and constant before and after the clock edge appears. Press **Setup** and **Hold** to set the setup time and hold time respectively and the range is from 2 ns to 1 s.

Trigger Mode:
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

Trigger Setting:
Press **Setting** to set the trigger parameters (trigger holdoff and noise rejection) under this trigger type.

Trigger Level:
Press **DataSrc** and use **TRIGGER LEVEL** to modify the trigger level of the data source. Press **ClkSrc** and use **TRIGGER LEVEL** to modify the trigger level of the clock source. For details, please refer to the description of **Trigger Level** on page 5-9.
RS232 Trigger

Trigger according to the start frame, error frame, check error or data. Below is the explanatory figure of RS232 protocol.

![Figure 5-10 RS232 Trigger](image)

**Trigger Type:**
Press **Type** to select “RS232”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

- **Source Selection:**
  Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.

- **Polarity**
  Press **Polarity** to select the polarity of data transmission. It can be set to “Normal” or “Invert” and the default is normal.

- **Trigger Condition:**
  Press **When** to select the desired trigger condition.
  - Start: trigger on the start frame position.
  - Error: trigger when error frame is detected. After this trigger condition is selected:
    --press **Stop Bit** to select “1 bit” or “2 bit”;
    --press **Even-OddCheck** to select “None”, “Odd Checkout” or “Even Checkout”.
    The oscilloscope will determine error frame according to the preset parameters.
  - Check Error: trigger when check error is detected. When this trigger condition is selected, press **Even-OddCheck** to select “Odd Checkout” or “Even Checkout”.
    The oscilloscope will determine check error according to the preset parameters.
  - Data: trigger on the last bit of the preset data bits and even-odd check bits.
    When this trigger condition is selected:
To Trigger the Oscilloscope

--press **Data Bits** to select “5 bit”, “6 bit”, “7 bit” or “8 bit”;
--press **Data** and input the data value according to the setting in **Data Bits** and the ranges are from 0 to 31, from 0 to 63, from 0 to 127 and from 0 to 255 respectively.

**Baud Rate:**
Set the baud rate of data transmission (equal to specifying a clock frequency). Press **Baud** to set the desired baud rate to 2400 bps, 4800 bps, 9600 bps (default), 19200 bps, 38400 bps, 57600 bps, 115200 bps and user-defined. When “User” is selected, press **Setup** and use the navigation knob to set a more specific value from 1 to 900000 with an adjustment step of 1 bps.

**Trigger Mode:**
Press **Sweep** to select the Trigger Mode (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameter (trigger holdoff and noise rejection) under this trigger type.

**Trigger Level:**
Use **TRIGGER LEVEL** to modify the level. For details, please refer to the description of Trigger Level on page 5-9.
I2C Trigger

Trigger on the start condition, restart, stop, missing acknowledgement or on the read/write frame with specific device address and data value. In I2C trigger, you need to specify the SCL and SDA data sources. The figure below shows the complete data transmission of I2C bus.

![I2C Trigger Diagram](image)

Figure 5-11 I2C Trigger

**Trigger Type:**
Press **Type** to select “I2C”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Trigger Setting](image)

**Source Selection:**
Press **SCL** and **SDA** to specify the data sources of SCL and SDA respectively. They can be set to CH1 or CH2 and the current trigger sources are displayed at the upper right corner of the screen.

**Trigger Condition:**
Press **When** to select the desired trigger condition.
- **Start**: trigger when SDA data transitions from high to low while SCL is high.
- **Restart**: trigger when another start condition occurs before a stop condition.
- **Stop**: trigger when SDA data transitions from low to high while SCL is high.
- **Missing ACK**: trigger when the SDA data is high during any acknowledgement of SCL clock position.
Address: trigger on the clock (SCL) edge corresponding to the byte of data (SDA) behind the preset address (Write, Read or R/W direction). After this trigger condition is selected:
-- press **AddrBits** to select “7 bit”, “8 bit” or “10 bit”;
-- press **Address** to set the address value according to the setting in **AddrBits** and the ranges are from 0 to 127, from 0 to 255 and from 0 to 1023 respectively;
-- press **Direction** to select “Read”, “Write” or “R/W”. (Note that this setting is not available when **AddrBits** is set to “8 bit”)

Data: the trigger searches for the control byte value on the data line (SDA) following which there is a reading bit and an acknowledgement bit and then searches for the specified data value. When this event occurs, the oscilloscope will trigger on the clock edge of the acknowledgement bit behind the data byte. After this trigger condition is selected:
-- press **Byte Length** to set the length of the data and the range is from 1 to 5;
-- press **CurrentBit** to select the desired data bit and the range is from 0 to (Byte Length×8-1);
-- press **Data** to set the data pattern of the current data bit to X, H or L.
-- press **AllBits** to set the data pattern of all the data bits to the data pattern specified in **Data**.

A&D: trigger when the “Address” and “Data” conditions are met at the same time. After this trigger condition is selected:
-- press **AddrBits** to select “7 bit”, “8 bit” or “10 bit”;
-- press **Address** to set the address value according to the setting in **AddrBits** and the ranges are from 0 to 127, from 0 to 255 and from 0 to 1023 respectively;
-- press **Byte Length** to set the length of the data and the range is from 1 to 5;
-- press **CurrentBit** to select the desired data bit and the range is from 0 to (Byte Length×8-1);
-- press **Data** to set the data pattern of the current data bit to X, H or L.
-- press **AllBits** to set the data pattern of all the data bits to the data pattern specified in **Data**.
-- press **Direction** to select “Read”, “Write” or “R/W”. (Note that this setting is not available when **AddrBits** is set to “8 bit”)

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.
Trigger Setting:
Press Setting to set the trigger parameter (noise rejection) under this trigger type.

Trigger Level:
Press SCL and use TRIGGER LEVEL to modify the trigger level of SCL channel. Press SDA and use TRIGGER LEVEL to modify the trigger level of SDA channel. For details, please refer to the description of Trigger Level on page 5-9.
**SPI Trigger**

Trigger on the data pattern on the specified edge. When using SPI trigger, you need to specify the SCL and SDA data sources. Below is the sequence chart of SPI bus data transmission.

![Sequence Chart of SPI Bus Data Transmission](image)

**Figure 5-12 SPI Trigger**

**Trigger Type:**
Press **Type** to select “SPI”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

```
Type 0 0.00 V
```

**Source Selection:**
Press **SCL** and **SDA** to specify the data sources of SCL and SDA respectively. They can be set to CH1 or CH2 and the current trigger source is displayed at the upper right corner of the screen.

**Data Line Setting:**
Set the instrument to trigger when the specified bit and length of data is transmitted in the SDA.
5 To Trigger the Oscilloscope

- Press **Data Bits** to set the number of bits of the serial data character string. It can be set to any integer between 4 and 32.
- Press **CurrentBit** to set the number of the data bit and the range is from 0 to (value specified in **Data Bits** - 1).
- Press **Data** to set the value of the current bit to H, L or X.
- Press **AllBits** to set all the data bits to the value specified in **Data**.

**Trigger Condition:**
The default trigger condition of this oscilloscope is timeout and you cannot set it.

**TimeOut:**
Set the minimum time that the clock (SCL) signal must be idle before the oscilloscope starts to search for the data (SDA) on which to trigger. Press **TimeOut** to set the timeout value and the range is from 100 ns to 1 s.

**Clock Edge:**
Press **Clock Edge** to select the desired clock edge.
- ![Rising Edge](image)
  - sample the SDA data on the rising edge of the clock.
- ![Falling Edge](image)
  - sample the SDA data on the falling edge of the clock.

**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameter (noise rejection) under this trigger type.

**Trigger Level:**
Press **SCL** and use **TRIGGER LEVEL** to modify the trigger level of the SCL channel. Press **SDA** and use **TRIGGER LEVEL** to modify the trigger level of the SDA channel. For details, please refer to the description of **Trigger Level** on page 5-9.
USB Trigger (Option)

Trigger on the SOP, EOP, RC, Suspend and Exit Suspend of the data packet on the differential USB data cable (D+ and D-). This trigger supports USB Low Speed and Full Speed. The figure below shows the USB data transmission protocol.

![USB Trigger](image)

Figure 5-13 USB Trigger

**Trigger Type:**
Press **Type** to select “USB”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

**Source Selection:**
Press **D+** and **D-** to specify data sources for D+ and D- data cables respectively. They can be set to CH1 or CH2 and the current trigger sources are displayed at the upper right corner of the screen.

**Signal Speed:**
Press **Speed** to select “Low Speed” (1.5 Mb/s) or “Full Speed” (12 Mb/s).

**Trigger Condition:**
Press **When** to select the desired trigger condition.
- **SOP**: trigger at the sync bit at the start of the data packet (SOP).
- **EOP**: trigger at the end of the SEO portion of the EOP of the data packet.
- **RC**: trigger when SEO is greater than 10 ms.
- **Suspend**: trigger when the idle time of the bus is greater than 3 ms.
- **ExitSuspend**: trigger when the bus exits from idle state for more than 10 ms.
**Trigger Mode:**
Press **Sweep** to select the **Trigger Mode** (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

**Trigger Setting:**
Press **Setting** to set the trigger parameter (noise rejection) under this trigger type.

**Trigger Level:**
Press **D+** and use **TRIGGER LEVEL** to modify the trigger level of the D+ channel. Press **D-** and use **TRIGGER LEVEL** to modify the trigger level of the D- channel. For details, please refer to the description of **Trigger Level** on page 5-9.
CAN Trigger (Option)

Trigger on the start frame, end frame, specified frame type or error frame of the CAN signal. When using CAN trigger, you need to specify the signal source, signal rate and trigger signal type of the CAN signal. The figure below shows the standard and expanded formats of CAN bus data frame.

![Standard Format](image)

![Extended Format](image)

Figure 5-14 Standard and Expanded Formats of CAN Bus Data Frame

**Trigger Type:**
Press **Type** to select “CAN”. At this point, the trigger setting information as shown in the figure below is displayed at the upper right corner of the screen.

![Trigger 1 62.5mV](image)

**Source Selection:**
Press **Source** to select CH1 or CH2 as the **Trigger Source**. The current trigger source is displayed at the upper right corner of the screen.
Signal Type:
Press **Signal Type** to select the desired signal type.
- **Rx:** receiving signal on the CAN signal line.
- **Tx:** transmission signal on the CAN signal line.
- **CAN_H:** actual CAN_H bus signal.
- **CAN_L:** actual CAN_L bus signal.
- **Differential:** CAN differential bus signal connected to the analog channel via the differential probe.

Trigger Condition:
Press **When** to select the desired trigger condition.
- **SOF:** trigger on the start frame of the data frame.
- **EOF:** trigger on the end frame of the data frame.
- **Frame Type:** after this type is selected, press **Frame Type** to select to trigger on the “Data”, “Remote”, “Error” or “OverLoad” frame. Set the following parameters when “Data” or “Remote” is selected.
  - **Data** trigger:
    --press **ID Setup** and select “Specific ID” or “Random ID”. When “Specific ID” is selected, press **ID Format** to select “Standard” or “Expand”; press **ID Data** and use or the navigation knob to input the desired value. The range is from 0 to 2047 (standard ID format) or 0 to 536870911 (expanded ID format).
    --press **Byte Length** and use to input the desired value. The range is from 1 to 8.
    --press **CurrentBit** to select the desired data bit and the range is from 0 to “(Byte Length”×8-1).
    --press **Data** to set the data pattern of the current bit to X, H or L.
    --press **AllBits** to set the data pattern of all the data bits to the data pattern specified in **Data**.
  - **Remote** trigger:
    --press **ID Setup** and select “Specific ID” or “Random ID”. When “Specific ID” is selected, press **ID Format** and select “Standard” or “Expand”. Press **ID Data** and use or the navigation knob to input the desired value. The range is from 0 to 2047 (standard ID format) or 0 to 536870911 (expanded ID format).
- **Frame Error:** after selecting this type, press **Error Type** to select to trigger on the “Bit Fill”, “Answer Error”, “Check Error”, “Format Error” or “Random Error”.

Baud:
Press Baud to set the CAN baud to match the CAN bus signal and the values available are 10 kb/s (default), 20 kb/s, 33.3 kb/s, 50 kb/s, 62.5 kb/s, 83.3 kb/s, 100 kb/s, 125 kb/s, 250 kb/s, 500 kb/s, 800 kb/s, 1 Mb/s or user. After “User” is selected, press User and use or the navigation knob to input the desired rate within 1 kb/s and 10.0 Mb/s.

Sample Point:
Sample point is a point within a bit’s time. The oscilloscope samples the bit level at this point. “Sample point” is represented by the percentage of “the time from the start of the bit’s time to the sample point time” in the “bit’s time”. Press SamplePoint and use to modify the parameter with a step of 1% and the range is from 5% to 95%.

![Figure 5-15 Sample Point Position](image)

Trigger Mode:
Press Sweep to select the Trigger Mode (page 5-3) under this trigger type as auto, normal or single. The corresponding status light of the current trigger mode turns on.

Trigger Setting:
Press Setting to set the trigger parameters (noise rejection) under this trigger type.

Trigger Level:
Use TRIGGER LEVEL to modify the level. For details, please refer to the description of Trigger Level on page 5-9.
Trigger Output Connector

The trigger output connector at the rear panel can output trigger signals determined by the current setting.

Press [Utility] → [AuxOutput] to select “TrigOut”. When the oscilloscope is triggered, it will output a trigger signal determined by the current trigger setting through the [Trigger Out] connector.
6 To Make Measurements

DS2000A can make math operation, cursor measurement and auto measurement on sampled and displayed data.

The contents of this chapter:

- Math Operation
- Auto Measurement
- Cursor Measurement
Math Operation

DS2000A can realize various math operations (including: addition (A+B), subtraction (A-B), multiplication (AxB), division (A÷B), FFT, logic operation and advanced operation) of waveforms between channels. The results of math operation also allows further measurement (for details, please refer to Cursor Measurement).

Press MATH → Operate in the vertical control area (VERTICAL) at the front panel to select the desired operation function. The result of math operation is displayed on the waveform marked with “M” on the screen.

Addition

Add the waveform voltage values of signal source A and B point by point and display the results.

Press MATH → Operate to select “A+B”:
- Press Source A and Source B to select the desired channels (CH1 or CH2).
- Press and use to adjust the vertical position of the operation results.
- Press and use to adjust the vertical scale of the operation results.
- Press Invert to turn the inverted display of the operation results on or off.
- HORIZONTAL POSITION and HORIZONTAL SCALE can also be used to adjust the horizontal position and scale of the operation results.

Substraction

Subtract the waveform voltage values of signal source B from that of source A point by point and display the results.

Press MATH → Operate to select “A-B”:
- Press Source A and Source B to select the desired channels (CH1 or CH2).
- Press and use to adjust the vertical position of the operation results.
- Press and use to adjust the vertical scale of the operation results.
• Press **Invert** to turn the inverted display of the operation results on or off.
• **HORIZONTAL POSITION** and **HORIZONTAL SCALE** can also be used to adjust the horizontal position and scale of the operation results.

## Multiplication

Multiply the waveform voltage values of signal source A and B point by point and display the results.

Press **MATH → Operate** to select “A x B”:

• Press **Source A** and **Source B** to select the desired channels (CH1 or CH2).

• Press **** and use **** to adjust the vertical position of the operation results.

• Press **** and use **** to adjust the vertical scale of the operation results.

• Press **Invert** to turn the inverted display of the operation results on or off.

• **HORIZONTAL POSITION** and **HORIZONTAL SCALE** can also be used to adjust the horizontal position and scale of the operation results.

## Division

Divide the waveform voltage values of signal source A by that of source B point by point and display the results. It can be used to analyze the multiple relationships of waveforms in the two channels. Note that when the voltage value of channel B is 0, the result of the division is treated as 0.

Press **MATH → Operate** to select “A ÷ B”:

• Press **Source A** and **Source B** to select the desired channels (CH1 or CH2).

• Press **** and use **** to adjust the vertical position of the operation results.

• Press **** and use **** to adjust the vertical scale of the operation results.

• Press **Invert** to turn the inverted display of the operation results on or off.

• **HORIZONTAL POSITION** and **HORIZONTAL SCALE** can also be used to adjust the horizontal position and scale of the operation results.
FFT

FFT is used to quickly perform Fourier transform on specified signals and transform time domain signals to frequency domain signals. FFT operation can facilitate the following works:

- Measure harmonic components and distortion in the system
- Measure the characteristics of the noise in DC power
- Analyze vibration

Press MATH \(\rightarrow\) Operate to select “FFT” and set the parameters of FFT operation.

1. **Select Source**
   Press **Source** to select the desired channel (CH1 or CH2).

2. **Select Window Function**
   Spectral leakage can be considerably decreased when a window function is used. DS2000A provides four kinds of FFT window functions which have different characteristics and are applicable to measure different waveforms. You need to select the window function according to the waveform to be measured and its characteristics. Press **Window** to select the desired window function and the default is “Rectangle”.

Figure 6-1 FFT
Table 6-1 Window Functions

<table>
<thead>
<tr>
<th>Window</th>
<th>Characteristics</th>
<th>Waveforms Suitable for Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangle</td>
<td>The best frequency resolution; the poorest amplitude resolution; similar to the situation when no window is multiplied.</td>
<td>Transient or short pulse, the signal levels before and after the multiplication are basically the same; Sine waveforms with the same amplitude and rather similar frequencies; Wide band random noise with relatively slowly changing waveform spectrum.</td>
</tr>
<tr>
<td>Hanning</td>
<td>Better frequency resolution; poorer amplitude resolution.</td>
<td>Sine, periodic and narrow band random noise.</td>
</tr>
<tr>
<td>Hamming</td>
<td>A little bit better frequency resolution than Hanning</td>
<td>Transient or short pulse, the signal levels before and after the multiplication are rather different.</td>
</tr>
<tr>
<td>Blackman</td>
<td>The best amplitude resolution; the poorest frequency resolution</td>
<td>Single frequency signal, search for higher order harmonics.</td>
</tr>
</tbody>
</table>

3. **Set the Display Mode**
   Press **Display** to select “Split” (default) or “Full Screen” display mode.
   Split: the source channel and the FFT operation results are displayed separately. The time domain and frequency domain signals are displayed clearly.
   Full Screen: the source channel and the FFT operation results are displayed in the same window to view the frequency spectrum more clearly and to perform more precise measurement.
   Note: In FFT mode and when MATH is the active channel, you can also press **HORIZONTAL SCALE** to switch between “Split” and “Full Screen”.

4. **Set the Vertical Scale**
   In FFT measurement, the unit of the horizontal axis changes from time to frequency. Use **HORIZONTAL SCALE** and **HORIZONTAL POSITION**
to set the scale and position of the horizontal axis respectively.
The unit of the vertical axis can be dB or Vrms which use logarithmic mode and linear mode to display vertical amplitude respectively. If you need to display the FFT frequency spectrum in a relatively larger dynamic range, dB is recommended. Press **Scale** to select the desired unit and the default is dB.

Press ▼ and ▲ and use 
 to set the vertical position and amplitude of the FFT frequency spectrum respectively.

<table>
<thead>
<tr>
<th>Tips</th>
</tr>
</thead>
</table>
| Signals with DC components or deviation would cause error or deviation of the FFT waveform components. To reduce the DC components, set the **Channel Coupling** to “AC”.
To reduce the random noise and aliasing frequency components of repetitive or single pulse, set the **Acquisition Mode** of the oscilloscope to “Average”. |
Logic Operation

Perform logic operation on the waveform voltage values of the specified sources point by point and display the results. In operation, when the voltage value of the source channel is greater than the threshold of the corresponding channel, it is regarded as logic “1”; otherwise logic “0”. The following common logic operation expressions are provided.

Table 6-2 Logic Operation

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| AND       | The results of logic **AND** operation of two binary bits are as follows:  
|           | A    B    A AND B  
|           | 0    0    0      
|           | 0    1    0      
|           | 1    0    0      
|           | 1    1    1      |
| OR        | The results of logic **OR** operation of two binary bits are as follows:  
|           | A    B    A OR B  
|           | 0    0    0      
|           | 0    1    1      
|           | 1    0    1      
|           | 1    1    1      |
| NOT       | The results of logic **NOT** operation of a binary bit are as follows:  
|           | A    NOT A  
|           | 0    1      
|           | 1    0      |
| XOR       | The results of logic **XOR** operation of two binary bits are as follows:  
|           | A    B    A XOR B  
|           | 0    0    0      
|           | 0    1    1      
|           | 1    0    1      
|           | 1    1    0      |

Press **MATH** \(\rightarrow\) **Operate** to select “Logic”:

- Press **Log.Formula** to select the desired logic formula and the default is “AND”.
- Press **Source A** and **Source B** to select the desired channels (CH1 or CH2).
• Press \( \text{[V Position]} \) and use \( \text{[V Scroll]} \) to adjust the vertical position of the operation results.

• Press \( \text{[V Scale]} \) and use \( \text{[V Scroll]} \) to adjust the vertical scale of the operation results.

• Press \( \text{Invert} \) to turn the inverted display of the operation results on or off.

• Press \( \text{Threshold A} \) and use \( \text{[V Scroll]} \) to set the threshold of source A in logic operation.

• Press \( \text{Threshold B} \) and use \( \text{[V Scroll]} \) to set the threshold of source B in logic operation.

• \( \text{HORIZONTAL [Position]} \) and \( \text{HORIZONTAL [Scale]} \) can also be used to adjust the horizontal position and scale of the operation results.
Advanced Operation

DS2000A provides advanced operation function that allows users to define operation functions. Press \[ \text{MATH} \rightarrow \text{Operate} \rightarrow \text{“Advanced”} \rightarrow \text{Expression} \rightarrow \text{“ON”} \] and the editing window as shown in the figure below is displayed.

![Advanced Operation Editing Window](image)

Turn \( \Rightarrow \) to select any item in “Channel”, “Function”, “Variable”, “Operator” and “Figure” (if they are currently available for selection), then press down the knob and the item selected will be displayed in the entry box on the right of the “Expression”.

During the expression editing, you can press \[ \text{Delete} \] to delete the character currently at the left of the cursor and press \[ \text{Clear} \] to delete all the characters in the entry box at any time.

After finishing the expression editing, press \[ \text{Apply} \] and the oscilloscope will operate according to the expression you set and display the result. Note that after \[ \text{Apply} \] is pressed, the Expression menu will be automatically set to “OFF” but the preset expression will still be displayed at the bottom of the screen for your reference. You can also press \[ \text{Invert} \] to turn the inverted display of the operation results on or off.

The following are descriptions of the contents in the editing window.

1. **Expression**
   Here, it refers to the formulas formed by channel, function, variable, operator and figure. The length of the expression is limited to 64 bytes.
2. **Channel**
   You can select any channel (CH1 or CH2).

3. **Function**
   Please refer to the following table to get the functions of each function. Note that the left brackets “(” here are only used to facilitate your entry and they are not a part of the function names.

   **Table 6-3 Functions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intg(</td>
<td>Calculate the integral of the selected source. You can use integral to measure the area under a waveform or the pulse energy.</td>
</tr>
<tr>
<td>Diff(</td>
<td>Calculate the discrete time differentiate of the selected source. You can use differentiate to measure the instantaneous slope of a waveform.</td>
</tr>
<tr>
<td>Log(</td>
<td>Calculate the natural logarithm of the selected source (use constant $e$ (approximately 2.718282) as the base).</td>
</tr>
<tr>
<td>Exp(</td>
<td>Calculate the exponent of the selected source. For example, $\text{Exp}(A)$ means calculate the $A$th power of $e$.</td>
</tr>
<tr>
<td>Sqrt(</td>
<td>Calculate the square root of the selected source.</td>
</tr>
<tr>
<td>Sine(</td>
<td>Calculate the sine value of the selected source.</td>
</tr>
<tr>
<td>Cosine(</td>
<td>Calculate the cosine value of the selected source.</td>
</tr>
<tr>
<td>Tangent(</td>
<td>Calculate the tangent value of the selected source.</td>
</tr>
</tbody>
</table>

4. **Variable**
   Users can set the desired values of Variable1 and Variable2. Press **Variable** to turn on the variable setting menu.

   - **Variable**: press this softkey to select the variable to be set as “Variable1” and “Variable2”.
   - **Step**: press this softkey to set the step used when using the knob to modify the “Mantissa”. The steps available are $\times 1$, $\times 0.1$, $\times 0.01$, $\times 0.001$ and $\times 0.0001$.
   - **Mantissa**: press this softkey to set the number of significant digits of the variable. After setting the “Step” and pressing this softkey, turn the knob to modify this parameter. The range available is from -9.9999 to 9.9999.
   - **Exponent**: press this softkey to set the numeric values of the exponents with 10 as the bottom number in the variables. The range is from -9 to 9.
For example, Variable1 is set to $6.1074 \times 10^8$ via the following settings.
Variable: Variable1
Mantissa: 6.1074
Exponent: 8

5. **Operator**

Please refer to the following table to get the functions of each operator.

Table 6-4 Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Arithmetic operators: add, subtract, multiply and divide</td>
</tr>
<tr>
<td>-</td>
<td></td>
</tr>
<tr>
<td>*</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
<tr>
<td>()</td>
<td>Parentheses: used to increase the priority of the operation enclosed in the parentheses</td>
</tr>
<tr>
<td>&lt;</td>
<td>Relationship operators: lower than, greater than, lower than or equal to, greater than or equal to, equal to, not equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;=</td>
<td></td>
</tr>
<tr>
<td>&gt;=</td>
<td></td>
</tr>
<tr>
<td>==</td>
<td></td>
</tr>
<tr>
<td>!=</td>
<td></td>
</tr>
<tr>
<td>!(</td>
<td>Logic operator: NOT, OR, AND</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td></td>
</tr>
</tbody>
</table>

Note: In division operation, when the divisor is 0, the result of the division is treated as 0.

6. **Figure**

Select from figure 0 to 9, decimal point and character E. Wherein, character E represents the nth power of 10. For example, 1.5E3 means $1.5 \times 10^3$. 
Auto Measurement

DS2000A provides auto measurements of 24 waveform parameters and the statistics and analysis of the measurement results. What’s more, you can also use the frequency counter to realize more precise frequency measurement.

Quick Measurement after AUTO

When the oscilloscope is correctly connected and has detected input signal, press AUTO to enable waveform auto setting function and open the following function menu:

**Single-period**: measure the “Period” and “Frequency” of the current signal within a single period and display the measurement results at the bottom of the screen.

**Multi-period**: measure the “Period” and “Frequency” of the current signal within multiple periods and display the measurement results at the bottom of the screen.

**Rise Time**: measure the “Rise Time” of the current signal and display the measurement result at the bottom of the screen.

**Fall Time**: measure the “Fall Time” of the current signal and display the measurement result at the bottom of the screen.

Note: The AUTO function requires that the frequency of the signal under test should be no lower than 25 Hz. If the parameter exceeds these limits, “Can’t detect any signal!” would be displayed after pressing this key and the quick parameter measurement menu might not be displayed.
One-key Measurement of 24 Parameters

Press [MENU] at the left of the screen to turn on the measurement menu of the 24 parameters and then press the corresponding menu softkey to quickly realize “One-key” measurement. The measurement result will be displayed at the bottom of the screen.

The icons of time and voltage parameters in the measurement items and the measurement results on the screen are always marked in the same color with the channel ([Measure] → [Source]) currently used. But the delay and phase measurement items are always marked in green. For example,

Parameter Icons:

- **Freq**
- **Vmax**
- **Delay1→2f**
- **Phase1→2f**

Measurement Results:

- **Freq**: 1.024kHz
- **Max**: 3.12 V
- **Delay1→2f**: -24.00μs
- **Phase1→2f**: -73.73°

Note: If the measurement result is displayed as “*****”, it means that there is no signal input in the current source or the measurement result is not within the valid range (too large or too small).
Time Parameters

1. **Period**: defined as the time between the middle threshold points of two consecutive, like-polarity edges.
2. **Frequency**: defined as the reciprocal of period.
3. **Rise Time**: the time for the signal amplitude to rise from 10% to 90%.
4. **Fall Time**: the time for the signal amplitude to fall from 90% to 10%.
5. **+ Width**: the time difference between the 50% threshold of a rising edge to the 50% threshold of the next falling edge of the pulse.
6. **- Width**: the time difference between the 50% threshold of a falling edge to the 50% threshold of the next rising edge of the pulse.
7. **+ Duty**: the ratio of the positive pulse width to the period.
8. **- Duty**: the ratio of the negative pulse width to the period.
Delay and Phase

Source 1 and source 2, the same as source A and source B in the measurement setting menu can be CH1 or CH2.

1. **Delay 1→2**: the time difference between the rising edges of source 1 and source 2. Negative delay indicates that the selected rising edge of source 1 occurred after the selected edge of source 2.

2. **Delay 1→2**: the time difference between the falling edges of source 1 and source 2. Negative delay indicates that the selected edge of source 1 occurred after the selected edge of source 2.

3. **Phase 1→2**: phase difference calculated according to “Delay 1→2” and the period of source 1, expressed in degree. The calculation formula is as shown below.

4. **Phase 1→2**: phase difference calculated according to “Delay 1→2” and the period of source 1, expressed in degree. The calculation formula is as shown below.

The phase calculation formula:

\[
Phase = \frac{Delay}{Period1} \times 360°
\]

Wherein,
- **Phase** represents “Phase 1→2” or “Phase 1→2”
- **Delay** represents “Delay 1→2” or “Delay 1→2”
- **Period1** represents the period of source 1
Voltage Parameters

![Diagram of Voltage Parameters]

Figure 6-5 Voltage Parameters

1. **Vmax**: the voltage value from the highest point of the waveform to the GND.
2. **Vmin**: the voltage value from the lowest point of the waveform to the GND.
3. **Vpp**: the voltage value from the highest point to the lowest point of the waveform.
4. **Vtop**: the voltage value from the flat top of the waveform to the GND.
5. **Vbase**: the voltage value from the flat base of the waveform to the GND.
6. **Vamp**: the voltage value from the top of the waveform to the base of the waveform.
7. **Vavg**: the arithmetic average value on the whole waveform or on the gating area.
   \[ \text{Average} = \frac{\sum x_i}{n}, \text{ wherein, } x_i \text{ is the } ith \text{ point being measured, } n \text{ is the number of points being measured.} \]
8. **Vrms**: the root mean square value on the whole waveform or the gating area.
   \[ \text{RMS} = \sqrt{\frac{\sum_{i=1}^{n} x_i^2}{n}}, \text{ where, } x_i \text{ is the } ith \text{ point being measured, } n \text{ is the number of points being measured.} \]
9. **Overshoot**: the ratio of the difference of the maximum value and top value of the waveform to the amplitude value.
10. **Preshoot**: the ratio of the difference of the minimum value and base value of the waveform to the amplitude value.

**Other Parameters**

1. ![Waveform](image)
   Area: the area of the whole waveform within the screen and the unit is voltage-second. The area measured above the zero reference (namely the vertical offset) is positive and the area measured below the zero reference is negative. The area measured is the algebraic sum of the area of the whole waveform within the screen.

2. ![Waveform](image)
   Period Area: the area of the first period of waveform on the screen and the unit is voltage-second. The area above the zero reference (namely the vertical offset) is positive and the area below the zero reference is negative. The area measured is the algebraic sum of the area of the whole period waveform. Note that when the waveform on the screen is less than a period, the period area measured is 0.
Frequency Counter Measurement

The hardware frequency counter supplied with this oscilloscope can make more precise measurement of the input signal frequency.

Press \textit{Measure} \xrightarrow{\textit{Counter}} to select CH1 or CH2 as the measurement source. The measurement result is displayed at the upper right corner of the screen and you can identify the current measurement source according to the color of the icon. The following figure is the result of frequency measurement of the input signal of CH1.

![1.00000kHz]

Select “OFF” to disable the frequency counter measurement function.
Measurement Setting

1. **Source Selection**
   Press **Measure → Source** to select the desired channel for measurement (CH1, CH2 or MATH). The color of the parameter icons under **MENU** at the left of the screen will change with the source selected.

2. **Measurement Range**
   Press **Measure → Meas.Range → Meas.Range** to select “Screen Region” or “Cursor Region” for measurement. When “Cursor Region” is selected, two cursor lines appear on the screen. At this point, press **CursorA** and **CursorB** and use **↑** to adjust the position of the two cursor lines respectively so as to determine the measurement range. Or, press **CursorAB** and use **↑** to adjust the positions of cursor A and cursor B at the same time. Note that you can press **↑** continuously to switch between the cursors.

3. **Delayed Measurement Setting**
   Specify the sourceA and sourceB in the measurement items “Delay 1→2” and “Delay 1→2†”.
   Press **Measure → Meas.Setting → Type → “Delay”** and then press **SourceA** and **SourceB** to set the two channel sources (CH1 or CH2) of delayed measurement respectively.

![Figure 6-6 “Cursor Region” Selected for Measurement Range](image-url)
4. **Phase Measurement Setting**

Specify the source A and source B in the measurement items “Phase 1→2f” and “Phase 1→2t”.

Press **Measure → Meas.Setting → Type → “Phase”** and then press **SourceA** and **SourceB** to set the two channel sources (CH1 or CH2) of phase measurement respectively.

5. **Threshold Measurement Setting**

Specify the vertical level (in percentage) being measured in the analog channel. Measurements of all the time, delay and phase parameters will be influenced by this setting.

Press **Measure → Meas.Setting → Type → “Threshold”** and then:

- Press **Max** and use \( \downarrow \) to set the maximum value of the measurement. Reducing the maximum value to the current “Mid” will automatically reduce the “Mid” to keep it lower than the maximum value. The default is 90% and the range available is from 7% to 95%.

- Press **Mid** and use \( \uparrow \) to set the middle value of measurement. The middle value is limited by the settings of “Max” and “Min”. The default is 50% and the range available is from 6% to 94%.

- Press **Min** and use \( \downarrow \) to set the minimum value of the measurement. Increasing the minimum value to the current “Mid” will automatically increase the “Mid” to keep it higher than the minimum value. The default is 10% and the range available is from 5% to 93%.
To Clear the Measurement

If you have currently enabled one or more items in the 24 measurement parameters, you can “Delete” or “Recover” the first five parameters or “Delete” or “Recover” all the measurement items enabled. Note that the first five parameters are determined according to the order in which you turned them on and they will not change as you delete one or more measurement items.

Press [Measure] → [Clear] → [Item n] to “Delete” or “Recover” the specified measurement item. When one measurement item is deleted or recovered, the measurement result at the bottom of the screen will move one-item left or right.

Press [Measure] → [Clear] → [All Items] to “Delete” or “Recover” all the measurement items enabled.

Note: Press and hold [Measure] to quickly clear or restore all the measurement items enabled.
All Measurement

All measurement could measure all the time and voltage parameters (each measurement source has 20 items, measurements can be performed on CH1, CH2 and MATH at the same time) of the current measurement source and display the results on the screen. Press **Measure** → **Display All** to enable or disable the all measurement function. Press **All Measure Source** and use ⬇️ to select the channel(s) to be measured (CH1, CH2 and MATH).

- When all measurement is enabled, “One-key” measurement is also valid.
- **To Clear the Measurement** will not clear the results of all measurement.

![Figure 6-7 All Measurement](image-url)
Statistic Function

Make statistic and display the current, average, minimum (or standard deviation) and maximum (or count) values of at most 5 measurement items that are turned on last.

Press **Measure** → **Statistic** to turn the statistic function on or off. When the statistic function is enabled, press **StatSel** to select “Extremum” or “Difference” measurement. When “Extremum” is selected, minimum and maximum values are displayed. When “Difference” is selected, standard deviation and count values are displayed.

Press **Measure** → **Reset Statistic** to clear the history data and make statistic again.
Measurement History

To view the history measurement data, press **Measure** → **MeasHistory** → **MeasHistory** → “ON”. The history data can be displayed in two modes:

- **Graph**: display the measurement results of at most 5 measurement items that are turned on last in graph mode. The measurement points are connected using linear interpolation.
- **Table**: display the results of the last 10 measurements of at most 5 measurement items that are turned on last in table mode.

Cursor Measurement

Cursors are the horizontal and vertical marks that can be used to measure the X axis values (usually Time) and Y axis values (usually Voltage) on a selected waveform. Please connect the signal to the oscilloscope and obtain stable display before using cursor measurement. All the **Auto Measurement** parameters can be measured through cursor measurement.

Press **Cursor** → **Mode** at the front panel and use ↕ to select the desired cursor mode (the default is “OFF”) and then press down the knob. The modes available are “Manual”, “Track” and “Auto”.

Manual Mode

In this mode, a pair of cursors will appear. You can adjust the cursors manually to measure the X (or Y), X increment (or Y increment) between cursors and the reciprocal of X increment on the waveform of the selected source (CH1, CH2 or MATH).

Press **Cursor** → **Mode** → “Manual” to turn the manual cursor function on. When the display mode is X-Y, the measurement results will be displayed at the upper left corner of the screen in the following mode.
To Make Measurements

- **A->X**: the X value at cursor A. X value takes the trigger position as reference.
- **B->X**: the X value at cursor B. X value takes the trigger position as reference.
- **A->Y**: the Y value at cursor A. Y value takes the channel GND as reference.
- **B->Y**: the Y value at cursor B. Y value takes the channel GND as reference.
- **ΔX**: the horizontal difference between cursor A and B.
- **1/ΔX**: the reciprocal of the horizontal difference between cursor A and B.
- **ΔY**: the vertical difference between cursor A and B.

If needed, please refer to the following steps to modify the parameters of manual cursor measurement.

1. **Select Display Mode**
   Press **Display Mode** to select “X”, “Y” or “X-Y”. The X cursors are a pair of vertical solid/dotted lines and are usually used to measure time parameters. The Y cursors are a pair of horizontal solid/dotted lines and are usually used to measure voltage parameters. The X-Y cursors are a pair of vertical solid/dotted lines and a pair of horizontal solid/dotted lines and are usually used to measure time and voltage parameters at the same time.

2. **Select Measurement Source**
   Press **Source** to select the waveform of the analog channels (CH1 or CH2) or math operation results (MATH) for measurement. If “None” is selected, no cursor will be displayed.

3. **Select Screen Region**
   - When Zoom is enabled (pressing the **HORIZONTAL SCALE** can enables Zoom), the screen is divided into two regions, Main and Zoom. When “Main” is selected, the cursors are displayed in the main region and measure the signal displayed in the main region. The measurement results are displayed in the zoom region. When “Zoom” is selected, the cursors are
displayed in the zoom region and measure the signal displayed in the zoom region. The measurement results are displayed in the main region.

- When Zoom is disabled, “Main” is automatically selected in **Screen Region** and can not be modified.

### 4. Select X (Y) Axis Unit

When the display mode is “X” or “X-Y”, press **Time Unit** to select “s”, “Hz”, “°” or “%”.

- **s**: when this unit is selected, in the measurement results, A->X, B->X and \(\Delta X\) are in “s” and \(1/\Delta X\) is in “Hz”.
- **Hz**: when this unit is selected, in the measurement results, A->X, B->X and \(\Delta X\) are in “Hz” and \(1/\Delta X\) is in “s”.
- **°**: when this unit is selected, in the measurement results, A->X, B->X and \(\Delta X\) are in “°”. At this point, A->X, B->X and \(\Delta X\) will change to “0°”, “360°” and “360°” respectively when you press **SetCursor**, no matter where cursor A and B are currently located. At the same time, two cursor lines (unmovable) appear on the screen as the reference positions.
- **%**: when this unit is selected, in the measurement results, A->X, B->X and \(\Delta X\) are in “%”. At this point, A->X, B->X and \(\Delta X\) will change to “0%”, “100%” and “100%” respectively when you press **SetCursor**, no matter where cursor A and B are currently located. At the same time, two cursor lines (unmovable) appear on the screen as the reference positions.

When the display mode is “Y” or “X-Y”, press **Vertical Unit** to select “Source Unit” or “%”.

- **Source Unit**: when this unit is selected, in the measurement results, the units of A->Y, B->Y and \(\Delta Y\) will be automatically set to the unit of the current source.
- **%**: when this unit is selected, in the measurement results, A->Y, B->Y and \(\Delta Y\) are in “%”. At this point, A->Y, B->Y and \(\Delta Y\) will change to “0%”, “100%” and “100%” respectively when you press **SetCursor**, no matter where cursor A and B are currently located. At the same time, two cursor lines (unmovable) appear on the screen as the reference positions.

### 5. Adjust the Cursor Position

- Adjust the horizontal positions of the cursors:
  - When the display mode is “X” or “X-Y” (press **SelectCursor** to select “X”)

---

6-26 User's Guide for DS2000A
mode, press **CursorA** and **CursorB** and use ▼ to adjust the horizontal positions of cursor A and cursor B respectively. Press **CursorAB** and use ▼ to adjust the horizontal positions of cursor A and B at the same time. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.

- **Adjust the vertical positions of the cursors:**
  When the display mode is “Y” or “X-Y” (press **SelectCursor** to select “Y”) mode, press **CursorA** and **CursorB** and use ▼ to adjust the vertical positions of cursor A and cursor B respectively. Press **CursorAB** and use ▼ to adjust the vertical positions of cursor A and B at the same time. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.

### 6. Measurement Example

Use manual cursor measurement to measure the period (\( \Delta X \)) and frequency (\( 1/\Delta X \)) of a sine waveform and the result is equal to the result from auto measurement.

![Figure 6-8 Manual Cursor Measurement Example](image)

**Figure 6-8 Manual Cursor Measurement Example**
Track Mode

In this mode, one or two pairs of cursors will appear. You can adjust the two pairs of cursors (cursor A and cursor B) to measure the X and Y values on two different sources respectively. The points being measured on cursor A and B are marked by an orange rectangle and rhombus respectively. When the cursors are moved horizontally, the marks will position on the waveform automatically. When the waveform is expanded or compressed horizontally, the marks will track the points being marked at the last adjustment of the cursors.

Press \textbf{Cursor} \rightarrow \textbf{Mode} \rightarrow "Track" to turn on the cursor track function and the measurement results will be displayed at the upper left corner of the screen in the following mode.

- \(A \rightarrow X\): the X value at cursor A. The X value takes the trigger position as reference and “s” or “Hz” (when measuring FFT waveform) as its unit.
- \(A \rightarrow Y\): the Y value at cursor A. The Y value takes the channel GND as reference and use the same unit as the current source.
- \(B \rightarrow X\): the X value at cursor B. The X value takes the trigger position as reference and “s” or “Hz” (when measuring FFT waveform) as its unit.
- \(B \rightarrow Y\): the Y value at cursor B. The Y value takes the channel GND as reference and use the same unit as the current source.
- \(\Delta X\): the horizontal difference between cursor A and B.
- \(1/\Delta X\): the reciprocal of the horizontal difference between cursor A and B.
- \(\Delta Y\): the vertical difference between cursor A and B.

If needed, please refer to the following steps to modify manual cursor track measurement parameters.
1. **Select Measurement Source**
   Press **Cursor A** to select the waveform of analog channels (CH1 or CH2) or math operation results (MATH) as the measurement source of cursor A (only channels enabled are available). You can also select “None”, namely do not use cursor A.

   Press **Cursor B** to select the waveform of analog channels (CH1 or CH2) or math operation results (MATH) as the measurement source of cursor B (only channels enabled are available). You can also select “None”, namely do not use cursor B.

2. **Adjust Cursor Position** *(note that under the same menu page, you can also press 🔄 continuously to switch the current cursor)*
   - Adjust cursor A: press **CursorA** and use 🔄 to adjust the position of cursor A. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.
   - Adjust cursor B: press **CursorB** and use 🔄 to adjust the position of cursor B. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.
   - Adjust cursor A and B at the same time: press **CursorAB** and use 🔄 to adjust the position of cursor A and B at the same time. During the adjustment, the measurement results will change accordingly. The adjustable range is limited within the screen.

   Note: The vertical cursor will track the marked point (namely jumps up and down with the transient change of the waveform). Thus, the Y value might change even though you do not adjust the cursor.

3. **Measurement Example**
   Use cursor A and B to measure the waveforms of CH1 and CH2 respectively. You would discover that the cursors would track the marked points when the waveforms are expanded or compressed horizontally, as shown in Figure 6-9 and Figure 6-10.
Figure 6-9 Cursor Track (Before Horizontal Expansion)

Figure 6-10 Cursor Track (After Horizontal Expansion)
## Auto Mode

In this mode, one or more cursors will appear. You can use auto cursor measurement to measure any of the 24 waveform parameters. Before using this mode, you need to at least enable one auto measurement parameter and the number of cursors will change with the measurement parameter enabled.

Press **Cursor** → **Mode** → “Auto” and the number of cursors displayed on the screen is determined by the measurement parameter enabled (different measurement parameter needs different number of cursors). Note that no cursor will be displayed if no auto cursor measurement parameter is enabled or the measurement source has no input. When the waveform is expanded or compressed horizontally, the cursor will move accordingly.

If multiple measurement parameters are turned on later, you can use **Meas.Para.** to switch among at most five measurement parameters that are turned on last and the measurement parameter currently selected is high-lighted at the bottom of the screen.

The following figure shows the auto measurement of the delay between two channels.

![Figure 6-11 Auto Measurement of The Delay Between Two Channels](image)
X-Y Mode

X-Y mode is only available when the main timebase is “X-Y” mode. In this mode, two pairs of cursors will appear. You can adjust the cursor to measure the crosspoints of the two pairs of cursors.

Press **MENU** → **Time Base**, and select “X-Y”. Then, press **Cursor** → **Mode** → “X-Y” to enable the X-Y mode cursor measurement function. The measurement results are displayed at the upper left corner of the screen in the following mode.

- CurAX: the X value at cursor A.
- CurBX: the X value at cursor B.
- CurAY: the Y value at cursor A.
- CurBY: the Y value at cursor B.

You can adjust the positions of the cursors by the following instructions.

Press **Type** to select “X”. Then, press **CursorA** and **CursorB** and use **△** to adjust the horizontal positions of cursor A and cursor B respectively. Press **CursorAB** and use **△** to adjust the horizontal position of cursor A and B at the same time. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.

Press **Type** to select “Y”. Then, press **CursorA** and **CursorB** and use **△** to adjust the vertical positions of cursor A and cursor B respectively. Press **CursorAB** and use **△** to adjust the vertical positions of cursor A and cursor B at the same time. During the adjustment, the measurement result will change accordingly. The adjustable range is limited within the screen.
7 Protocol Decoding

Protocol analysis can be used by users to discover errors, debug hardware and accelerate development easily, so as to guarantee quick and high-quality accomplishment of projects. Protocol decoding is the basis of protocol analysis. Only protocol analyses with correct protocol decoding are acceptable and only correct protocol decoding can provide more error information. DS2000A provides two buses to make common protocol decoding (including Parallel (standard), RS232 (option), I2C (option), SPI (option) and CAN (option)) of the analog channels (CH1 or CH2). As the decoding functions and setting methods of the two buses are the same, this chapter only takes Decode1 for illustration.

To get the decoding option information, please refer to Appendix A: Accessories and Options on page 18-1. When you have ordered the decoding option, please refer to Option Management on page 14-12 to activate corresponding option.

The contents of this chapter:

- Parallel Decoding
- RS232 Decoding (Option)
- I2C Decoding (Option)
- SPI Decoding (Option)
- CAN Decoding (Option)
Parallel Decoding

Parallel bus consists of clock line and data line. As shown in the figure below, CLK is the clock line, while Bit0 and Bit1 are the 0 bit and 1st bit on the data line respectively.

The oscilloscope will sample the channel data on the rising edge, falling edge or the rising&falling edges of the clock and judge each data point (logic “1” or logic “0”) according to the preset threshold level.

Press Decode1 → Decode to select “Parallel” and open the parallel decoding function menu.

1. Clock Line Setting (CLK)
   Press CLKChannel to select any channel (CH1 or CH2) as the clock channel. If “None” is selected, no clock channel is set.
   Press Slope to set the oscilloscope to sample the channel data on the rising edge (↑), falling edge (↓) or rising/falling edges (↔). If no clock channel is selected, the instrument will sample when the channel data jumps during the decoding.

2. Data Line Setting
   - Set the bus bits
     Press Bus Bits to set the data width of the parallel bus namely the number of bits per frame. The default is 1 and the maximum is 20 bits (Bit0, Bit1…Bit19).

   - Specify data channel for each bit.
     First, press CurrentBit to select the bit that needs to specify channel. The
default is 0 and the range available is always 1 smaller than the bus bits. For example, when the bus bits is 20, the range available is 0, 1...19.
Next, press **Channel** to specify a channel source for the bit currently selected in **CurrentBit**.

3. **Analog Channel Threshold Setting**
To judge logic “1” and logic “0” of the buses, you need to set a threshold for each analog channel (CH1 and CH2). When the signal amplitude is greater than the preset value, it is considered as “1”; otherwise “0”.

![Threshold Setting Diagram]

Press **Threshold** to turn the threshold setting menu on.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Select the channel (CH1 or CH2) that needs to set a threshold.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TTL</td>
<td>Press this softkey to set the threshold of the specified channel to TTL level immediately.</td>
</tr>
<tr>
<td>CMOS</td>
<td>Press this softkey to set the threshold of the specified channel to CMOS level immediately.</td>
</tr>
<tr>
<td>ECL</td>
<td>Press this softkey to set the threshold of the specified channel to ECL level immediately.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Press this softkey and use to set the threshold. The default is 0 V.</td>
</tr>
</tbody>
</table>

Note: When the threshold selected is beyond the specified range, it will be automatically limited within the range.

4. **Display-related Setting**
Press **Format** to set the display format of the bus to Hex, Decimal, Binary or ASCII.
Press **Offset** and use to adjust the vertical display position of the bus.
Press **BusStatus** to turn the bus display on or off.
5. Decoding Table
The decoding table displays the decoded data and the corresponding line number and time in table format. It can be used to observe relatively longer decoded data to solve the problem that some data could not be seen clearly on the screen.

Press Event Table → Event Table to select “ON” (note that this operation is only available when BusStatus is set to “ON”) to enter the decoding table interface as shown in the figure below. At this point, “Table” is selected in the View menu automatically and the menu is grayed out. The decoded data is displayed in table format following the time order. If an USB storage device is currently connected to the instrument, press Export to export the data table to the external USB storage device in CSV format.

![Figure 7-2 Parallel Decoding Table](image)
**RS232 Decoding (Option)**

RS232 serial bus consists of the transmitting data line (TX) and the receiving data line (RX).

![Figure 7-3 RS232 Serial Bus Schematic Diagram](image)

The industry standard of RS232 uses “Negative Logic”, namely high level is logic “0” and low level is logic “1”.

![Figure 7-4 RS232 Industrial Standard Schematic Diagram](image)

By default, RS232 uses LSB (Least Significant Bit) transmission sequence, namely the lowest bit of the data is transmitted first. While for MSB (Most Significant Bit), the highest bit of the data is transmitted first.

![Endian (LSB) and MSB](image)

In RS232, baud rate is used to represent the transmitting rate (namely bits per second) of the data. The commonly used baud rates include 2400 bps, 4800 bps, 9600 bps, 19200 bps, 38400 bps, 57600 bps and 115200 bps.

In RS232, you need to set the start bit, data bits, check bit (optional) and stop bit of
each frame of data.

<table>
<thead>
<tr>
<th>Start Bit</th>
<th>Data Bit</th>
<th>Check Bit</th>
<th>Stop Bit</th>
</tr>
</thead>
</table>

**Start Bit:** represent when the data starts outputting. Setting the **Polarity** is equivalent to specifying the “Start Bit”.

**Data Bits:** represent the number of data bits actually contained in each frame of data.

**Check Bit:** used to check the correctness of the data transmission.
- Odd Checkout: the total number of “1” in the data bit and check bit is an odd. For example, when 0x55 (01010101) is sent, a 1 needs to be filled in the check bit to make the number of 1 be an odd.
- Even Checkout: the total number of “1” in the data bit and check bit is an even. For example, when 0x55 (01010101) is sent, a 0 should be filled in the check bit.
- None: there would not be check bit during the transmission.

Press [Decode1] → [Decode] to select “RS232” to open the RS232 decoding function menu.

1. **TX and RX Channel Setting**
   Press **TX** to select any channel (CH1 or CH2) as the transmitting channel and when “OFF” is selected, no transmitting channel is set. Use the same method the set the **RX** channel. What’s more, you need to set the thresholds of the input channels of **TX** and **RX**. Switch the menu page and press **TXThreshold** and **RXThreshold** respectively to input the desired threshold values.

2. **Polarity Setting**
   Press **Polarity** to select “Normal” or “Invert” and the default is normal. The oscilloscope will select the rising or falling edge as the start position during decoding.

3. **Endian Setting**
   Press **Endian** to select “LSB” or “MSB” and the default is “LSB”.

---

User's Guide for DS2000A
4. **Baud Rate Setting**

Press Baud to select the desired baud rate and the default is 9600 bps.

5. **Data Packet Setting**

As mentioned before, in RS232, you need to set the start bit, data bits, check bit (optional) and stop bit of each frame of data. “Start Bit” is specified by the “Polarity Setting”. The setting methods of other parameters are as follows.

- Press Data Bits to set the data width of each frame. It can be set to 5, 6, 7, 8 or 9 and the default is 8.
- Press Stop Bit to set the stop bit after each frame of data. It can be set to 1 bit, 1.5 bits or 2 bits.
- Press Even-OddCheck to set the even-odd check mode of the data transmission. It can be set to None, Odd Checkout or Even Checkout.
- Press Packet to enable or disable the packet end. When packet end is enabled, several data blocks are combined according to the packet end.
- Press PacketEnd to set the packet end during data transmission and it can be set to 00 (NULL), 0A (LF), 0D (CR), 20 (SP) or FF.

6. **Display-related Setting**

Press Format to set the display format of the bus to Hex, Decimal, Binary or ASCII.

Press Offset and use to adjust the vertical display position of the bus.

Press BusStatus to turn the bus display on or off.

7. **Decoding Table**

The decoding table displays the decoded data, the corresponding line number, time and error information on TX and RX data lines in table format. It can be used to observe relatively longer decoded data to solve the problem that some data could not be seen clearly on the screen.

Note that when the RX channel is turned off, the information of this data line will not be displayed in the decoding table.

Press Event Table → Event Table to select “ON” (note that this operation is only available when BusStatus is set to “ON”) to enter the decoding table interface as shown in the figure below. At this point, “Table” is selected in the View menu automatically and the menu is grayed out. The decoded data is
displayed in table format following the time order. If error occurs during the decoding, the corresponding error information is displayed. If a USB storage device is currently connected to the instrument, press Export to export the data table to the external USB storage device in CSV format.

Figure 7-5 RS232 Decoding Table

8. **The Error Expression during Decoding**

DS2000A makes full use of the resources such as color and view to express the results of the protocol decoding effectively so as to let users find the desired information quickly.

**End Frame Error:**

Errors generated when the end frame condition is not met. When the stop bit is set to 1.5, red error mark (note that the red mark is displayed in different modes according to the horizontal time base setting; when the horizontal time base is relatively smaller, ⬤ is displayed; otherwise, ⬤ is displayed) will be displayed if the stop bit is less than 1.5.
Check Error:
When check bit error is detected during the decoding, red error mark will be displayed. For example, when the transmitting terminal is set to none check and the decoder is set to odd check, the following check error occurs.

Wherein, there are odd number (1) of 1 in the 8-bit data 00000100 and the check bit should be 0; but the check bit detected on the TX is 1, thus check error occurs.

After the decoder is set to none check, the decoding becomes normal.

Note that two error marks will be displayed when end frame error and check error are detected at the same time.
I2C Decoding (Option)

I2C serial bus consists of the clock line (SCLK) and the data line (SDA).

![I2C Serial Bus Diagram](image)

**SCLK:** sample the SDA on the clock rising edge or falling edge.

**SDA:** denote the data channel.

Press **Decode1 → Decode** to select “I2C” and open the I2C decoding function menu.

1. **SCLK Setting**
   - Press **SCLK** to select any channel (CH1 or CH2) as the clock channel.
   - Press **SCLKThreshold** to set the threshold of the clock channel. The range of the threshold is decided by the vertical position and scale, and is from (-5*vertical scale - vertical position) to (5*vertical scale - vertical position).

2. **SDA Setting**
   - Press **SDA** to select any channel (CH1 or CH2) as the data channel.
   - Press **SDAThreshold** to set the threshold of the data channel. The range of the threshold is decided by the vertical position and scale, and is from (-5*vertical scale - vertical position) to (5*vertical scale - vertical position).

3. **Display-related Setting**
   - Press **Format** to set the display format of the bus to Hex, Decimal, Binary or
7 Protocol Decoding

ASCII.
Press **Offset** and use ⊕ to adjust the vertical display position of the bus. Press **BusStatus** to turn the bus display on or off.

4. Decoding Table

The decoding table displays the decoded data, the corresponding line number, time, data direction, ID and ACK information in table or details format.

Press **Event Table → Event Table** to select “ON” (note that this operation is only available when **BusStatus** is set to “ON”) to enter the decoding table interface. At this point, you can press **View** to display the decoding table in “Table” form (as shown in Figure 7-7) or “Details” form (as shown in Figure 7-8). If a USB storage device is currently connected to the instrument, you can export the data table to the external USB storage device in CSV format.

![Figure 7-7 I2C Decoding Table (Table)](image-url)
5. **Address Information during Decoding**

In I2C bus, the front part of each frame of data contains the address information and blue patches are used to represent address ID. In the ID, “Write” is used to represent writing address and “Read” is used to represent reading address.

Press **Include R/W**. When “Open” is selected, **AddrBits** will include the “R/W” bit as a part of the address value.

6. **Error Expressions during Decoding**

When the ACK (ACKnowledge Character) is not met, the red error marks as shown in the figure below will be displayed. Note that the red mark is displayed
in different modes according to the horizontal time base setting; when the horizontal time base is relatively smaller, \( \text{ack} = 0 \) is displayed; otherwise, \( \text{ack} = 1 \) is displayed.

Figure 7-10 Error Expressions during Decoding
SPI Decoding (Option)

SPI serial bus consists of clock line (SCLK) and data line (SDA).

![SPI Serial Bus Diagram]

**SCLK**: sample the SDA on the clock rising edge or falling edge.

**SDA**: denote the data channel.

Press **Decode1** → **Decode** to select “SPI” and open the SPI decoding function menu.

1. **SCLK Setting**
   - Press **SCLK** to enter the clock line setting interface.
     - Press **Channel** to select any channel (CH1 or CH2) as the clock channel.
     - Press **Slope** to set to sample the SDA on the rising or falling edge of the SCLK.
   - Press **Threshold** to set the threshold of the clock channel. The range of the threshold is decided by the vertical position and scale, and is from (-5 * vertical scale - vertical position) to (5 * vertical scale - vertical position).

2. **SDA Setting**
   - Press **SDA** to enter the SDA data line setting interface.
     - Press **Channel** to select any channel (CH1 or CH2) as the data channel. If “OFF” is selected, this data line will not be set.
     - Press **Polarity** to set the polarity of the SDA data line to **HIGH** (high) or **LOW** (low).
   - Press **Threshold** to set the threshold of the data channel. The range of the threshold is decided by the vertical position and scale, and is from (-5 * vertical scale - vertical position) to (5 * vertical scale - vertical position).
scale - vertical position) to (5 * vertical scale - vertical position).

3. **Data Bits Setting**
   Press **Data Bits** to set the number of bits of each frame of data. The range available is from 4 to 32. The default is 8.

4. **TimeOut**
   Press **TimeOut**, rotate ← or the navigation knob to set the timeout value of the current signal. The range available is from 1 ns to 1.00s.

5. **Endian Setting**
   Press **Endian** to select “LSB” or “MSB” and the default is “MSB”.

6. **Display-related Setting**
   Press **Format** to set the display format of the bus to Hex, Decimal, Binary or ASCII.
   Press **Offset** and use ← to adjust the vertical display position of the bus.
   Press **BusStatus** to turn the bus display on or off.

7. **Decoding Table**
   The decoding table displays the decoded data, the corresponding line number, time and error information on the data line in table format. It can be used to observe relatively longer decoded data to solve the problem that some data could not be seen clearly on the screen.

   Press **Event Table** → **Event Table** to select “ON” (note that this operation is only available when **BusStatus** is set to “ON”) to enter the decoding table interface as shown in the figure below. At this point, “Table” is selected in the **View** menu automatically and the menu is grayed out. The decoded data is displayed in table format following the time order. If a USB storage device is currently connected to the instrument, press **Export** to export the data table to the external USB storage device in CSV format.
8. **Error Expressions during Decoding**

When the clock for a frame in SPI is not enough, the data is filled with red patches. For example, when Data Bits is set to 7 and SCLK slope is set to rising edge, decoding error will be generated.
CAN Decoding (Option)

Press Decode \(\rightarrow\) Decode and select “CAN” to open the CAN decoding function menu.

1. **Source**
   Press Source and select any channel (CH1 or CH2) as the source channel.

2. **Signal Type**
   Press Signal Type to select the desired signal type.
   - **CAN_H**: the actual CAN_H bus signal.
   - **CAN_L**: the actual CAN_L bus signal.
   - **Differential**: the CAN differential bus signals connected to an analog channel using a differential probe. The positive lead of the probe connects the CAN_H bus signal and the negative lead connects the CAN_L bus signal.

3. **Baud**
   Press Baud to select a baud rate (100 kb/s, 125 kb/s, 250 kb/s, 400 kb/s, 500 kb/s (default), 800 kb/s, 1 Mb/s or User) that matches the CAN bus signal. When “User” is selected, press Setup and use \(\rightarrow\) or the navigation knob to enter the desired rate. The range is from 10 kb/s to 1 Mb/s.

4. **Sample Point**
   The Sample point is a point within a bit’s time. The oscilloscope samples the bit level at this point. “Sample point” is represented by the percentage of “the time from the start of the bit’s time to the sample point time” in the “bit’s time”.

   Press Sample Point and use \(\rightarrow\) to adjust this parameter with a step of 1%. The range is from 5% to 95% and the default is 50%.

![Figure 7-14 Sample Position Schematic Diagram](image)
5. **Threshold**
   Refer to the introduction in “Parallel Decoding”.

6. **Display-related Setting**
   Press **Format** to set the bus display format to Hex, Decimal, Binary or ASCII. Press **Offset** and use ↑ to adjust the vertical display position of the bus. Press **BusStatus** to enable or disable bus display.

7. **Decoding Table**
   The decoding table displays the decoded data, the corresponding line number, time, frame ID, DLC, CRC and ACK information in table or details format.

   Press **Event Table → Event Table** to select “ON” (note that this operation is only available when **BusStatus** is set to “ON”) to enter the decoding table interface. At this point, you can press **View** to display the decoding table in “Table” form (as shown in Figure 7-15) or “Details” form (as shown in Figure 7-16). If a USB storage device is currently connected to the instrument, press **Export** to export the data table to the external USB storage device in CSV format.

![Figure 7-15 CAN Decoding Table (Table)](image)
8. Decoded CAN Data Interpretation

- Frame ID: display as hex digits in blue.
- Data Length code (DLC): displayed as a chartreuse patch.
- Data Frame: displayed as green patches if data is successfully decoded. The frames appear as red patches if the data frame is lost.
- Cyclic Redundancy Check (CRC): displayed in a light blue patch when valid and red error mark is displayed when error occurs.
8 Reference Waveform

In actual testing process, the waveform being tested can be compared with the reference waveform to judge the causes of failures.

The contents of this chapter:

- **To Enable REF Function**
- **To Set the Color**
- **To Select REF Source**
- **To Save to Internal Memory**
- **To Adjust REF Waveform Display**
- **To Export to Internal or External Memory**
- **To Import from Internal or External Memory**
To Enable REF Function

Press **REF** in the vertical control area (VERTICAL) at the front panel to enable the REF function. Note that when the time base is in X-Y mode, REF function can not be enabled.

DS2000A provides 10 reference waveform channels. Press **Channel** and use ☑️ to set the desired reference channel to on or off and a channel icon (for example, ☑️) of the channel enabled will be display at the left side of the screen grid.

When the REF function is enabled, you can select different color for each reference waveform, set the source of each reference channel, adjust the vertical scale and position of the reference waveform and save the reference waveform to internal or external memory as well as recall it when needed. For details, please refer to the introductions below.
To Set the Color

DS2000A series oscilloscope provides five colors (gray, green, light blue, magenta and orange) to mark the reference waveforms of different channels in order to distinguish them.

Press **Current** and use ← to select any of the reference channels (Ref1-Ref10) enabled. Then, press **Color** to specify a different color for the reference waveform of that channel. The corresponding icon at the left of the channel currently selected will be filled with the specified color, for example, ³:].

To Select REF Source

Press **Current** and use ← to select any of the reference channels (Ref1 to Ref10) enabled and then press **Source** to specify a reference source (CH1, CH2 or MATH) for this channel.

To Save to Internal Memory

Press **Save** to save the waveform (screen region) in the specified source to internal memory as reference waveform and display it on the screen. Note that this operation only saves the reference waveform in the volatile memory and the waveform will be cleared at power-off.
To Adjust REF Waveform Display

To adjust the reference waveform specified in **Current**:

Press [REF] to enable the REF function. Then, press [△] and use [○] to adjust the vertical position of the reference waveform and press [▽] and use [△] to adjust the vertical scale of the reference waveform.

Press [Reset] and the reference waveform returns to the position where the source channel waveform is located when the **Save** operation was executed.

To Export to Internal or External Memory

Users can also save the reference waveform to the internal Flash memory or external USB storage device. The file format of the reference waveform is “*.ref”. At most 10 reference files (LocalREF0.ref to LocalREF9.ref) can be saved inside the instrument.

Press [Export] to enter the file store interface. Please refer to the relative descriptions in **Store and Recall** to save the reference waveform to internal or external memory.

To Import from Internal or External Memory

Users can also import the reference waveform stored in the internal Flash memory or external USB storage device to the internal memory.

Press [Import] to enter the file recall interface. Please refer to the relative descriptions in **Store and Recall** to import the reference waveform to the internal memory of the instrument.
9 Pass/ Fail Test

Monitor the change of the signal by judging whether the input signal is within the mask created. The test results can be displayed on the screen as well as be declared through the system sound or the pulse signal output from the [Trigger Out] connector at the rear panel.

The contents of this chapter:

- To Enable Pass/ Fail Test
- To Select Source
- Mask Range
- Test and Ouput
- To Save the Test Mask
- To Load the Test Mask
To Enable Pass/Fail Test

Press Utility → Pass/Fail → Enable Test to select “ON”. Note that when the time base is in X-Y mode, the Pass/Fail test function cannot be enabled.

To start testing, press Enable Test and select “ON”. Then, press Operate to select “▶” to start testing and select “■” to stop testing.

You can select the signal source, set the test mask range, create mask as well as save and load the test mask. For details, please refer to the following introductions.

To Select Source

Press Source to select the channel (CH1 or CH2) to be tested and only channels enabled can be selected. During the test, the oscilloscope will judge whether each frame of waveform in the source complies with the current test mask and those waveforms pass through the mask area (blue area) is considered as failed.

Mask Range

Users can define their desired test masks.

Press MaskRange → MaskRange to select “Screen Region” or “Cursor Region” for test. When “Cursor Region” is selected, two gray cursor lines appear on the screen. At this point, press CursorA and CursorB; then, use ‹› to adjust the positions of the two cursor lines respectively. Or, press CursorAB and use ‹› to adjust the positions of cursor A and cursor B at the same time. Note that you can press down ‼· continuously to switch the current cursor.

Press X Mask and Y Mask, rotate ‹› and the mask lines appear on the screen as shown in the figure below. Press Create Mask to apply the mask currently created. The horizontal and vertical adjustment ranges are 0.02 div to 4.0 div and 0.04 div to 5.12 div respectively.
Test and Output

Before the test, you can use the following method to set the output mode of the test results.

Press **Msg Display** to select “ON” or “OFF”. When “ON” is selected, the test results will be displayed at the upper right corner of the screen.

![Fail 13 wfs
Pass= 1035 wfs
Total= 1048 wfs](image)

Press **Stop On Outp** to select “ON” or “OFF”.

- **ON**: when failed waveforms are detected, the oscilloscope will stop the test and enter the “STOP” state. At this point, the results of the test remain the same on the screen (if display is turned on) and only one negative pulse is output from the [Trigger Out] connector (if enabled) at the rear panel.
- **OFF**: the oscilloscope will continue with the test even though failed waveforms are detected. The test results on the screen will update continuously and a pulse will be output from the [Trigger Out] connector at the rear panel each time a failed waveform is detected.

Press **Output** to select “Fail” or “Fail+.”
• Fail: when failed waveforms are detected, there are display and output but the beeper does not sound.
• Fail+: when failed waveforms are detected, there are display and output and the beeper sounds (not related to the on/off state of the sound).

Press **AuxOutput** to quickly turn “ON” or “OFF” the output of test results from the **[Trigger Out]** connector at the rear panel. You can also press **Utility** → **AuxOutput** and select “PassFail” to set this output.

**To Save the Test Mask**

Users can save the current test mask to the internal Flash memory or external USB storage device. The file format of the test mask file is “*.pf”. The internal memory can store at most 10 test mask files (LocalPF.pf).

Press **Save** to enter the file store interface. Please refer to the relative descriptions in **Store and Recall** to save the test mask file to the internal or external memory.

**To Load the Test Mask**

Users can also load the test mask files (*.pf) stored in the internal Flash memory or external USB storage device to the internal memory.

Press **Load** to enter the file recall interface. Please refer to the relative descriptions in **Store and Recall** to load the test masks to the internal memory of the instrument.
10 Waveform Record

Waveform record can record the waveforms of the input channels (CH1 and CH2). In record constant on (open) mode, the oscilloscope can record the input waveform continuously until users press RUN/STOP. Waveform playback and analysis can provide better waveform analysis effect. (Note: The horizontal time base must be set to Y-T mode during waveform record.)

The contents of this chapter:

- Waveform Record
- Record Constant On
- Waveform Playback
- Waveform Analysis
Waveform Record

Waveforms from both the channels currently turned on will be recorded during waveform record. Press Utility → Record → Mode and use to select “Record” to open the waveform record operation menu.

1. **End Frame**
   Press End Frame and use to set the desired number of frames to be recorded. The number of frames available is related to the memory depth currently selected.

2. **Record Operation**
   Waveform record can be realized via the menu or the shortcut buttons at the front panel.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Front Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press Operate and select “●” to start recording.</td>
<td>Press ; the backlight goes on (in red) and starts to flash, indicating that the record is started.</td>
</tr>
<tr>
<td>When the record is finished, “●” changes to “■” automatically. You can also select “■” manually.</td>
<td>When the record is finished, goes off automatically and goes on (in orange). You can also press directly.</td>
</tr>
</tbody>
</table>

3. **Interval**
   Set the time interval between the frames in waveform record and the range available is from 100 ns to 10 s.

4. **Total Frames**
   The menu shows the maximum number of frames that can be recorded currently.
   As the capacity of the waveform memory is fixed, the more the number of points each frame of waveform has, the less the number of waveform frames can be recorded. The number of points each frame of waveform has equals to the current memory depth\(^1\). Thus, the maximum end frame of waveform record is decided by the memory depth currently selected. Please refer to the instruction in Memory Depth to select the desired memory depth.
**Note[^1]**: Memory Depth = Sample Rate \times \text{Horizontal Timebase} \times \text{The Number of Divisions in the Horizontal Axis. For DS2000A, “The Number of Divisions in the Horizontal Axis” equals to 14. Thus, the maximum end frame of waveform record is also related to “Sample Rate” and “Horizontal Timebase”.

Table 10-1 Memory Depth and Total Frames

<table>
<thead>
<tr>
<th>Memory Depth</th>
<th>Maximum End Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>65000</td>
</tr>
<tr>
<td>14 k points</td>
<td>8128</td>
</tr>
<tr>
<td>140 k points</td>
<td>508</td>
</tr>
<tr>
<td>1.4M points</td>
<td>63</td>
</tr>
<tr>
<td>14M points</td>
<td>7</td>
</tr>
<tr>
<td>56M points (Option)</td>
<td>2</td>
</tr>
</tbody>
</table>

[^1]: This note is used to denote a special condition or exception in the text.
Record Constant On

DS2000A provides record “Open” (record constant on) mode for waveform record. When this mode is enabled, the oscilloscope records the waveform continuously according to the current memory depth. The number of the waveform frames recorded is limited by the memory depth (sample rate and horizontal timebase) and the waveform data recorded before will be overwritten by the waveform currently recorded. In this mode, the other oscilloscope operations (except Pass/Fail Test as well as Acquisition Mode, Sample Mode, Sample Rate and Memory Depth in the sample system setting and Time Base Mode in the horizontal system setting) are not affected.

Press Utility → Record → Mode and use ⇧ to select “Open”. At this point, the waveform record key ➡ at the front panel turns red and the oscilloscope records the waveform continuously according to the current memory depth (sample rate and horizontal timebase). The oscilloscope stops recording until users press RUN/STOP and at this point, users can play back or analyze the waveform.

In constant on mode, the oscilloscope can capture the accidental abnormal signals during the adjustment. Following is an application example of the record constant on mode. Use DS2000A (CH1) to observe a pulse which might contain runt pulses.

1. Connect the pulse under test to CH1 of the oscilloscope. Adjust the oscilloscope to make it trigger stably.

2. Enable record constant on mode.
3. Press **RUN/STOP** to stop the record.

4. Analyze the waveform recorded using waveform analysis and as shown in the figure below, the runt pulses are captured.
Waveform Playback

Waveform playback can play back the waveforms currently recorded. Press **Utility** → **Record** → **Mode** and use ← to select “Play back”. At this point, the information as shown in the figure below is displayed at the upper right corner of the screen, indicating the specific frame currently displayed on the screen. During the playback, this value would change continuously.

Please refer to the following descriptions to set the playback parameters.

1. **Play Mode**
   - Press this softkey to set the playback mode to cycle or single.
     - ■: cycle playback. Play from the start frame to the end frame and then repeat until you stop it manually.
     - ●: single playback. Play from the start frame to the end frame and then stop.

2. **Interval**
   - Press this softkey and use ← to set the time interval of playback. The range available is from 100 ns to 10 s and the default is 100 ns.

3. **Start Frame**
   - Press this softkey and use ← to set the start frame of playback. The default is 1 and the maximum is the maximum number of frames recorded.

4. **Current Frame**
   - Press this softkey and use ← or the navigation knob (large scale adjustment) to set the current frame. By default, the current frame is the same with the end frame. The setting range of current frame is related to the start frame and end frame settings. During the setting, the screen will display the corresponding waveform of the current frame synchronously, namely manual playback.
   - If you perform the playback operation after setting this parameter, this menu will be adjusted to the **Start Frame** value automatically and will change continuously during the playback process.
5. **End Frame**
   Press this softkey and use 🔁 to set the end frame of the playback. The default is the total number of frames of the waveform recorded.

6. **Playback Operation**
   Waveform playback can be realized through the menu or the shortcut buttons at the front panel.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Front Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press Operate and select ▶️ to start playing back.</td>
<td>Press ▶️; the backlight flashes, indicating that the playback is started.</td>
</tr>
<tr>
<td>Press Operate and select ▪️ to pause the playback.</td>
<td>Press ▪️ again (the backlight goes on (yellow)) to pause the playback.</td>
</tr>
<tr>
<td>Press Operate and select ▼️ to stop the playback.</td>
<td>Press ▼️ to stop the playback.</td>
</tr>
</tbody>
</table>

7. **Time Tag**
   The time tag is used to display the absolute recording time of each frame of the waveform currently recorded. Press Time Tag to enable or disable the time tag function. When it is enabled, the time tag information is displayed at the upper right corner of the screen as shown in the figure below.

   ![Time Tag Example](image)

   T₀: display the absolute starting time of the waveform record.
   △T: display the recording time deviation of the current waveform relative to the first frame of waveform. This value changes accordingly during the waveform playback process.

   **Tip**
   During waveform playback, RUN/STOP can be used to switch between playback and pause. Each time SINGLE is pressed, the Current Frame moves one frame forward.
Waveform Analysis

This function is used to analyze the recorded waveform. Press [Utility] → [Record] → [Mode] and use $\text{→}$ to select “Analyze” to open the waveform analysis menu. At this point, the screen is divided into two display areas as shown in the figure below.

![Waveform Analysis Diagram]

Please refer to the following explanations to set the waveform analysis parameters.

1. **Analyze**
   - Press **Analyze** to select the desired analysis mode.
     - Trace: perform analysis on the basis of the templet selected by users. For detailed information, refer to [Analysis Based on Trace](#).
     - Pass/Fail: perform analysis on the basis of the Pass/Fail mask created by users. For detailed information, refer to [Analysis Based on Pass/Fail Mask](#).

2. **Source**
   - Press **Source** to select the channel (CH1 or CH2) to be analyzed. Note that only channels currently enabled can be selected.
3. **Start**

Press **Start** to enable waveform analysis. Note that during the analysis process, the progress bar is displayed and the parameters can not be modified. After the analysis finishes, the analysis results of “Error Frames”, “Current Error” and “CurFrame Diff” are displayed; at the same time, the first error frame is located as shown in the figure below. At this point, the next error frame, the previous error frame as well as every frame in this waveform analysis can be located using the corresponding softkeys.

**Error Frames:**
The total number of error frames discovered in this analysis. The number of error frames is related to the error frame threshold currently set.

**Current Error:**
The order number of the error frame lately located in all the error frames when locating every data frame in this analysis.

**CurFrame Diff:**
During the analysis based on trace, the oscilloscope compares each frame with the templet to compute the difference value and normalizes each value using the maximum one; then, compares the normalized value of each frame with the threshold selected to judge whether the frame is an error frame. “CurFrame Diff” (relative difference) is the normalized value of the difference between the current frame and templet.

During the analysis based on pass/fail mask, the oscilloscope compares each frame with the mask to compute the difference value and recognizes the frame whose difference value is equal to or larger than the threshold selected as an error frame and the corresponding “CurFrame Diff” is 100%; otherwise, the frame is judged as correct and the “CurFrame Diff” is 0%. Note that there are
only two “CurFrame Diff” values (100% and 0%) under the analysis based on pass/fail mask.

4. **Cancel**
   During the analysis, users can press **Cancel** to stop the analysis and press **Start** again to restart the analysis.

5. **Previous**
   After the waveform analysis finishes, pressing **Previous** can locate the error frame previous to the current error frame. Pressing **RUN/STOP** can also perform the operation.

6. **Next**
   After the waveform analysis finishes, pressing **Next** can locate the error frame following the current error frame. Pressing **SINGLE** can also perform the operation.

7. **Current Frame**
   Press **Current Frame** to adjust the data frame currently displayed and the adjustable range is from 1 to the total number of frames in this waveform analysis. Using the navigation knob can also perform the operation.

8. **Setup**
   Press **Setup** to open the more detailed setting menu.
   - Screen Start: press this key to set the start point of waveform analysis and the range is from 5 to 685. The start point must be less than the “Screen End - 10” currently set.
   - Screen End: press this key to set the end point of waveform analysis and the range is from 15 to 695. The end point must be greater than the “Screen Start + 10” currently set.
   - Start Frame: press this key to set the start frame of waveform analysis and the default is the first frame.
   - End Frame: press this key to set the end frame of waveform analysis and the default is the last frame.
   - Threshold: press this key to set the threshold of waveform analysis and the range is from 1% to 99%. The threshold is used to judge whether the frame is an error frame. A frame is recognize as an error one if the (relative)
difference value between the frame and the template is equal to or larger than the threshold currently set.

9. **Time Tag**

The time tag is used to display the absolute recording time of each frame of the waveform currently recorded. Press **Time Tag** to enable or disable the time tag function. When it is enabled, the time tag information is displayed at the upper right corner of the screen as shown in the figure below.

![Time Tag Example](image)

$T_0$: display the absolute starting time of the waveform record.

$\Delta T$: display the recording time deviation of the current waveform relative to the first frame of waveform.
Analysis Based on Trace

Press **Analyze** and select “Trace”. Then, set the template used in analysis based on trace through the method below.

1. **Trace**
   - Press **Trace** to select the creation method of analysis template.
     - Current Frame: select the current frame as the analysis template.
     - Average: select the average of the current data frame as the analysis template.

2. **Setup Template**
   - Press **Setup Template** to configure the template immediately. After the analysis starts, the oscilloscope compares each frame with the template and determines whether error frame exists according to the threshold currently set.

3. **TemplateDisp**
   - Press **TemplateDisp** to enable or disable template display.
Analysis Based on Pass/ Fail Mask

Press **Analyze** and select “Pass/Fail”. Then, set the template used in analysis based on Pass/Fail mask through the method below.

Press **MaskRange** to open the following setting menus.

1. **Mask Range**
   Press this softkey to select “Screen Region” or “Cursor Region” for the analysis (the default is “Screen Region”). When “Cursor Region” is selected, two gray cursor lines appear on the screen. At this point, press **Cursor A** and **Cursor B**; then, use \( \leftrightarrow \) to adjust the positions of the two cursor lines respectively to determine the analysis range. Or, press **CursorAB** and use \( \leftrightarrow \) to adjust the positions of cursor A and cursor B at the same time. Note that you can press down \( \downarrow \) continuously to switch the current cursor.

2. **X Mask**
   Press this softkey and use \( \leftrightarrow \) to adjust the horizontal threshold and the range is from 0.02 div to 4.00 div. During the adjustment, two curves would be displayed to show the outline of the current mask as shown in the figure below.

![Outline of the Current Mask](image)

Figure 10-4 Analysis Based on Pass/Fail Mask

3. **Y Mask**
   Press this softkey and use \( \leftrightarrow \) to adjust the vertical threshold and the range is from 0.04 div to 5.12 div. During the adjustment, two curves would be displayed to show the outline of the current mask.
4. **Create Mask**

Mask is the template used in waveform analysis. Press **Create Mask** to immediately apply the mask (X Mask and Y Mask) currently created.

Users can store the current test mask into the internal Flash memory or external USB storage device or load the test mask file (*.pf) stored in the internal Flash memory or external USB storage device into the internal memory.

Press **Save** to enter the file store interface. Store the test mask file to internal or external memory by referring to the introduction in **Store and Recall**.

Press **Load** to enter the file recall interface. Load the test mask into the internal memory of the instrument by referring to the introduction in **Store and Recall**.
11 Display Control

You can set the type, persistence time and brightness of waveform display as well as the grid type, grid brightness of the screen display and the menu display time.

The contents of this chapter:

- To Select the Display Type
- To Set the Persistence Time
- To Set the Waveform Intensity
- To Set the Screen Grid
- To Set the Grid Brightness
- To Set the Menu Display
To Select the Display Type

Press **Display** → **Type** to set the waveform display mode to “Vectors” or “Dots”.

- Vectors: the sample points are connected by lines and displayed. Normally, this mode can provide the most vivid waveform to view the steep edge of the waveform (such as square waveform).
- Dots: display the sample points directly. You can directly view each sample point and use the cursor to measure the X and Y values of the sample point.
To Set the Persistence Time

Press **Display** → **PersistTime** to set the persistence time of the oscilloscope to Min, specific values (from 50 ms to 20 s) or Infinite.

In the following part, a frequency sweep signal of the sine waveform is used to demonstrate the waveform effects in different persistence times.

1. **Min**
   Enable to view waveform changing in high refresh rate.

   ![Figure 11-1 Set the Persistence Time of the Oscilloscope to Min](image)

2. **Specific Values**
   Enable to observe glitch that changes relatively slowly or glitch with low occurrence probability. The persistence time can be set to 50 ms, 100 ms, 200 ms, 500 ms, 1 s, 2 s, 5 s, 10 s or 20 s.
3. **Infinite**

In this mode, the oscilloscope displays the waveform newly acquired without clearing the waveforms acquired formerly. The waveforms acquired formerly will be displayed in relatively low-brightness color and the waveform newly acquired will be displayed in normal brightness and color. Infinite persistence can be used to measure noise and jitter and to capture incidental events.
To Set the Waveform Intensity

Press Display → Wave Intensity or turn ↪ when the menu is hidden to adjust the waveform brightness of the analog channel. The default is 50% and the range available is from 0% to 100%.

To Set the Screen Grid

Press Display → Grid to set the screen grid type.

- ●: turn the background grid and coordinate on.
- ●: turn the background grid off.
- ●: turn the background grid and coordinate off.

To Set the Grid Brightness

Press Display → Brightness to set the brightness of the screen grid. Turn ⬇ to adjust the grid brightness. The default is 50% and the range available is from 0% to 100%.

To Set the Menu Display

Press Display → Menu Display to set the menu display time. The menu will hold for a specified period of time after the last button-pressing action and then is hidden. The display time can be set to 1 s, 2 s, 5 s, 10 s, 20 s or Infinite (the menu will not be hidden).
12 Signal Source

DS2000A combines the signal generator and oscilloscope in one instrument by providing a built-in dual-channel, 25MHz signal generator, thus providing convenience for engineers who need to use the signal generator and oscilloscope at the same time. This chapter introduces how to use the built-in signal generator. As the functions and setting methods of the two channels of the signal generator are same, this chapter takes Source 1 for illustration.

Press **Source** to enter the signal generator setting interface.

Press **Source1** to enable or disable the signal output. When it is enabled, the **Source1** connector at the rear panel outputs signal according to the current setting.

Note: The function of **Source → Source1** is the same with that of **Source → Src1 Setup → Source**.

Press **Src1 Setup** to set the signal type and the signal parameters.

Press **Status Disp** to view the parameter settings of SOURCE1 and SOURCE2, such as the frequency, amplitude and offset.

The contents of this chapter:

- **Parameter Setting Method**
- **To Output Basic Waveform**
- **To Output Built-in Waveform**
- **To Output Arbitrary Waveform**
Parameter Setting Method

The following two methods are available for setting the basic parameters (such as the frequency, amplitude, start phase and offset).

Method 1:
Rotate ὀ or the navigation knob to set the desired value.

Method 2:
Press down ὀ and the numeric keyboard is displayed, as is shown below. Rotate the knob to select the desired value and unit and then press down the knob to input the value and unit.

![Figure 12-1 Numeric Keyboard](image)

Note: The number input cannot exceed 10 digits. Otherwise, “DEL” will be selected automatically and pressing the knob will execute the delete operation.
To Output Basic Waveform

To Output Sine

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Sine”. At this point, you can set the sine parameters.

1. **Source**
   
   Press **Source** to turn on or off the signal output.

2. **Set the frequency**
   
   Press **Frequency** to set the frequency of the signal. The range is from 100 mHz to 25 MHz. Note that for different waveforms, the frequency ranges are different. The frequency range of square is from 100 mHz to 15 MHz; the frequency range of pulse is from 100 mHz to 1 MHz; the frequency range of ramp is from 100 mHz to 100 kHz. For the setting method, please refer to the introduction in **Parameter Setting Method**.

3. **Set the amplitude**
   
   Press **Amplitude** to set the amplitude of the signal. When the impedance is set to HighZ, the range is from 20 mVpp to 5 Vpp; when the impedance is set to 50 \( \Omega \), the range is from 10 mVpp to 2.5 Vpp. For the setting method, please refer to the introduction in **Parameter Setting Method**.

4. **Set the DC offset voltage**
   
   Press **Offset** to set the DC offset of the signal. When the impedance is HighZ, the range is from (-2.5 V+the current amplitude/2) to (2.5 V-the current amplitude/2); when the impedance is set to 50 \( \Omega \), the range is from (-1.25 V+the current amplitude/2) to (1.25 V-the current amplitude/2).

   For the setting method, please refer to the introduction in **Parameter Setting Method**.

   Note: The offset value contains three effective digits. For example, when the amplitude is set to 10 mVpp (the impedance is 50 \( \Omega \)), the offset range calculated is from -1.245 V to 1.245 V, while the actual offset range is -1.24 V to 1.24 V.
5. **Set the start phase**
   Press **StartPhase** to set the start phase of the signal. The range is from 0° to 360°. For the setting method, please refer to the introduction in Parameter Setting Method.

6. **Align Phase**
   Pressing **AlignPhase** will re-configure the two channels to output according to the preset frequency and phase. For two signals of which the frequencies are the same or are multiples, this operation can align their phase. Acquire the waveforms of the two channels using the oscilloscope and display the waveforms stably. After switching the channel status, the phase deviation between the two waveforms is changed. At this point, press **AlignPhase** and the phase deviation shown on the oscilloscope will restore to the current phase deviation between the two waveforms automatically.

7. **Modulation**
   Press **Modulation** to turn on or off the modulation function. For detailed introduction of the modulation function, please refer to Modulation.

8. **Set the impedance**
   Press **Impedance** to set the output impedance of the signal generator. It can be set to “HighZ” or “50Ω”.

**To Output Square**

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Square”. At this point, you can set the square parameters. For the detailed setting method, refer to the introduction in Parameter Setting Method. The duty cycle of square is fixed at 50%.
To Output Ramp

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Ramp”. At this point, you can set the ramp parameters. For the detailed setting method, refer to the introduction in **Parameter Setting Method**. This section only introduces “Symmetry”.

**Symmetry**
It is defined as the percentage that the rising period of the ramp takes up in the whole period.

\[
\text{Symmetry} = \frac{t}{T} \times 100\%
\]

Set the symmetry
Press **Symmetry** and use ⏩ or the navigation knob to set the symmetry of the ramp waveform. The range is from 0% to 100%.
To Output Pulse

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Pulse”. At this point, you can set the pulse parameters. For the detailed setting method, refer to the introduction in **To Output Sine**. This section only introduces “DutyCycle”.

**Duty Cycle**

It is defined as the percentage that the high level takes up in the whole pulse period.

\[
\text{Duty Cycle} = \frac{t}{T} \times 100\%
\]

Set the duty cycle

Press **DutyCycle** and use \( \uparrow \downarrow \) or the navigation knob to set the duty cycle of the pulse signal. The range is from 10% to 90%.

To Output DC

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “DC”. At this point, you can output a DC signal with the specified offset.

1. **Source**
   - Press **Source** to turn on or off the signal output.

2. **Set the offset**
   - Press **Offset** to set the offset of the DC signal. When the impedance is HighZ, the range is from -2.5 V to +2.5 V; when the impedance is set to 50 Ω, the range is from -1.25 V to +1.25 V. For the setting method, please refer to the introduction in **Parameter Setting Method**.
To Output Noise

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Noise”. At this point, you can output noise signal with specified amplitude.

1. **Source**
   - Press **Source** to turn on or off the signal output.

2. **Set the amplitude**
   - Press **Amplitude** to set the amplitude of the signal. When the impedance is set to HighZ, the range is from 20 mVpp to 5 Vpp; when the impedance is set to 50 Ω, the range is from 10 mVpp to 2.5 Vpp. For the setting method, please refer to the introduction in **Parameter Setting Method**.

3. **Set the offset**
   - Press **Offset** to set the DC offset of the noise signal. When the impedance is HighZ, the range is from (-2.5 V+the current amplitude/2) to (2.5 V-the current amplitude/2); when the impedance is set to 50 Ω, the range is from (-1.25 V+the current amplitude/2) to (1.25 V-the current amplitude/2).

   For the setting method, please refer to the introduction in **Parameter Setting Method**.

   Note: The offset value contains three effective digits. For example, when the amplitude is set to 10 mVpp (the impedance is 50 Ω), the offset range calculated is from -1.245 V to 1.245 V, while the actual offset range is -1.24 V to 1.24 V.
To Output Built-in Waveform

DS2000A series oscilloscope provides 7 kinds of built-in waveforms, including Sinc, ExpRise, ExpFall, ECG, Gauss, Lorentz and Haversine.

**Sinc**

The schematic diagram of Sinc function waveform is as shown in the figure below.

![Figure 12-2 Sinc Function Waveform](image)

**ExpRise**

The schematic diagram of ExpRise function waveform is as shown in the figure below.

![Figure 12-3 ExpRise Function Waveform](image)
**ExpFall**
The schematic diagram of ExpFall function waveform is as shown in the figure below.

![Figure 12-4 ExpFall Function Waveform](image)

**ECG**
The analog ECG is as shown in the figure below.

![Figure 12-5 Analog ECG](image)
Gauss
The schematic diagram of Gauss function waveform is as shown in the figure below.

![Figure 12-6 Gauss Function Waveform](image)

Lorentz
The schematic diagram of Lorentz function waveform is as shown in the figure below.

![Figure 12-7 Lorentz Function Waveform](image)
Haversine
The schematic diagram of Haversine function waveform is as shown in the figure below.

![Haversine Function Waveform](image)

Figure 12-8 Haversine Function Waveform

Press **Src1 Setup** to open the waveform setting menu. Press **Wave** and select “Built-in”. At this point, you can set the output signal parameters according to the type of the built-in waveform selected.

1. **Source**
   Press **Source** to turn on or off the signal output.

2. **Select built-in waveform**
   Press **Built-in** to select any of the 7 built-in waveforms.

3. **Set the frequency**
   Press **Frequency** to set the frequency of the signal. The range is from 100 mHz to 1 MHz. For the setting method, please refer to the introduction in Parameter Setting Method.

4. **Set the amplitude**
   Press **Amplitude** to set the amplitude of the signal. When the impedance is set to HighZ, the range is from 20 mVpp to 5 Vpp; when the impedance is set to 50 Ω, the range is from 10 mVpp to 2.5 Vpp. For the setting method, please refer to the introduction in Parameter Setting Method.
5. **Set the DC offset voltage**
   Press Offset to set the DC offset of the signal. When the impedance is HighZ, the range is from (-2.5 V+the current amplitude/2) to (2.5 V-the current amplitude/2); when the impedance is set to 50 Ω, the range is from (-1.25 V+the current amplitude/2) to (1.25 V-the current amplitude/2). For the setting method, please refer to the introduction in Parameter Setting Method.
   Note: The offset value contains three effective digits. For example, when the amplitude is set to 10 mVpp (the impedance is 50 Ω), the offset range calculated is from -1.245 V to 1.245 V, while the actual offset range is -1.24 V to 1.24 V.

6. **Set the start phase**
   Press StartPhase to set the start phase of the signal. The range is from 0° to 360°.
   For the setting method, please refer to the introduction in Parameter Setting Method.

7. **Align Phase**
   The align phase operation is for the two channels. Pressing AlignPhase will re-configure the two channels to output according to the preset frequency and phase. For two signals of which the frequencies are the same or are multiples, this operation can align their phase. Acquire the waveforms of the two channels using the oscilloscope and display the waveforms stably. After switching the channel status, the phase deviation between the two waveforms is changed. At this point, press AlignPhase and the phase deviation shown on the oscilloscope will restore to the current phase deviation between the two waveforms automatically.

8. **Modulation**
   Press Modulation to turn on or off the modulation function. For detailed introduction of the modulation function, please refer to Modulation.

9. **Set the impedance**
   Press Impedance to set the output impedance of the signal generator. It can be set to “HighZ” or “50Ω”.

---

[Parameter Setting Method]
To Output Arbitrary Waveform

DS2000A allows users to define their own arbitrary waveform and save it in the internal or external memory. At most 10 arbitrary waveforms can be stored in the internal memory. The user-defined waveform can contain 1 to 16384 data points (namely 1 pts to 16 kpts).

1. **Source**
   Press **Source** to turn on or off the signal output.

2. **Set the frequency**
   Press **Frequency** to set the frequency of the signal. The range is from 100 mHz to 10 MHz.
   For the setting method, please refer to the introduction in Parameter Setting Method.

3. **Set the amplitude**
   Press **Amplitude** to set the amplitude of the signal. When the impedance is set to HighZ, the range is from 20 mVpp to 5 Vpp; when the impedance is set to 50 Ω, the range is from 10 mVpp to 2.5 Vpp. For the setting method, please refer to the introduction in Parameter Setting Method.

4. **Set the DC offset voltage**
   Press **Offset** to set the DC offset of the signal. When the impedance is HighZ, the range is from (-2.5 V+the current amplitude/2) to (2.5 V-the current amplitude/2); when the impedance is set to 50 Ω, the range is from (-1.25 V+the current amplitude/2) to (1.25 V-the current amplitude/2).
   For the setting method, please refer to the introduction in Parameter Setting Method.
   Note: The offset value contains three effective digits. For example, when the amplitude is set to 10 mVpp (the impedance is 50 Ω), the offset range calculated is from -1.245 V to 1.245 V, while the actual offset range is -1.24 V to 1.24 V.

5. **Set the start phase**
   Press **StartPhase** to set the start phase of the signal. The range is from 0° to
360°.
For the setting method, please refer to the introduction in Parameter Setting Method.

6. **Align Phase**
The align phase operation is for the two channels. Pressing **AlignPhase** will re-configure the two channels to output according to the preset frequency and phase. For two signals of which the frequencies are the same or are multiples, this operation can align their phase. Acquire the waveforms of the two channels using the oscilloscope and display the waveforms stably. After switching the channel status, the phase deviation between the two waveforms is changed. At this point, press **AlignPhase** and the phase deviation shown on the oscilloscope will restore to the current phase deviation between the two waveforms automatically.

7. **Select waveform**
Select the arbitrary waveform in the internal or external memory.

8. **Create waveform**
Users define their own arbitrary waveform.

9. **Edit waveform**
Edit the arbitrary waveform stored.

10. **Modulation**
Press **Modulation** to turn on or off the modulation function. For detailed introduction of the modulation function, please refer to **Modulation**.

11. **Set the impedance**
Press **Impedance** to set the output impedance of the signal generator. It can be set to “HighZ” or “50Ω”.

The following section introduces how to **To Select Waveform**, **To Create Waveform** and **To Edit Waveform**.
11 Display Control

To Select Waveform

Users can select arbitrary waveforms in the internal or external memory for output. Press **SelectArb** → **StoredWforms**, use ← to select the desired waveform and press **Load**. You can also edit the waveform currently selected; for details, refer to the introduction in **To Edit Waveform**.

To Create Waveform

Users can create arbitrary waveforms according to their needs. Press **Create New** to enter the waveform creation menu.

1. **Set the initial Points**
   When creating a new waveform, the waveform editor will create a waveform formed by two points automatically. By default, point 1 is fixed at 0 s and point 2 is fixed at the middle of the period.
   Press **InitPoint** and use ← or the navigation knob to set the initial points of the new waveform. The arbitrary waveform can contain up to 16384 (16 kpts) points.

2. **Interpolation**
   Press **Interp** to turn on or off the interpolation mode between the points of the waveform.
   - **ON**: the waveform editor connects two points using a straight line.
   - **OFF**: the waveform editor will keep a constant voltage level between the two points and create a ladder-like waveform.
3. **Zoom**
   Press **Zoom** to turn on or off the zoom function.
   - **ON**: the waveform editing window only displays the current point.
   - **OFF**: the waveform editing window displays all the initial points.

4. **Current Point**
   Press **CurPoint** and use ↪ or the navigation knob to select the point to be edited. The range is from 1 to the **initial points**.

5. **Voltage**
   Press **Voltage** to set the voltage of the current point. The range is from -2.5 V to +2.5 V.

6. **Time**
   Press **Time** to set the duration of the current point. This setting is limited by the times of the previous point and following point. The time of point 1 is fixed at 0 s.

7. **Insert**
   Press **Insert** to insert a new waveform point between the current point and the next point.

8. **Delete**
   Press **Delete** to delete the current point from the waveform and connect the remaining points using the current interpolation mode. Note that point 1 can not be deleted.

9. **Done**
   Press **Done** to finish editing the current waveform.
10. Save

Press **Save** to enter the file store interface. Please refer to the introduction in **Store and Recall** to save the current waveform file in “.arb” format in the internal memory (you can overwrite the original file or save the current waveform again). You can select the arbitrary waveforms in the internal or external memory for output. For details, refer to the introduction in **To Select Waveform**.
To Edit Waveform

Users can edit the waveform stored. Press **Edit** to enter the waveform editing menu.

1. **Interp**
   Press **Interp** to turn on or off the interpolation mode between the points of the waveform.
   - **ON**: the waveform editor connects two points using a straight line.
   - **OFF**: the waveform editor will keep a constant voltage level between the two points and create a ladder-like waveform.

2. **Zoom**
   Press **Zoom** to turn on or off the zoom function.
   - **ON**: the waveform editing window only displays the current point.
   - **OFF**: the waveform editing window displays all the initial points.

3. **Current Point**
   Press **CurPoint** and use ← or the navigation knob to select the point to be edited. The range is from 1 to the initial points.

4. **Voltage**
   Press **Voltage** to set the voltage of the current point. The range is from -2.5 V to +2.5 V.

5. **Time**
   Press **Time** to set the duration of the current point. This setting is limited by the times of the previous point and following point. The time of point 1 is fixed at 0 s.

6. **Insert**
   Press **Insert** to insert a new waveform point between the current point and the next point.

7. **Delete**
   Press **Delete** to delete the current point from the waveform and connect the remaining points using the current interpolation mode. Note that point 1 can not be deleted.
8. **Done**
   Press **Done** to finish editing the current waveform.

9. **Save**
   Press **Save** to enter the file store interface. Please refer to the introduction in **Store and Recall** to save the current waveform file in “.arb” format in the internal memory (you can overwrite the original file or save the current waveform again). You can select the arbitrary waveforms in the internal or external memory for output. For details, refer to the introduction in **To Select Waveform**.
Modulation

The built-in signal generator of DS2000A series oscilloscope supports amplitude modulation (AM) and frequency modulation (FM). The modulated waveform consists of the carrier waveform and modulating waveform. The carrier waveform is the waveform output from the signal generator and the modulating signal can be the built-in sine, square, ramp waveform or noise signal. Press Modulation to open the modulation setting menu. You can turn on or off the modulation function and set the modulation parameters.

1. Select the modulation type

Press Mod. Type to set the modulation type of the current signal.

- AM: the amplitude of the carrier waveform changes with the amplitude of the modulating waveform. After selecting AM, you can set the AM frequency and AM depth of the modulating waveform.

![Modulation Diagram](image)

Figure 12-9 AM

AM Frequency: press AM_Freq to set the frequency of the modulating waveform. The range is from 1 Hz to 50kHz. For the setting method, please refer to the introduction in Parameter Setting Method.

AM Depth: the modulation depth refers to the strength of the AM and is expressed in percentage. Press AM_Depth to set the modulation depth of the modulating waveform. The range is from 0% to 120%. When it is set to
0%, the output amplitude is half of the carrier amplitude. When it is set to 100%, the output amplitude equals the carrier amplitude. When it is set to a value greater than 100%, envelop distortion will occur which must be avoided in actual circuit; at this point, the output of the instrument will not exceed 5 Vpp (the load is 50 Ω).

- FM: the frequency of the carrier waveform changes with that of the modulating waveform. After selecting FM, you can set the FM frequency and frequency deviation of the modulating waveform.

![Diagram of FM modulation](Figure 12-10 FM)

**FM Frequency**: press **FM** to set the frequency of the modulating waveform. The range is from 1 Hz to 50 kHz. For the setting method, please refer to the introduction in [Parameter Setting Method](#).

**Frequency Deviation**: press **Deviation** to set the deviation of the frequency of the modulating waveform relative to the carrier frequency. The range is from 0 Hz to the current carrier frequency.

2. **Select modulating waveform**
   Press **Shape** to select sine, square, ramp waveform or noise as the modulating waveform.
13 Store and Recall

Users can save the current settings, waveforms, and screen image of the oscilloscope in internal memory or external USB mass storage device (such as USB storage device) in various formats and recall the stored settings or waveforms when needed.

The contents of this chapter:

- Storage System
- Storage Type
- Internal Storage and Recall
- External Storage and Recall
- Disk Management
- Factory
Storage System

Press **Storage** to enter the store and recall setting interface.

This oscilloscope provides a USB Host interface at the front panel to connect USB storage device for external storage. The USB storage device connected is marked as “Disk D”. The internal memory (Local Disk) of the instrument can store 10 setting files, 10 reference waveform files and 10 mask files of the Pass/Fail test. Below is the disk management interface.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size(B)</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local Disk</td>
<td>64.0k</td>
<td>960.0M</td>
</tr>
<tr>
<td>Disk D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 13-1 Disk Management Interface**

Table 13-1 Probable Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Return to the previous disk management interface</td>
<td><img src="image2" alt="Icon" /></td>
<td>Waveform File</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Local Disk Memory</td>
<td><img src="image4" alt="Icon" /></td>
<td>J PEG File</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>External USB Storage Device</td>
<td><img src="image6" alt="Icon" /></td>
<td>Pass/Fail Mask File</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Folder</td>
<td><img src="image8" alt="Icon" /></td>
<td>PNG File</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Return to the previous folder.</td>
<td><img src="image10" alt="Icon" /></td>
<td>Waveform Record File</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>Unknown File</td>
<td><img src="image12" alt="Icon" /></td>
<td>Reference Waveform File</td>
</tr>
<tr>
<td><img src="image13" alt="Icon" /></td>
<td>Bitmap File</td>
<td><img src="image14" alt="Icon" /></td>
<td>Setting File</td>
</tr>
<tr>
<td><img src="image15" alt="Icon" /></td>
<td>CSV File</td>
<td><img src="image16" alt="Icon" /></td>
<td>Trace File</td>
</tr>
<tr>
<td><img src="image17" alt="Icon" /></td>
<td>ARB File</td>
<td><img src="image18" alt="Icon" /></td>
<td>--</td>
</tr>
</tbody>
</table>

--
Storage Type

Press [Storage] \(\rightarrow\) [Storage] to select the desired storage type. The default is “Picture”. The storage and recall descriptions of each type are as follows.

1. Traces
   Save the waveform data in external memory in “*.trc” format. The data of all the channels turned on can be saved in the same file. At recall, the data will be displayed on the screen directly.

2. Waveforms
   Save the waveform data in external memory in “*.wfm” format. The stored files contain the waveform data of the two analog channels and the main setting information of the oscilloscope and all the data can be recalled.

3. Setups
   Save the settings of the oscilloscope in internal or external memory in “*.stp” format. At most 10 setting files (from LocalSetup0.stp to LocalSetup9.stp) can be stored in internal memory. The stored settings can be recalled.

4. Picture
   Save the screen image in external memory in “*.bmp”, “*.png”, “*.jpeg” or “*.tiff” format. You can specify the file name and saving directory and save the corresponding parameter file (*.txt) under the same directory using the same file name. The recall of image and parameter files is not supported.
   After selecting this type:
   Press [Pic Type] to select the desired storage format.
   Press [Para.Save] to enable or disable the parameter save function.
   Press [Inverted] to enable or disable the invert function.
   Press [Color] to set the color of the image. It can be set to “GrayScale” or “Color”.
   Press [Header] to enable or disable the header function. When it is enabled, the header would display the instrument information, such as the model, date and time.
   Press [Footer] to enable or disable the footer function. When it is enabled, the footer would display the serial number of the instrument.
### Tips

After a USB storage device is connected, press 📧 at the front panel to quickly save the current screen image under the root directory of the USB storage device in “.png” format by default.

<table>
<thead>
<tr>
<th>5. <strong>CSV</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the waveform data displayed on the screen or of the specified channels in external memory in a single “<em>.csv” file. You can specify the file name and the saving directory and save the corresponding parameter file (</em>.txt) under the same directory using the same file name. The recall of CVS and parameter files is not supported.</td>
</tr>
</tbody>
</table>

After selecting this type:
- Press **DataDepth** to select “Displayed” or “Maximum”. After selecting “Maximum”, press **Channel** to select the desired channel (note that only channels currently enabled can be selected).
- Press **Para.Save** to enable or disable the parameter save function.
Internal Storage and Recall

Internal storage and recall support “Setups” in Storage. In the following part, the storage and recall method and procedures are introduced.

1. **Save the specified oscilloscope setting in internal memory.**
   1) Connect the signal to the oscilloscope and obtain stable display.
   2) Press [Storage] → [Storage] to select “Setups” and press [Save] to turn on the disk management interface. Use \(\downarrow\) to select “Local Disk” (the characters turn green) and press down \(\downarrow\) to open the local disk, as shown in Figure 13-2.
   3) The local disk can store at most 10 setting files. Use \(\uparrow\) to select the desired storage position, [Save] is illuminated and then press the softkey to execute the saving operation. If the current position contains a file, the original file can be overwritten or be deleted by pressing [Delete]. Use \(\downarrow\) to select \(\uparrow\) and then press down \(\downarrow\) to return to the previous directory.

![Figure 13-2 Local Disk (Save)](image)

Note: in internal storage, **New File** and **New Folder** are not available.
2. **Load the specified type of file in internal memory.**
   1) Press `[Storage] → Storage` to select “Setups” and then press `Load` to turn on the disk management interface. Use ↑ to select “Local Disk” and then press down ↓ to open the local disk, as shown in Figure 13-3.
   2) Use ↑ to select the desired file to load and press `Load` to load the file selected.

![Figure 13-3 Local Disk (Recall)](image_url)

<table>
<thead>
<tr>
<th>Name</th>
<th>Size/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>LocalSetup1.txt</td>
<td>2.43k 2012-3-17 17:06</td>
</tr>
<tr>
<td>LocalSetup2.txt</td>
<td>2.42k 2012-2-20 17:06</td>
</tr>
<tr>
<td>LocalSetup3.txt</td>
<td>2.43k 2012-3-13 13:01</td>
</tr>
</tbody>
</table>

Figure 13-3 Local Disk (Recall)
External Storage and Recall

Before using external storage and recall, make sure that the USB storage device is connected correctly. External storage supports all the types of files in Storage but in recall, “Picture” and “CSV” are not supported.

1. **Save the specified type of file in the external USB storage device.**
   1) Connect the signal to the oscilloscope and obtain stable display.
   2) Press `Storage → Storage` to select “CSV” and press `Save` to turn on the disk management interface. Use  to select “Disk D” and press down  to open the USB storage device, as shown in Figure 13-4.
   3) Use  to select the desired storage position. The file can be stored under the root directory or in a certain folder under the root directory of the USB storage device.

   ![Figure 13-4 External Disk (Selecting Storage Position)](image)

4) After the storage position is selected, press `New File` to turn on the interface as shown in Figure 13-5. Refer to the descriptions in **To Create a New File or Folder** to create a new file.
5) Press **OK** to execute the saving operation.

2. **Load the specified type of file in the external USB storage device.**
   1) Press **Storage** → **Storage** to select “Traces” and then press **Load** to turn on the disk management interface. Use **↓** to select “Disk D” and press down **↓** to open the USB storage device, as shown in Figure 13-6.
   2) Use **↓** to select the desired file to load and then press **Load** to load the selected file.

![Figure 13-5 External Disk (Creating New File)](image1)

![Figure 13-6 External Disk (Selecting File to be Recalled)](image2)
Disk Management

Press **Storage** \( \rightarrow \) **Disk.Manage** to turn on the disk management interface as shown in Figure 13-1 and use \( \downarrow \) to select the desired disk. The disk currently selected is displayed in green and press down \( \uparrow \) to open the disk selected.

Execute the following operations through the disk management menu:

- **To Select File Type**
- **To Create a New File or Folder**
- **To Delete a File or Folder**
- **To Rename a File or Folder**
- **To Clear the Local Memory**
To Select File Type

Except the file types in **Storage**, the oscilloscope can also display, save or read some files for advanced applications such as mask file of the Pass/Fail test (*.pf), waveform record file (*.rec), upgrade file (.rgl), parameter file (*.txt) and reference waveform file (*.ref).

Press **Storage** → **Disk.Manage** → **File Type** to select the desired file type. The default is “*.*”. Under the current directory, only files of which the suffix of the file name matches with the file type selected will be displayed in the current disk.
To Create a New File or Folder

This operation is only valid in external storage. Before using external disk, make sure that the USB storage device is connected correctly. First, press \textbf{Storage} \rightarrow \textbf{Disk.Manage} and use \textarrow{ } to select and open the external disk (“Disk D”). Then, select the desired file type and select the desired directory under which to create a new file or folder. The default is the root directory of the USB storage device.

Then, press \textbf{New File} or \textbf{New Folder} to turn on the interface as shown in the figure below.

![Figure 13-7 To Create a New File or Folder](image)

This oscilloscope supports Chinese/English input method. The file name or folder name can contain letters, numbers, underscores, spaces and Chinese characters and the length of the characters is limited to 31 bytes. The following part introduces how to input a file name or folder name using Chinese/English input method.

\begin{mdframed}[framecmd={\textcolor{red}{\textbf{Operation Tip}}},roundcorner=5pt]
During the name input, use the menu softkeys to select different operation areas, then turn \textarrow{ } to select the desired content and press down \textarrow{ } to input the content selected.
\end{mdframed}
# English Input Method

For example, create a file or folder with the name “Filename”.

1. Press **Keyboard**.
   1) Use \( \rightarrow \) to select English input method “En” and uppercase input state “Aa”.
   2) Use \( \rightarrow \) to input the letter “F”. If the input is wrong, press **Delete** to delete the character input.
   3) Use \( \rightarrow \) to select lowercase input state “Aa”.
   4) Use \( \rightarrow \) to input the remaining letters “ilename”.

![Figure 13-8 English Input Example](image)

2. During the name input, you can press **Name** to select the “Name Input Area” and use \( \rightarrow \) to move the cursor, then press **Delete** to delete the characters one by one.

3. After finishing the input, press **OK** and the oscilloscope will create a folder or a specified type of file with this name under the current directory.
Chinese Input Method

For example, create a file or folder with the name “文件名”.

1. Press Keyboard.
   1) Use 📝 to select Chinese input method “中”. Note that Chinese is added in the menu items at the right of the screen.
   2) Use 📝 to input the pinyin “wen”. If the input is wrong, press Delete to delete the pinyin input. After “wen” is input, a series of Chinese characters appear in the “Chinese Character Selecting Area”.
   3) Press Chinese and use 📝 to select and input “文”.
   4) Use the same method to input “件” and “名”.

2. During the name input, you can press Name to select the “Name Input Area” and then press Delete to delete the Chinese characters one by one.

3. After finishing the input, press OK and the oscilloscope will create a folder or a specified type of file with this name under the current directory.
To Delete a File or Folder

Folder operation is valid only in external storage. Before using the external disk, make sure that the USB storage device is connected correctly.

1. Delete a file in internal memory.
   1) Press Storage → Disk.Manage and use ↕ to select and open the local disk (“local Disk”).
   2) Press File Type to select the desired type of file to delete (note that the file types of internal storage include “*.stp”, “*.ref”, “*.pf” and “*.arb”).
   3) Use ↕ to select the desired file to delete.
   4) Press Delete → OK to delete the file selected.

2. Delete a file or folder in external memory.
   Press Storage → Disk.Manage and use ↕ to select and open the external disk (“Disk D”). Use ↕ to select the file (or folder) to be deleted and then press Delete → OK to delete the selected file (or folder).
To Rename a File or Folder

Rename operation is valid only in external storage. Before using the external disk, make sure that the USB storage device is connected correctly.

Press Storage → Disk.Manage and use ← to select and open the external disk (“Disk D”). Use ← to select the desired file or folder to rename and then press Rename to turn on the rename interface. For specific operations, please refer to the descriptions in To Create a New File or Folder.

To Clear the Local Memory

Press Storage → Disk.Manage and select “Local Disk”, then turn to the next menu page and press SecurityClear → OK to delete all the files stored in the local memory. At the same time, the instrument will be restored to the default setting.
Factory

Press Storage → Default to return the oscilloscope to its factory state (refer to the table below).

Table 13-2 Factory

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Factory</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal Setting (HORIZONTAL)</strong></td>
<td></td>
</tr>
<tr>
<td>Vertical Setting (VERTICAL)</td>
<td></td>
</tr>
<tr>
<td>Acquisition Setting (Acquire)</td>
<td></td>
</tr>
<tr>
<td>Trigger Setting (TRIGGER)</td>
<td></td>
</tr>
<tr>
<td>Display Setting (Display)</td>
<td></td>
</tr>
<tr>
<td>Signal Source (Source)</td>
<td></td>
</tr>
<tr>
<td>Cursor Setting (Cursor)</td>
<td></td>
</tr>
<tr>
<td>Storage Setting (Storage)</td>
<td></td>
</tr>
<tr>
<td>Utility Function Setting (Utility)</td>
<td></td>
</tr>
<tr>
<td>Math Operation Setting (MATH-&gt;Operation)</td>
<td></td>
</tr>
<tr>
<td>Protocol Decoding (Decode 1, Decode 2)</td>
<td></td>
</tr>
<tr>
<td>Reference Waveform Setting (REF)</td>
<td></td>
</tr>
<tr>
<td><strong>Horizontal Setting (HORIZONTAL)</strong></td>
<td>Factory</td>
</tr>
<tr>
<td>Horizontal Time Base</td>
<td>1 μs</td>
</tr>
<tr>
<td>Horizontal Offset</td>
<td>0 s</td>
</tr>
<tr>
<td>Delayed Sweep</td>
<td>OFF</td>
</tr>
<tr>
<td>Time Base Type</td>
<td>Y-T</td>
</tr>
<tr>
<td>Time Base Scale</td>
<td>Coarse</td>
</tr>
<tr>
<td>Horizontal Reference</td>
<td>The Center of the Screen</td>
</tr>
<tr>
<td><strong>Vertical Setting (VERTICAL)</strong></td>
<td></td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>1 V</td>
</tr>
<tr>
<td>Vertical Offset</td>
<td>0 V</td>
</tr>
<tr>
<td>CH1 Switch</td>
<td>ON</td>
</tr>
<tr>
<td>CH2 Switch</td>
<td>ON</td>
</tr>
<tr>
<td>Channel Coupling</td>
<td>DC</td>
</tr>
<tr>
<td>Bandwidth Limit</td>
<td>OFF</td>
</tr>
<tr>
<td>Probe Ratio</td>
<td>1X</td>
</tr>
<tr>
<td><strong>Input</strong></td>
<td>1 MΩ</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Channel Invert</strong></td>
<td>OFF</td>
</tr>
<tr>
<td><strong>Amplitude Scale</strong></td>
<td>Coarse</td>
</tr>
<tr>
<td><strong>Channel Unit</strong></td>
<td>V</td>
</tr>
</tbody>
</table>

**Acquisition Setting (Acquire)**
- **Acquisition Mode**: Normal
- **Sampling Mode**: Real Time
- **Memory Depth**: Auto
- **Anti-Aliasing**: OFF

**Trigger Setting (TRIGGER)**
- **Trigger Type**: Edge
- **Source**: CH1
- **Slope**: Rising Edge
- **Trigger Mode**: Auto
- **Trigger Coupling**: DC
- **Trigger Holdoff**: 100 ns
- **Noise Reject**: OFF

**Display Setting (Display)**
- **Display Type**: Vectors
- **Persistence Time**: Min
- **Waveform Intensity**: 50%
- **Screen Grid**: [slider]
- **Brightness**: 50%
- **Menu Display**: Infinite

**Signal Source (Source)**
- **Source 1 Switch**: OFF
- **Source 2 Switch**: OFF
- **Status Display**: OFF
- **Source 1 Setup**
  - **Waveform**: Sine
  - **Channel Switch**: OFF
  - **Frequency**: 100 kHz
<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>1.000 V</td>
</tr>
<tr>
<td>Offset</td>
<td>0.00 V</td>
</tr>
<tr>
<td>Start Phase</td>
<td>0.0°</td>
</tr>
<tr>
<td>Modulation</td>
<td>OFF</td>
</tr>
<tr>
<td>Impedance</td>
<td>HighZ</td>
</tr>
</tbody>
</table>

**Source 2 Setup**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform</td>
<td>Sine</td>
</tr>
<tr>
<td>Channel Switch</td>
<td>OFF</td>
</tr>
<tr>
<td>Frequency</td>
<td>100 kHz</td>
</tr>
<tr>
<td>Amplitude</td>
<td>1.000 V</td>
</tr>
<tr>
<td>Offset</td>
<td>0.00 V</td>
</tr>
<tr>
<td>Start Phase</td>
<td>0.0°</td>
</tr>
<tr>
<td>Modulation</td>
<td>OFF</td>
</tr>
<tr>
<td>Impedance</td>
<td>HighZ</td>
</tr>
</tbody>
</table>

**Cursor Setting (Cursor)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>OFF</td>
</tr>
</tbody>
</table>

**Manual**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Mode</td>
<td>X-Y</td>
</tr>
<tr>
<td>Source</td>
<td>CH1</td>
</tr>
<tr>
<td>Time Unit</td>
<td>s</td>
</tr>
<tr>
<td>CurA</td>
<td>-4*1 μs</td>
</tr>
<tr>
<td>CurB</td>
<td>4*1 μs</td>
</tr>
</tbody>
</table>

**Track**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor A</td>
<td>CH1</td>
</tr>
<tr>
<td>Cursor B</td>
<td>CH1</td>
</tr>
<tr>
<td>CurA</td>
<td>-4*1 μs</td>
</tr>
<tr>
<td>CurB</td>
<td>4*1 μs</td>
</tr>
</tbody>
</table>

**Storage Setting (Storage)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Type</td>
<td>Picture</td>
</tr>
</tbody>
</table>

**Utility Function Setting (Utility)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound</td>
<td>OFF</td>
</tr>
</tbody>
</table>

**Pass/ Fail Test**
### 13 Store and Recall

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Test</td>
<td>OFF</td>
</tr>
<tr>
<td>Source</td>
<td>CH1</td>
</tr>
<tr>
<td>Operate</td>
<td>OFF</td>
</tr>
<tr>
<td>Mask Range</td>
<td>Screen Region</td>
</tr>
<tr>
<td>X Mask</td>
<td>0.24 div</td>
</tr>
<tr>
<td>Y Mask</td>
<td>0.48 div</td>
</tr>
<tr>
<td>Message Display</td>
<td>OFF</td>
</tr>
<tr>
<td>Stop On Output</td>
<td>OFF</td>
</tr>
<tr>
<td>Output</td>
<td>Fail</td>
</tr>
<tr>
<td>AuxOutput</td>
<td>OFF</td>
</tr>
</tbody>
</table>

#### Waveform Record

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>OFF</td>
</tr>
</tbody>
</table>

#### Record

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Frame</td>
<td>4064</td>
</tr>
<tr>
<td>Operate</td>
<td>OFF</td>
</tr>
<tr>
<td>Interval</td>
<td>100 ns</td>
</tr>
<tr>
<td>Total Frames</td>
<td>4064</td>
</tr>
</tbody>
</table>

#### Playback

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operate</td>
<td>OFF</td>
</tr>
<tr>
<td>Play Mode</td>
<td>Single</td>
</tr>
<tr>
<td>Interval</td>
<td>100 ns</td>
</tr>
<tr>
<td>Start Frame</td>
<td>1</td>
</tr>
<tr>
<td>Time Tag</td>
<td>OFF</td>
</tr>
</tbody>
</table>

#### Analyze

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Mode</td>
<td>Trace</td>
</tr>
<tr>
<td>Source</td>
<td>CH1</td>
</tr>
<tr>
<td>Trace Mode</td>
<td>Current Frame</td>
</tr>
<tr>
<td>Current Frame</td>
<td>1</td>
</tr>
<tr>
<td>Template Display</td>
<td>ON</td>
</tr>
<tr>
<td>Time Tag</td>
<td>OFF</td>
</tr>
</tbody>
</table>

#### System Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Expansion</td>
<td>Ground</td>
</tr>
<tr>
<td>Screen Saver</td>
<td>Default</td>
</tr>
<tr>
<td>Screen Saver Time</td>
<td>OFF</td>
</tr>
<tr>
<td>AuxOutput</td>
<td>TrigOut</td>
</tr>
<tr>
<td>Math Operation Setting (MATH-&gt;Operation)</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--</td>
</tr>
<tr>
<td>Operate</td>
<td>OFF</td>
</tr>
<tr>
<td><strong>A+B</strong></td>
<td></td>
</tr>
<tr>
<td>Source A</td>
<td>CH1</td>
</tr>
<tr>
<td>Source B</td>
<td>CH1</td>
</tr>
<tr>
<td>Invert</td>
<td>OFF</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>2 V</td>
</tr>
<tr>
<td><strong>A-B</strong></td>
<td></td>
</tr>
<tr>
<td>Source A</td>
<td>CH1</td>
</tr>
<tr>
<td>Source B</td>
<td>CH1</td>
</tr>
<tr>
<td>Invert</td>
<td>OFF</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>2 V</td>
</tr>
<tr>
<td><strong>A×B</strong></td>
<td></td>
</tr>
<tr>
<td>Source A</td>
<td>CH1</td>
</tr>
<tr>
<td>Source B</td>
<td>CH1</td>
</tr>
<tr>
<td>Vertical Invert</td>
<td>OFF</td>
</tr>
<tr>
<td>Scale</td>
<td>2 U</td>
</tr>
<tr>
<td><strong>A÷B</strong></td>
<td></td>
</tr>
<tr>
<td>Source A</td>
<td>CH1</td>
</tr>
<tr>
<td>Source B</td>
<td>CH1</td>
</tr>
<tr>
<td>Invert</td>
<td>OFF</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>2 U</td>
</tr>
<tr>
<td><strong>FFT</strong></td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>CH1</td>
</tr>
<tr>
<td>Window Function</td>
<td>Rectangle</td>
</tr>
<tr>
<td>Display</td>
<td>Split</td>
</tr>
<tr>
<td>Scale</td>
<td>dB</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>20 dB</td>
</tr>
<tr>
<td>Horizontal Scale</td>
<td>1.25 MHz/div</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>50 MSa/s</td>
</tr>
<tr>
<td><strong>Logic Operation</strong></td>
<td></td>
</tr>
<tr>
<td>Log.Formula</td>
<td>AND</td>
</tr>
<tr>
<td>Source A</td>
<td>CH1</td>
</tr>
<tr>
<td>Source B</td>
<td>CH1</td>
</tr>
<tr>
<td>Invert</td>
<td>OFF</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>1 U</td>
</tr>
</tbody>
</table>
### Thresholds
- **Threshold A**: 0 V
- **Threshold B**: 0 V

### Advanced Operation
- **Expression**: OFF
- **Expression**: CH1+CH2
- **Vertical Scale**: 2 V

### Protocol Decoding (Decode 1, Decode 2)
- **Decoding Type**: Parallel
- **BUS Status**: OFF
- **Format**: Hex
- **Offset**: 0
- **Threshold**: 0

#### Parallel
- **Clock Channel**: None
- **Slope**: Rising Edge
- **Bus Bits**: 1
- **Current Bit**: 0
- **Channel**: CH1

#### RS232
- **TX**: CH1
- **RX**: CH2
- **Polarity**: Normal
- **Endian**: LSB
- **Baud**: 9600 bps
- **Data Bits**: 8
- **Stop Bit**: 1
- **Even-Odd Check**: None
- **Packet**: OFF
- **Packet End**: 00 (NULL)

#### I2C
- **SCLK**: CH1
- **SDA**: CH2
- **Include R/W**: Close

#### SPI
- **SCLK Channel**: CH1
### SCLK Slope
- Rising Edge

### SDA Channel
- CH2

### SDA Polarity
- 1 for high level

### CAN
- **Source**: CH1
- **Signal Type**: CAN_H
- **Baud**: 500 kb/s
- **Sample Point**: 50.0%
- **Format**: Hex

### Reference Waveform Setting (REF)
- **Channel Setting**: Ref1
- **Current Channel**: Ref1
- **Source**: CH1
- **Color**: Gray
14 System Function Setting

The contents of this chapter:

- Remote Interface Configuration
- System-related
Remote Interface Configuration

DS2000A can communicate with PC via LAN, USB and GPIB (with the USB-GPIB interface converter provided by RIGOL) buses. Please refer to the introduction below to configure the corresponding interface before using the remote interfaces.

LAN Setting

Press Utility → IO Setting → LAN Set to turn on the LAN setting interface. You can view the network connection status and configure the network parameters.

Network Status

Connect the oscilloscope to your local area network using the network cable. The network hole of the oscilloscope is at the rear panel. The oscilloscope will give different prompts according to the current network connection status.

- Net Config Success!
- Acquire IP…
- IP Conflict!
- Unconnected!
- DHCP Fail!
14 System Function Setting

IP Configuration Type (DHCP)

The configuration type of the IP address can be DHCP, auto IP or static IP. In different IP configuration type, the configuration mode of the network parameters (such as the IP address) is different.

Press **Config Mode** and use to select “DHCP”. Then press down to select this type. When DHCP type is valid, the DHCP server in the current network will assign the network parameters (such as the IP address) for the oscilloscope.

IP Configuration Type (Auto IP)

Press **Config Mode** and use to select “Auto IP”. Then press down to select this type. When the auto IP type is valid, disable DHCP manually, **Gate** and **DNS** are added to the right side of the screen and users can define the gateway and DNS server address of the oscilloscope. In auto IP mode, the oscilloscope will get the IP address ranging from 169.254.0.1 to 169.254.255.254 and the subnet mask 255.255.0.0 automatically according to the current network configuration.

IP Configuration Type (Static IP)

Press **Config Mode** and use to select “Static IP”. Then press down to select this type. When this type is valid, disable DHCP and auto IP manually, **IP Address**, **Mask**, **Gate** and **DNS** are added to the right of the screen. At this point, users can define their own network parameters (such as the IP address) of the oscilloscope.

1. **Set the IP Address**  
   The format of IP address is nnn.nnn.nnn.nnn; wherein, the range of the first
nnn is from 0 to 223 (except 127) and the ranges of the other three nnn are from 0 to 255. You are recommended to ask your network administrator for an IP address available.

Press **IP Address** and use ← to input the desired IP address. This setting will be saved in the non-volatile memory and if **Power-off Recall** is set to “Last”, **DHCP** and **Auto IP** will be “Off” and the oscilloscope will load the preset IP address automatically at the next power-on.

2. **Set the Subnet Mask.**
   The format of the subnet mask is nnn.nnn.nnn.nnn; wherein, the range of the nnn is from 0 to 255. You are recommended to ask your network administrator for a subnet mask available.

   Press **Mask** and use ← to input the desired subnet mask. This setting will be saved in the non-volatile memory and if **Power-off Recall** is set to “Last”, **DHCP** and **Auto IP** will be “Off” and the oscilloscope will load the preset subnet mask automatically at the next power-on.

**Set the Gate**

You can set this parameter in **Auto IP** and **Static IP** mode. The format of the gate is nnn.nnn.nnn.nnn; wherein, the range of the first nnn is from 0 to 223 (except 127) and the ranges of the other three nnn are from 0 to 255. You are recommended to ask your network administrator for a gate address available.

Press **Gate** and use ← to input the desired gate address. This setting will be saved in the non-volatile memory and if **Power-off Recall** is set to “Last”, **DHCP** and **Auto IP** will be “Off” and the oscilloscope will load the preset gate address automatically at the next power-on.
Set the Domain Name Server

You can set this parameter in **Auto IP** and **Static IP** mode. The address format of the domain name server is nnn.nnn.nnn.nnn; wherein, the range of the first nnn is from 0 to 223 (except 127) and the ranges of the other three nnn are from 0 to 255. You are recommended to ask your network administrator for an address available.

Press **DNS** and use 🔄 to input the desired address. Generally, users do not need to set the DNS, therefore this parameter setting can be ignored.

<table>
<thead>
<tr>
<th>Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>● When the three IP configuration types are all turned on, the priority of the parameter configuration from high to low is “DHCP”, “Auto IP” and “Static IP”.</td>
</tr>
<tr>
<td>● The three IP configuration types can not be all turned off at the same time.</td>
</tr>
</tbody>
</table>

Apply the Network Parameter Setting

Press **Apply** to validate the current network parameter setting.

Initialize the Network Parameters

Press **Initialize** to return the network parameters to the default state.

MAC Address

For each oscilloscope, the MAC address is unique. When attributing IP address for the oscilloscope, the MAC address is usually used to identify the instrument.

VI SA Address

Display the VISA address currently used by the oscilloscope.
USB Device

This oscilloscope can communicate with PC or PictBridge printer via the **USB Device** interface at the rear panel. You need to set the oscilloscope to make it match with different device types.

Press **Utility** → **IO Setting** → **USB Device** and use ← to select the desired device type.

- **Computer**: in this type, the oscilloscope can communicate with the PC.
- **PictBridge**: in this type, the oscilloscope can communicate with the PictBridge printer.

**To Set the GPIB Address**

When using the GPIB mode to control the oscilloscope, you need to extend a GPIB interface for the oscilloscope using the USB-GPIB interface converter (need to be ordered separately).

To set the GPIB address of this interface, press **Utility** → **IO Setting** → **GPIB** and use ← to input the desired address. The default is 1 and the range is from 1 to 30.
System-related

Sound

When the sound is enabled, you can hear the sound of the beeper when you press a function key or a menu softkey or when the prompt message pops up.

Press **Utility → Sound** to select [on] (on) or [off] (off). The default is off. When the sound is turned on, a trumpet icon ![trumpet icon] will be displayed at the lower right corner of the screen.

Language

This oscilloscope supports multiple language menus, Chinese/English help and prompt messages.

Press **Utility → Language** and use ![language selection] to select the desired language. Then press down ![language selection] to select the language.

System Information

Press **Utility → System → System Info** to view the version information of your oscilloscope. The system information contains the following contents as shown in the figure below.

![System Information Interface](image)

Figure 14-2 System Information Interface
Power-off Recall

You can set the system configuration to be recalled when the oscilloscope is powered on again after power-off.

Press **Utility → System → Power On** to select “Last” or “Default”.
- Last: return to the setting of the system at last power-off.
- Default: return to the factory setting of the system.

System Time

The system time is displayed at the lower right corner of the screen in “hh:mm (hour:minute)” format. When printing or storing a waveform, the file output will contain this time information.

Press **Utility → System → System Time → System Time** to turn on the setting interface as follows.

![System Time Setting Interface](image)

In the figure, the item in green (such as 2013) is the item that can be modified currently. Use ← to modify and press down ↓ to complete the input. The order of time modifications is: year (2013) → month (04) → date (13) → hour (10) → minute (20) → second (29). The setting range of each item conforms to the convention:
- Year: 2011 to 2099
- Month: 01-12
- Date: 01-31 (28, 29 or 30)
• Hour: 00 to 23
• Minute: 00 to 59
• Second: 00 to 59

Press **Apply** to put the current setting into effect. The time at the lower right corner of the screen will be updated.

**Screen**

When the oscilloscope enters the idle state and holds for a certain period of time, the screen saver program will be enabled.

Press **Utility** → **System** → **Screen** to open the screen saver setting menu. “Default” means using the icon **RIGOL** as the screen saver icon.

Press **Time** to select the screen saver time. When “OFF” is selected, the screen saver program is disabled. The screen saver time can be set to 1 min, 2 min, 5 min, 15 min, 30 min, 45 min, 60 min, 2 hour or 5 hour.
Self-calibration

The self-calibration program can quickly make the oscilloscope reach the best working state to get the most precise measurement values. You can perform self-calibration at any time especially when the change of the environment temperature is up to or more than 5 °C. Make sure that the oscilloscope has been warmed up or operated for more than 30 minutes before the self-calibration.

Disconnect all the input channel connections, and then press **Utility → Self-Cal** and the self-calibration interface as shown in the figure below is displayed.

![Self-calibration Interface](image)

Figure 14-4 Self-calibration Interface

Press **Start** and the oscilloscope will start to execute the self-calibration program. Press **Exit** to give up the self-calibration operation at any time and return to the previous menu.

Note: Most of the keys are disabled during the self-calibration.
Aux Output

Users can set the type of the signal output from the [Trigger Out] connector at the rear panel.

Press Utility → AuxOutput to select the desired output type.

1. TrigOut
   After this type is selected, the oscilloscope outputs a signal that can reflect the current capture rate of the oscilloscope at each trigger. Connect this signal to a waveform display device, measure the signal frequency and the measurement result equals the current acquisition rate.

2. PassFail
   After this type is selected, the oscilloscope will output a pulse signal when failed waveforms are detected. This signal can be connected to other control systems to conveniently view the test results. The oscilloscope will output a 3.3 V CMOS high level when no failed waveform is detected.
Option Management

This oscilloscope provides multiple options to fulfill your measurement requirements. Please contact your RIGOL sales representative or RIGOL technical support to order the corresponding options. You can view the options currently installed on the oscilloscope or activate the newly bought option serial number through this menu.

Press **Utility** → **Options** → **Installed** to view the options currently installed on the oscilloscope. Press **Setup** to enter the serial number activation operation menu.

- **Editor**: press this softkey to turn on the serial number input interface as shown in the figure below. Use \( \leftarrow \) to select the characters on the virtual keyboard and press down the knob to input the character.

![Figure 14-5 Option Serial Number Input Interface](image)

- **Backspace**: press this softkey to delete the characters in the “Serial Number Input Area” from the right to the left.
- **Clear**: press this softkey to clear all the characters in the “Serial Number Input Area”.
- **Apply**: press this softkey and the oscilloscope will activate the corresponding option using the serial number currently input.
15 Remote Control

The oscilloscope can be controlled remotely mainly through the following two methods.

**User-defined programming**
Users can program and control the oscilloscope by using the SCPI (Standard Commands for Programmable Instruments) commands. For more information about the commands and programming, refer to the *Programming Guide*.

**Use PC software provided by RIGOL or other manufacturers**
Users can use the PC software *Ultra Sigma* of RIGOL, *Measurement & Automation Explorer* of NI (National Instruments Corporation) or *Agilent IO Libraries Suite* of Agilent (Agilent Technologies, Inc.) to send commands to control the oscilloscope remotely.

This oscilloscope can communicate with PC through USB, LAN and GPIB (with the USB-GPIB interface converter provided by RIGOL) instrument buses. This chapter will give a detailed introduction of how to use *Ultra Sigma* to control DS2000A remotely through various interfaces. For the *Ultra Sigma* software, please contact RIGOL salesmen or technical support.

The contents of this chapter:

- Remote Control via USB
- Remote Control via LAN
- Remote Control via GPIB
Remote Control via USB

1. **Connect the device**
   Connect the oscilloscope (USB DEVICE) with your PC using a USB cable.

2. **Install the USB driver**
   This oscilloscope is a USBTMC device. Assuming that your PC has already been installed with **Ultra Sigma**, after you connect the oscilloscope to the PC and turn both on for the first time (the oscilloscope is automatically configured to USB interface), the **New Hardware Wizard** as shown in the figure below is displayed on the PC. Please install the “USB Test and Measurement Device” driver following the directions in the wizard. The steps are as follows.

![New Hardware Wizard](image)
15 Remote Control

RIGOL

3. **Search device resource**

Start up the **Ultra Sigma** and the software will automatically search for the oscilloscope resources currently connected to the PC. You can also click **USB-TMC** to search the resources. During the search, the status bar of the software is as shown in the figure below.
4. **View the device resource**

   The resources found will appear under the “RI GOL Online Resource” directory and the model number and USB interface information of the instrument will also be displayed as shown in the figure below.

   ![Figure 15-1 View the Device Resource under Control via USB](image)

5. **Communication test**

   Right click the resource name “DS2302A (USB0::0x1AB1::0x04B0::DS2A0000000023::INSTR)” to select “SCPI Panel Control” to turn on the remote command control panel (as shown in the figure below) through which you can send commands and read data.

   ![Figure 15-2 Communication test under Control via USB](image)
Remote Control via LAN

1. Connect the device
   Connect the oscilloscope to your LAN using a network cable.

2. Configure network parameters
   Configure the network parameters of the oscilloscope according to the
description in **LAN Setting**.

3. Search device resource
   1) Start the Ultra Sigma, click **LAN** and the window as shown below is
displayed.

   ![Image of Create LAN Instrument Resource window]

   2) Click **Search** to search for the instrument resources connected to the local
   network. The names of the instrument resources found will be displayed in
   the window at the right, as shown in the figure below.

   ![Image of Create LAN Instrument Resource window with search results]

   3) Select the desired resource name and click **OK**.


4. **View device resource**

   The resources found will appear under the “RIGOL Online Resource” directory as shown in the figure below.

   ![Image of device resource](image1)

   **Figure 15-3 View the Device Resource under Control via LAN**

5. **Communication test**

   Right click the resource name “DS2302A(TCPIP::172.16.3.113::INSTR)” to select “SCPI Panel Control” to turn on the remote command control panel (as shown in the figure below) through which you can send commands and read data.

   ![Image of communication test](image2)

   **Figure 15-4 Communication Test under Control via LAN**

6. **Load LXI webpage**

   As this oscilloscope conforms to LXI-C standards, you can load LXI webpage through **Ultra Sigma** (right-click the resource name and select LXI-Web; or directly input the IP address in the browser). Various important information
about the oscilloscope (including the model number, manufacturer, serial number, description, MAC address and IP address) will be displayed on the webpage as shown in the figure below.

![Figure 15-5 LXI Webpage](image)

©2011 RIGOL Technology, Inc. All Rights Reserved

Figure 15-5 LXI Webpage
Remote Control via GPIB

1. **Connect the device**
   Use the USB to GPIB interface converter to extend a GPIB interface for the oscilloscope. Then connect the oscilloscope to your PC using a GPIB cable.

2. **Install the driver of GPIB card**
   Install the driver of the GPIB card which has been connected to the PC correctly.

3. **Set the GPIB address**
   Set the GPIB address of the oscilloscope according to the description in *To Set the GPIB Address*.

4. **Search device resource**
   Start up the **Ultra Sigma** and click **GPIB** to open the panel as shown in the figure below. Click “Search” and the software will search the GPIB instrument resources connected to the PC. The device resources will be displayed on the right side of the panel.

![Figure 15-6 Search Device Resource under Control via GPIB](image)

**If resources can not be found automatically:**
- Select the GPIB card address of the PC from the comboBox of “GPIB::” and select the GPIB address set in the oscilloscope from the comboBox of “::INSTR”.
5. **View device resource**

Click “OK” to return back to the main interface of Ultra Sigma. The resources found will appear under the “RIGOL Online Resource” directory.

6. **Communication Test**

Right-click the resource name “DS2302A (GPIB0::1::INSTR)” to select “SCPI Panel Control” to turn on the remote command control panel through which you can send commands and read data as shown in the figure below.
16 Troubleshooting

The commonly encountered failures and their solutions are listed below. When you encounter those problems, please solve them following the corresponding steps. If the problem remains still, please contact RIGOL and provide your device information (Utility → System → System Info).

1. **The screen is still dark (no display) after power on:**
   1. Check whether the power is correctly connected.
   2. Check whether the power switch is really on.
   3. Check whether the fuse is burned out. If the fuse needs to be changed, please use the specified fuse.
   4. Restart the instrument after finishing the above inspections.
   5. If it still does not work correctly, please contact RIGOL.

2. **The signal is sampled but no waveform of the signal is displayed:**
   1. Check whether the probe is correctly connected to the oscilloscope and item to be tested.
   2. Check whether there are signals generated from the item to be tested (you can connect the probe compensation signal to the problematic channel to determine which has problem, the channel or the item to be tested).
   3. Resample the signal.

3. **The tested voltage amplitude is greater or lower than the actual value (note that this problem usually occurs when probe is used):**
   Check whether the attenuation coefficient of the channel complies with the attenuation ratio of the probe.

4. **There is waveform display but not stable:**
   1. Check the trigger signal source: check whether the Source item at the trigger panel complies with the signal channel actually used.
   2. Check the trigger type: general signals should use “Edge” trigger and video signal should use “Video” trigger. Only when the proper trigger type is used, can the waveform be displayed stably.
3. Check the trigger level: adjust the trigger level to the middle of the signal.
4. Change the trigger holdoff setting.

5. **No display after pressing** [RUN/STOP]:
   Check whether the [MODE] at the trigger panel (TRIGGER) is on “Normal” or “Single” and whether the trigger level exceeds the waveform range. If yes, set the trigger level to the middle or set the [MODE] to “Auto”. Note: Using [AUTO] could automatically finish the above setting.

6. **The display of waveform is ladder-like:**
   1. The horizontal time base might be too low. Increase the horizontal time base to increase the horizontal resolution and improve the display.
   2. If the display [Type] is “Vectors”, the lines between the sample points may cause ladder-like display. Set [Type] to “Dots” to solve the problem.

7. **Fail to connect PC or PictBridge printer through USB:**
   1. Check the [IO Setting] in [Utility] to make sure whether the setting in [USB Device] matches the device currently connected.
   2. Check whether the USB cable is correctly connected to the oscilloscope.
   3. Check whether the USB cable is in good condition. If needed, restart the oscilloscope.

8. **The USB storage device can not be recognized:**
   1. Check whether the USB storage device can work normally.
   2. Make sure that the USB storage device being used is flash storage type. This oscilloscope does not support hardware storage type.
   3. Make sure whether the capacity of the USB storage device is too large. It is recommended that the capacity of the USB storage device being used with this oscilloscope is no larger than 8 GBytes.
   4. Restart the instrument and then insert the USB storage device to check it.
   5. If the USB storage device still can not be used normally, please contact RIGOL.
17 Specifications

All the specifications are guaranteed except the parameters marked with “Typical” and the oscilloscope needs to operate for more than 30 minutes under the specified operation temperature.

**Sample**

<table>
<thead>
<tr>
<th>Sample Mode</th>
<th>Real-time Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time Sample</td>
<td>2 GSa/s (single-channel)</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>1 Gsa/s (dual-channel)</td>
</tr>
<tr>
<td>Peak Detect</td>
<td>500 ps (single-channel)</td>
</tr>
<tr>
<td></td>
<td>1 ns (dual-channel)</td>
</tr>
<tr>
<td>Averaging</td>
<td>After both the channels finish N samples at the same time, N can be 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024, 2048, 4096 or 8192.</td>
</tr>
<tr>
<td>High Resolution</td>
<td>12 bits of resolution when ≥5 μs/div @ 1 GSa/s (or ≥10 μs/div @ 500 MSA/s).</td>
</tr>
<tr>
<td>Memory Depth</td>
<td>single-channel: Auto, 14k pts, 140k pts, 1.4M pts, 14M pts and 56M pts (option) are available</td>
</tr>
<tr>
<td></td>
<td>dual-channel: Auto, 7k pts, 70k pts, 700k pts, 7M pts and 28M pts (option) are available</td>
</tr>
</tbody>
</table>

**Input**

<table>
<thead>
<tr>
<th>Number of Channels</th>
<th>Two channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Coupling</td>
<td>DC, AC or GND</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>(1 MΩ±1%)</td>
</tr>
<tr>
<td>Probe Attenuation</td>
<td>0.01X to 1000X, in 1-2-5 step</td>
</tr>
<tr>
<td>Maximum Input Voltage</td>
<td>Maximum Input Voltage of the Analog Channel</td>
</tr>
<tr>
<td></td>
<td>CAT I 300 Vrms, CAT II 100 Vrms,</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

### Horizontal

| Timebase Scale | DS2302A: 1 ns/div to 1.000 ks/div  
DS2202A: 2.000 ns/div to 1.000 ks/div  
DS2102A/DS2072A: 5.000 ns/div to 1.000 ks/div |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Timebase Accuracy</td>
<td>≤ ± 25 ppm</td>
</tr>
<tr>
<td>Clock Drift</td>
<td>≤ ± 5 ppm/year</td>
</tr>
</tbody>
</table>
| Max Delay Range | Pre-trigger (negative delay): ≥1 screen width  
Post-trigger (positive delay): 1 s to 100,000 s |
| Timebase Mode | Y-T, X-Y, Roll |
| Number of XYs | 1 |
| Waveform Capture Rate | 50,000 wfms/s (dots display) |

### Vertical

| Bandwidth (-3dB) | DS2302A: DC to 300 MHz  
DS2202A: DC to 200 MHz  
DS2102A: DC to 100 MHz  
DS2072A: DC to 70 MHz |
|------------------|--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| Single-shot Bandwidth | DS2302A: DC to 300 MHz  
DS2202A: DC to 200 MHz  
DS2102A: DC to 100 MHz  
DS2072A: DC to 70 MHz |
| Vertical Resolution | 8 bit |
| Vertical Scale | 500 μV/div to 1 V/div (50Ω)  
500 μV/div to 10 V/div (1MΩ) |
### Offset Range
- 500 μV/div to 50 mV/div: ± 2 V
- 51 mV/div to 200 mV/div: ± 10 V
- 205 mV/div to 2 V/div: ± 50 V
- 2.05 V/div to 10 V/div: ± 100 V

### Bandwidth Limit
- DS2302A/DS2202A: 20 MHz/100 MHz
- DS2102A/DS2072A: 20 MHz

### Low Frequency Response (AC Coupling, -3dB)
≤5 Hz (on BNC)

### Calculated Rise Time
- DS2302A: 1.2 ns
- DS2202A: 1.8 ns
- DS2102A: 3.5 ns
- DS2072A: 5 ns

### DC Gain Accuracy
±2% full scale

### DC Offset Accuracy
±0.1 div ± 2 mV ± 1% offset value

### Channel to Channel Isolation
DC to maximum bandwidth: >40 dB

---

**Trigger**

<table>
<thead>
<tr>
<th>Trigger Level Range</th>
<th>Internal</th>
<th>± 5 div from center of the screen</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EXT</td>
<td>± 4 V</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger Mode</th>
<th>Auto, Normal, Single</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Holdoff Range</th>
<th>100 ns to 10 s</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>High Frequency Rejection(^1)</th>
<th>75 kHz</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Low Frequency Rejection(^1)</th>
<th>75 kHz</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Trigger Sensitivity</th>
<th>1 div (below 10 mV or noise rejection is enabled)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.3 div (above 10 mV and noise rejection is disabled)</td>
</tr>
</tbody>
</table>
### Edge Trigger

| Edge Type       | Rising, Falling, Rising/Falling |

### Pulse Trigger

<table>
<thead>
<tr>
<th>Pulse Condition</th>
<th>Positive Pulse Width (greater than, lower than, within specific interval)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Negative Pulse Width (greater than, lower than, within specific interval)</td>
</tr>
<tr>
<td>Pulse Width Range</td>
<td>2 ns to 4 s</td>
</tr>
</tbody>
</table>

### Runt Trigger

<table>
<thead>
<tr>
<th>Pulse Width Condition</th>
<th>None, &gt;, &lt;, &lt;&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Polarity</td>
<td>Positive, Negative</td>
</tr>
<tr>
<td>Pulse Width Range</td>
<td>2 ns to 4 s</td>
</tr>
</tbody>
</table>

### Windows Trigger (Option)

<table>
<thead>
<tr>
<th>Windows Type</th>
<th>Rising, Falling, Rising/Falling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Position</td>
<td>Enter, Exit, Time</td>
</tr>
<tr>
<td>Windows Time</td>
<td>16 ns to 4 s</td>
</tr>
</tbody>
</table>

### Nth Edge Trigger (Option)

<table>
<thead>
<tr>
<th>Edge Type</th>
<th>Rising, Falling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle Time</td>
<td>16 ns to 4 s</td>
</tr>
<tr>
<td>Edge Number</td>
<td>1 to 65535</td>
</tr>
</tbody>
</table>

### Slope Trigger

<table>
<thead>
<tr>
<th>Slope Condition</th>
<th>Positive Slope (greater than, lower than, within specific interval)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Negative Slope (greater than, lower than, within specific interval)</td>
</tr>
<tr>
<td>Time Setting</td>
<td>10 ns to 1 s</td>
</tr>
</tbody>
</table>

### Video Trigger (HDTV Option)

<table>
<thead>
<tr>
<th>Signal Standard</th>
<th>NTSC, PAL/SECAM, 480P, 576P (Standard)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>720P, 1080P and 1080I (Option)</td>
</tr>
</tbody>
</table>

### Pattern Trigger

| Pattern Setting | H, L, X, Rising, Falling |

### Delay Trigger (Option)
<table>
<thead>
<tr>
<th>Specifications</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edge Type</strong></td>
<td>Rising, Falling</td>
</tr>
<tr>
<td><strong>Delay Type</strong></td>
<td>&gt;, &lt;, &lt;&lt;, &gt;&gt;</td>
</tr>
<tr>
<td><strong>Delay Time</strong></td>
<td>2 ns to 4 s</td>
</tr>
<tr>
<td><strong>Timeout Trigger (Option)</strong></td>
<td></td>
</tr>
<tr>
<td>Edge Type</td>
<td>Rising, Falling, Rising/Falling</td>
</tr>
<tr>
<td>Timeout time</td>
<td>16 ns to 4 s</td>
</tr>
<tr>
<td><strong>Duration Trigger (Option)</strong></td>
<td></td>
</tr>
<tr>
<td>Pattern</td>
<td>H, L, X</td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>&gt;, &lt;, &lt;&gt;</td>
</tr>
<tr>
<td>Duration Time</td>
<td>2 ns to 4 s</td>
</tr>
<tr>
<td><strong>Setup/Hold Trigger</strong></td>
<td></td>
</tr>
<tr>
<td>Edge Type</td>
<td>Rising, Falling</td>
</tr>
<tr>
<td>Data Type</td>
<td>H, L</td>
</tr>
<tr>
<td>Setup Time</td>
<td>2 ns to 1 s</td>
</tr>
<tr>
<td>Hold Time</td>
<td>2 ns to 1 s</td>
</tr>
<tr>
<td><strong>RS232/UART Trigger</strong></td>
<td></td>
</tr>
<tr>
<td>Polarity</td>
<td>Normal, Invert</td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Start, Error, Check Error, Data</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>2400 bps, 4800 bps, 9600 bps, 19200 bps, 38400 bps, 57600 bps, 115200 bps, User</td>
</tr>
<tr>
<td>Data Bits</td>
<td>5 bit, 6 bit, 7 bit, 8 bit</td>
</tr>
<tr>
<td><strong>I2C Trigger</strong></td>
<td></td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Start, Restart, Stop, Missing ACK, Address, Data, A&amp;D</td>
</tr>
<tr>
<td>Address Bits</td>
<td>7 bit, 8 bit, 10 bit</td>
</tr>
<tr>
<td>Address Range</td>
<td>0 to 127, 0 to 255, 0 to 1023</td>
</tr>
<tr>
<td>Byte Length</td>
<td>1 to 5</td>
</tr>
<tr>
<td><strong>SPI Trigger</strong></td>
<td></td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>Timeout</td>
</tr>
<tr>
<td>Timeout Value</td>
<td>100 ns to 1 s</td>
</tr>
<tr>
<td>Data Bits</td>
<td>4 bit to 32 bit</td>
</tr>
<tr>
<td>Data Line</td>
<td>H, L, X</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th><strong>CAN Trigger (Option)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Type</td>
<td>Rx, Tx, CAN <em>H</em>, CAN <em>L</em>, Differential</td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>SOF, EOF, FrameType, FrameError</td>
</tr>
<tr>
<td>Signal Rate</td>
<td>10 kbps, 20 kbps, 33.3 kbps, 50 kbps, 62.5 kbps, 83.3 kbps, 100 kbps, 125 kbps, 250 kbps, 500 kbps, 800 kbps, 1 Mbps, User</td>
</tr>
<tr>
<td>Sample Points</td>
<td>5% to 95%</td>
</tr>
<tr>
<td>Frame Type</td>
<td>Data, Remote, Error, OverLoad</td>
</tr>
<tr>
<td>Error Type</td>
<td>Bit Fill, AnswerError, CheckError, FormatError, RandomError</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>USB Trigger (Option)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Speed</td>
<td>Low Speed, Full Speed</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>SOP, EOP, RC, Suspend, Exit Suspend</td>
</tr>
</tbody>
</table>

### Measure

<table>
<thead>
<tr>
<th><strong>Cursor</strong></th>
<th><strong>Manual Mode</strong></th>
<th>Voltage Deviation between Cursors ((\Delta V))</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Deviation between Cursors ((\Delta T))</td>
<td>Reciprocal of (\Delta T) (Hz) (1/(\Delta T))</td>
<td></td>
</tr>
<tr>
<td><strong>Track Mode</strong></td>
<td>Voltage and Time Values of the Waveform Point</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Mode</strong></td>
<td>Allow to display cursors during auto measurement</td>
<td></td>
</tr>
</tbody>
</table>

|**Auto Measurement**| Measurements of Maximum, Minimum, Peak-Peak Value, Top Value, Bottom Value, Amplitude, Average, Mean Square Root, Overshoot, Pre-shoot, Frequency, Period, Rise Time, Fall Time, Positive Pulse Width, Negative Pulse Width, Positive Duty Cycle, Negative Duty Cycle, Delay 1→2\(f\), Delay 1→2\(f\), Phase 1→2\(f\), Phase 1→2\(\pi\), Area, Period Area |

|**Number of Measurements**| Display 5 measurements at the same time. |

|**Measurement Range**| Screen or cursor. |

|**Measurement Statistic**| Average, Max, Min, Standard Deviation, Number of Measurements |
### Frequency Counter

| | Hardware 6 bits frequency counter (channels are selectable) |

### Math Operation

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT Window Function</td>
<td>Rectangle, Hanning, Blackman, Hamming</td>
</tr>
<tr>
<td>FFT Display</td>
<td>Split, Full Screen</td>
</tr>
<tr>
<td>FFT Vertical Scale</td>
<td>Vrms, dB</td>
</tr>
<tr>
<td>Logic Operation</td>
<td>AND, OR, NOT, XOR</td>
</tr>
<tr>
<td>Math Function</td>
<td>Intg, Diff, Log, Exp, Sqrt, Sine, Cosine, Tangent</td>
</tr>
<tr>
<td>Number of Buses for Decoding</td>
<td>2</td>
</tr>
<tr>
<td>Decoding Type</td>
<td>Parallel (standard), RS232/UART (option), I2C (option), SPI (option), CAN (option)</td>
</tr>
</tbody>
</table>

### Display

<table>
<thead>
<tr>
<th></th>
<th>8.0 inches (203 mm) TFT LCD display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Resolution</td>
<td>800 Horizontal ×RGB×480 Vertical Pixel</td>
</tr>
<tr>
<td>Display Color</td>
<td>160,000 Color (TFT)</td>
</tr>
<tr>
<td>Persistence Time</td>
<td>Min, 50ms, 100ms, 200ms, 500ms, 1 s, 2 s, 5 s, 10 s, 20 s, Infinite</td>
</tr>
<tr>
<td>Display Type</td>
<td>Dots, Vectors</td>
</tr>
<tr>
<td>Real-time Clock</td>
<td>Time and Date (user adjustable)</td>
</tr>
</tbody>
</table>
## Signal Source (DS2000A-S)

<table>
<thead>
<tr>
<th>Channels</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>200 MSa/s</td>
</tr>
<tr>
<td>Vertical Resolution</td>
<td>14 bits</td>
</tr>
<tr>
<td>Max. Frequency</td>
<td>25 MHz</td>
</tr>
<tr>
<td>Standard Waveform</td>
<td>Sine, Square, Pulse, Ramp, Noise, DC</td>
</tr>
<tr>
<td>Built-in Waveform</td>
<td>Sinc, Exponential Rise, Exponential Fall, ECG, Gauss, Lorentz, Haversine</td>
</tr>
<tr>
<td>Sine</td>
<td></td>
</tr>
<tr>
<td>Frequency Range</td>
<td>0.1 Hz to 1 MHz</td>
</tr>
<tr>
<td>Flatness</td>
<td>±0.5 dB (relative to 1 kHz)</td>
</tr>
<tr>
<td>Harmonic Distortion</td>
<td>-40 dBC</td>
</tr>
<tr>
<td>Stray (Non-harmonic)</td>
<td>-40 dBC</td>
</tr>
<tr>
<td>Total Harmonic Distortion</td>
<td>1%</td>
</tr>
<tr>
<td>S/N Ratio</td>
<td>40 dB</td>
</tr>
<tr>
<td>Square/Pulse</td>
<td></td>
</tr>
</tbody>
</table>
| Frequency Range | Square: 0.1 Hz to 15 MHz  
| | Pulse: 0.1 Hz to 1 MHz |
| Rise/Fall Time | <15 ns |
| Overshoot | <5% |
| Duty Cycle | Square: 50%  
| | Pulse: 10% to 90% (user adjustable) |
| Duty Cycle Resolution | 1% or 10 ns (the larger of the two) |
| Min. Pulse Width | 20 ns |
| Pulse Width Resolution | 10 ns or 5 bits (the larger of the two) |
| Jitter | 500 ps |
| Ramp | | 
| Frequency Range | 0.1 Hz to 100 kHz |
| Linearity | 1% |
| Symmetry | 0 to 100% |
| Noise | | 
| Bandwidth | 25 MHz (typical) |
### Built-in Waveform

<table>
<thead>
<tr>
<th>Frequency Range</th>
<th>0.1 Hz to 1 MHz</th>
</tr>
</thead>
</table>

### Arbitrary Waveform

<table>
<thead>
<tr>
<th>Frequency Range</th>
<th>0.1 Hz to 10 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform Length</td>
<td>2 to 16 k points</td>
</tr>
<tr>
<td>Internal Storage Location</td>
<td>10</td>
</tr>
</tbody>
</table>

### Frequency

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>100 ppm (lower than 10 kHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>0.1 Hz or 4 bits, the larger of the two</td>
</tr>
<tr>
<td>Resolution</td>
<td>50 ppm (higher than 10 kHz)</td>
</tr>
</tbody>
</table>

### Amplitude

<table>
<thead>
<tr>
<th>Output Range</th>
<th>20 mVpp to 5 Vpp, HighZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>100 µV or 3 bits, the larger of the two</td>
</tr>
<tr>
<td>Accuracy</td>
<td>2% (1 kHz)</td>
</tr>
<tr>
<td>Resolution</td>
<td>10 mVpp to 2.5 Vpp, 50 Ω</td>
</tr>
<tr>
<td>Resolution</td>
<td>100 µV or 3 bits, the larger of the two</td>
</tr>
<tr>
<td>Accuracy</td>
<td>100 µV or 3 bits, the larger of the two</td>
</tr>
</tbody>
</table>

### DC Offset

<table>
<thead>
<tr>
<th>Range</th>
<th>±2.5 V, HighZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>±1.25 V, 50 Ω</td>
</tr>
<tr>
<td>Resolution</td>
<td>100 µV or 3 bits, the larger of the two</td>
</tr>
<tr>
<td>Accuracy</td>
<td>Offset setting Value ± 2%</td>
</tr>
</tbody>
</table>

### I/O

<table>
<thead>
<tr>
<th>Standard Ports</th>
<th>USB HOST (support USB-GPIB), USB DEVICE, LAN, Aux Output (TrigOut/PassFail)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Compatibility</td>
<td>PictBridge</td>
</tr>
</tbody>
</table>

---

**General Specifications**

**Probe Compensation Output**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Voltage(^1)</td>
<td>About 3 V, peak-peak</td>
</tr>
<tr>
<td>Frequency(^1)</td>
<td>1 kHz</td>
</tr>
</tbody>
</table>

**Power**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Voltage</td>
<td>100 to 240 V, 45 to 440 Hz</td>
</tr>
<tr>
<td>Power</td>
<td>Maximum 50 W</td>
</tr>
<tr>
<td>Fuse</td>
<td>2 A, T Degree, 250 V</td>
</tr>
</tbody>
</table>

**Environment**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Range</td>
<td>Operating: 0 °C to +50 °C</td>
</tr>
<tr>
<td></td>
<td>Non-operating: -40 °C to +70 °C</td>
</tr>
<tr>
<td>Cooling Method</td>
<td>Fan cooling</td>
</tr>
<tr>
<td>Humidity Range</td>
<td>0°C to +30°C: ≤95% Relative Humidity</td>
</tr>
<tr>
<td></td>
<td>+30°C to +40°C: ≤75% Relative Humidity</td>
</tr>
<tr>
<td></td>
<td>+40°C to +50°C: ≤45% Relative Humidity</td>
</tr>
<tr>
<td>Altitude</td>
<td>Operating: under 3,000 meters</td>
</tr>
<tr>
<td></td>
<td>Non-operating: under 15,000 meters</td>
</tr>
</tbody>
</table>

**Physical Characteristics**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size(^3)</td>
<td>Width×Height×Depth = 361.6 mm×179.6 mm×130.8 mm</td>
</tr>
<tr>
<td>Weight(^4)</td>
<td>Package Excluded: 3.9 kg ± 0.2 kg</td>
</tr>
<tr>
<td></td>
<td>Package Included: 4.5 kg ± 0.5 kg</td>
</tr>
</tbody>
</table>

**Calibration Interval**

The recommended calibration interval is one year.

**Regulatory Information**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electromagnetic Compatibility</td>
<td>2004/108/EC</td>
</tr>
<tr>
<td></td>
<td>Execution standard EN 61326-1:2006 EN 61326-2-1:2006</td>
</tr>
</tbody>
</table>

1 Typical.  
2 Maximum value. 20ns, single-channel mode, dots display, auto memory depth.  
3 Supporting legs and handle folded, knob height included.  
4 Standard configuration.
# Appendix A: Accessories and Options

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS2302A</td>
<td>300 MHz, dual-channel oscilloscope</td>
<td>DS2302A</td>
</tr>
<tr>
<td>DS2302A-S</td>
<td>300MHz, dual-channel oscilloscope+25MHz, dual-channel signal generator</td>
<td>DS2302A-S</td>
</tr>
<tr>
<td>DS2202A</td>
<td>200 MHz, dual-channel oscilloscope</td>
<td>DS2202A</td>
</tr>
<tr>
<td>DS2202A-S</td>
<td>200MHz, dual-channel oscilloscope+25MHz, dual-channel signal generator</td>
<td>DS2202A-S</td>
</tr>
<tr>
<td>DS2102A</td>
<td>100 MHz, dual-channel oscilloscope</td>
<td>DS2102A</td>
</tr>
<tr>
<td>DS2102A-S</td>
<td>100MHz, dual-channel oscilloscope+25MHz, dual-channel signal generator</td>
<td>DS2102A-S</td>
</tr>
<tr>
<td>DS2072A</td>
<td>70 MHz, dual-channel oscilloscope</td>
<td>DS2072A</td>
</tr>
<tr>
<td>DS2072A-S</td>
<td>70MHz, dual-channel oscilloscope+25MHz, dual-channel signal generator</td>
<td>DS2072A-S</td>
</tr>
</tbody>
</table>

### Accessories

<table>
<thead>
<tr>
<th>Description</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Cord conforming to the standard of the country</td>
<td>-</td>
</tr>
<tr>
<td>USB Cable</td>
<td>CB-USBA-USBB-FF-150</td>
</tr>
<tr>
<td>2 Passive Probes (350 MHz)</td>
<td>RP3300A</td>
</tr>
<tr>
<td>Quick Guide</td>
<td>-</td>
</tr>
<tr>
<td>Resource CD (include User’s Guide and application software)</td>
<td>-</td>
</tr>
</tbody>
</table>

### Optional Accessories

<table>
<thead>
<tr>
<th>Description</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passive Probe (500 MHz)</td>
<td>RP3500A</td>
</tr>
<tr>
<td>Rack Mount Kit</td>
<td>RM-DS-2000A</td>
</tr>
</tbody>
</table>

### Option

<table>
<thead>
<tr>
<th>Description</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Depth Options 56Mpts (single channel)/ 28Mpts (dual-channel)</td>
<td>MEM-DS2000A</td>
</tr>
<tr>
<td>Advanced Trigger Options Windows trigger, Nth edge trigger, HDTV trigger, delay trigger, timeout trigger, duration trigger, USB trigger</td>
<td>AT-DS2000A</td>
</tr>
<tr>
<td>Decoding Options</td>
<td>RS232/UART decoding kit</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>I2C decoding kit</td>
</tr>
<tr>
<td></td>
<td>SPI decoding kit</td>
</tr>
<tr>
<td></td>
<td>CAN analysis kit</td>
</tr>
</tbody>
</table>

Note: All the options or accessories can be ordered from your local RIGOL Office.
Appendix B: Warranty

RIGOL warrants that its products mainframe and accessories will be free from defects in materials and workmanship within the warranty period.

If a product is proven to be defective within the respective period, RIGOL guarantees the free replacement or repair of products which are approved defective. To get repair service, please contact with your nearest RIGOL sales and service office.

RIGOL does not provide any other warranty items except the one being provided by this summary and the warranty statement. The warranty items include but not being subjected to the hint guarantee items related to tradable characteristic and any particular purpose. RIGOL will not take any responsibility in cases regarding to indirect, particular and ensuing damage.
# Index

- Duty ........................................ 6-14
- Width ........................................ 6-14
+ Duty ........................................ 6-14
+ Width ........................................ 6-14
Acquisition Mode ......................... 4-2
Addition ...................................... 6-2
AND ............................................. 6-7
Antialiasing.................................. 4-9
Area ............................................. 6-17
Auto IP ........................................ 14-3
Auto Mode .................................... 6-31
Aux Output .................................. 14-11
Average ....................................... 4-2
Bandwidth Limit ............................. 2-3
Blackman ...................................... 6-5
CAN Decoding ............................... 7-17
CAN Trigger .................................. 5-42
Channel Coupling ........................... 2-3
Channel Label ................................ 2-7
CSV ............................................. 13-4
Cursor ......................................... 6-24
DC .............................................. 12-6
Decoding Table ............................. 7-4
Delay .......................................... 6-15
Delay Calibration ........................... 2-8
Delay Trigger .................................. 5-25
Delayed Sweep ............................... 3-2
DHCP .......................................... 14-3
Division ....................................... 6-3
Domain Name Server ....................... 14-5
Dots ............................................. 11-2
Duration Trigger ............................ 5-29
Duty Cycle .................................... 12-6
ECG ............................................. 12-9

Edge Trigger .................................. 5-9
Edge Type ..................................... 5-9, 5-16
ExpFall ........................................ 12-9
ExpRise ........................................ 12-8
Expression ..................................... 6-9
Fall Time ....................................... 6-14
FFT .............................................. 6-4
Frequency ..................................... 6-14
Frequency Counter .......................... 6-18
Gate ............................................. 14-4
Gauss .......................................... 12-10
Hamming ....................................... 6-5
Hanning ........................................ 6-5
Haversine ...................................... 12-11
High Resolution ............................. 4-4
Horizontal Reference ...................... 3-9
Horizontal Scale ............................. 3-8
I2C Decoding .................................. 7-10
I2C Trigger .................................... 5-35
Idle Time ....................................... 5-16
Input Impedance ............................. 2-4
IP Address ..................................... 14-3
Lorentz ........................................ 12-10
MAC ............................................. 14-5
Manual Mode .................................. 6-24
Memory Depth ................................ 4-8
Multiplication ................................ 6-3
Network Status ............................... 14-2
Noise .......................................... 12-7
Noise Rejection .............................. 5-7
Normal ......................................... 4-2
NOT ............................................. 6-7
Nth Edge Trigger ............................. 5-16
Operator ...................................6-11
OR...........................................6-7
Overshoot ...............................6-16
Parallel Decoding ......................7-2
Pattern Setting ............................5-23, 5-29
Pattern Trigger .........................5-23
Peak Detect ................................4-4
Period ......................................6-14
Period Area ...............................6-17
Persistence Time ..........................11-3
Phase .......................................6-15
Picture ....................................13-3
Preshoot .................................6-17
Pulse ........................................12-6
Pulse Condition ...........................5-10
Pulse Polarity .............................5-12
Pulse Trigger .............................5-10
Pulse Width Setting ......................5-10
Qualifier ...................................5-12
Ramp ........................................12-5
Record Constant On .....................10-4
Rectangle ...................................6-5
Rise Time ...................................6-14
Roll ..........................................3-7
RS232 Decoding ......................... 7-5
RS232 Trigger .............................5-33
Runt Trigger ..............................5-12
Sample Rate ...............................4-6
Setup/Hold Trigger .......................5-31
Setups ......................................13-3
Signal Source ............................12-1
Sinc ..........................................12-8
Sine ..........................................12-3
Slope Condition ...........................5-18
Slope Trigger .............................5-18
SPI Decoding .............................7-14
SPI Trigger ...............................5-38
Square ......................................12-4
Static IP ....................................14-3
Subnet Mask..............................14-4
Substraction ..............................6-2
Symmetry ...................................12-5
Sync ..........................................5-21
Threshold ...................................6-20
Time Setting ...............................5-18
TimeOut Trigger .........................5-27
Traces .......................................13-3
Track Mode ...............................6-28
Trigger Coupling .........................5-5
Trigger Holdoff ...........................5-6
Trigger Level ..............................5-9
Trigger Mode ..............................5-3
Trigger Position ..........................5-14
Trigger Source ...........................5-2
USB ..........................................14-6
USB Trigger ...............................5-40
Vamp ........................................6-16
Variable ....................................6-10
Vavg ..........................................6-16
Vbase ........................................6-16
Vectors .....................................11-2
Vertical Expansion .......................2-6
Vertical Scale .............................2-5
Vertical Window .........................5-13, 5-19
Video Polarity ............................5-21
Video Standard ......................... 5-21
Video Trigger .............................5-21
VISA .........................................14-5
Vmax ........................................6-16
Vmin ........................................6-16
Vpp ..........................................6-16
Vrms ........................................6-16
Vtop ........................................6-16
Waveform Analysis .....................10-8
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform Confusion</td>
<td>4-6</td>
</tr>
<tr>
<td>Waveform Distortion</td>
<td>4-6</td>
</tr>
<tr>
<td>Waveform Invert</td>
<td>2-5</td>
</tr>
<tr>
<td>Waveform Leakage</td>
<td>4-7</td>
</tr>
<tr>
<td>Waveform Playback</td>
<td>10-6</td>
</tr>
<tr>
<td>Waveform Record</td>
<td>10-2</td>
</tr>
<tr>
<td>Waveforms</td>
<td>13-3</td>
</tr>
<tr>
<td>Window Function</td>
<td>6-4</td>
</tr>
<tr>
<td>Windows trigger</td>
<td>5-14</td>
</tr>
<tr>
<td>Windows Type</td>
<td>5-14</td>
</tr>
<tr>
<td>XOR</td>
<td>6-7</td>
</tr>
<tr>
<td>XY</td>
<td>3-4</td>
</tr>
<tr>
<td>Y-T</td>
<td>3-4</td>
</tr>
</tbody>
</table>